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INTRODUCTION 
 

 
Welcome to NuVJ!  NuVJ is an intuitive VJ environment which seamlessly integrates software and hardware for 
a professional quality, hassle-free performance.  The NuVJ environment is based around a DJ-style setup which 
allows you to mix, scratch, and apply effects to video clips and images.  We have designed the NuVJ software 
and controller to be simple to use, while allowing for unprecedented variation and creativity with your visual 
sources.  And with an extended set of features such as live inputs, synchronization to music, and real-time 
visual effect generation, we hope that you enjoy using this product as much as we enjoyed building it for you! 
 
Sincerely, 
 
The People of Numark and Arkaos 
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CONTROLLER OVERVIEW 
 

 
The NuVJ controller provides a simple and quick way to interface with the most important functions and 
features of the NuVJ software.  The controller was specifically designed to control the NuVJ software, but may 
also be used as a generic MIDI controller for a variety of other software applications and hardware devices 
which support the MIDI protocol.   
 

Please note:  The NuVJ controller was specifically designed to be used with the NuVJ software.  
However, it may also used as a generic MIDI controller for various other applications which respond 
to MIDI commands.  If  you use the NuVJ controller with another software application, you might 
notice that some of the controller features are disabled.  For example, the pads and buttons will 
not light up.  This is normal and the controller will still function properly.   

 
For the purposes of this manual, we will only explain the control surface functionality when used in conjunction 
with the NuVJ software.  Please also read the “Introduction to the Software” and “Using the Software” sections 
of this manual for more information on the software. 
   

Top Panel  
 

 

 
 

1. PADS: The 9 pads on each side control which ‘clip’ is displayed on each ‘deck zone’. Taping 
the pad will trigger the clip that is assigned to the particular ‘cell’ in the software.  Please see 
Introduction to the Software section for infromation on clips, cells, and decks. 

2. WHEEL: The wheels on each side can be used to scratch or speed up/slow down the video 
currently playing.  If you hold down the [SCRATCH] button underneath the wheel, you can 
use the wheel for scratching the video content.  If the button is not held down, you can use 
the wheel to speed up and slow down clips temporarily, like a pitch bend. 

3. SPEED: The two vertical sliders in the middle set the speed of the video playback, allowing 
you to slow down, accelerate or reverse the video on each deck zone. 

4. [SCRATCH]: When this button is held down, the jog wheel can be used to scratch the video 
playing on that deck. 
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5. [INSTA A/B]: These buttons allow you to quickly switch the video output to one of the 
decks.  For example, if you press [INSTA A] the video output will only show what is playing 
on deck A, regardless of the crossfader position, until you release the [INSTA A] button.  The 
speed of the fade when the [INSTA A/B] buttons are pressed is determined by the Auto Fade 
Speed knob on the front panel. 

6. BANK: Use this knob to select different banks of video clips.  Each bank contains up to 9 
clips which can be toggled by pressing the corresponding pad.  There are 16 different banks 
which can be used on either of the two deck zones. 

7. PMTR1: Each cell in a bank can be assigned an effect through the software. The PMTR1 knob 
will then adjust the first effect parameter of the cell currently playing on that bank.  This 
parameter will be different, depending on which effect you have chosen for the particular cell. 

8. PMTR2: The PMTR2 knob adjusts the second effect parameter of the cell currently playing on 
that bank.  This parameter will be different, depending on which effect you have chosen for 
the particular cell. 

9. [LATCH]: If the [LATCH] button is pressed on, the clips on the deck will play continuously 
when triggered.  If the [LATCH] button is pressed off, then the clips on the deck will play for 
as long as the corresponding pad is held down. 

10. [AUTO]: Press this button to play the clips (cells) of the current bank in a random 
automated fashion. 

11. [SYNC]: Press this button to synchronize the playback of the video clips playing on the deck 
to the BPM of the session. 

12. DISPLAY: The display helps you keep track of software parameters. 

13. FX LEVEL: This knob adjusts the Master FX Mix.  This setting describes how much of the 
selected Master Effect will be mixed in with the original image.  As you turn up the FX Level 
knob, you will see more of the effected mix.  As you turn down the FX Level knob, you will 
see more of the original image. 

14. [MASTER FX]: Press this button to activate and deactivate the Master Effect.  You can swap 
effects on the fly by selecting the desired effect with the Master FX knob.    

15. MASTER FX: Rotate this knob to select the Master Effect.  The Master effect will be applied 
to the master mixing zone.   

16. PMTR1: This knob adjusts the first parameter of the Master Effect.  This parameter will be 
different, depending on which effect you have chosen. 

17. [INSTA BLACK]: Pressing this button will toggle the video output to black or to a selected 
background visual assigned in the NuVJ software.  

18. CONTRAST: Use this knob to adjust the contrast of the video output. 

19. PMTR2: This knob adjusts the second parameter of the master effect.  This parameter will 
be different, depending on which effect you have chosen. 

20. [BPM TAP]: You can use this button to manually adjust the tempo of the session by tapping 
the button to the beat.  If you hold the button for 3 seconds and then release it, the BPM of 
the session will go back to the BPM detected from the sound input. 

21. BRIGHT: Use this knob to adjust the brightness of the video output. 

22. CROSSFADER: The crossfader allows you to mix the two visuals playing on each side.  If you 
move the crossfader to the right, you will see more of the right visual.  Conversely, if you 
move the crossfader to the left, you will see more of the left visual blended in. 
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Rear Panel 
 

 

 

 

1. AC IN: If the unit is not being powered by the USB connection, it can be powered by 
plugging an 6V-1A DC power adapter into this input. 

2. USB: Connect a USB cable from your computer to this input.  This port is used to power the 
unit, as well as to transmit MIDI control to your computer and the software.  Alternatively, 
you may power the controller by plugging in a 6V-1A DC power adapter. 

3. KENSINGTON LOCK: The unit can be attached and secured to a surface using this 
Kensington Lock slot. 

   

Front Panel 
 

 

 
 
1. FADER MODE: This switch determines the operation of the Fader Start option, as specified in 

the software. 

2. AUTO FADE SPEED: This switch adjusts the speed of the auto fade. The auto fade speed 
determines the speed of the fade from the current position to full A/full B when using the 
Insta A/B buttons on the top panel. 

3. FADER START: Fader Start allows you to start a selected pad by moving the fader toward 
the deck that it is loaded on.  For example, if the crossfader is in an extreme left or right 
position, moving it toward the opposite side will trigger the video selected on that deck.   
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CONNECTING THE CONTROLLER TO YOUR COMPUTER 
 

 

 
 

To connect the NuVJ to your computer, please connect the supplied USB power cord from the USB 
port on the NuVJ to an an available USB port on your computer.  There is no need to plug in an 
adapter – your computer’s USB bus will power the controller – but if you would like to use external 
power, you may do so by plugging in a 6V-1A DC adapter.   

The NuVJ is a Plug and Play device so there are no drivers or special software to install.  When you 
plug in the controller, you will see the screen illuminate and display “NuVJ”.  

 
Please note: When using the NuVJ control surface with other software, some of the 
features of the control surface will be disabled.  These features include the LED lights, 
as well as the value readout on the display.  The display will simply say “NuVJ”. 
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INSTALLING THE SOFTWARE - PC 
 

 
 

1. To install the NuVJ software, please insert the NuVJ installation CD into your computer’s CD-ROM 
drive. 

2. Double-click on the NuVJ installation file, located in the root directory on the CD.  This will launch 
the InstallShield Wizard. 

3. Follow the on-screen instructions.   
Please note:  The installation program will scan your available video components prior to installing 
the software.  If there are any components which are not up to date, please install them by clicking 
on their corresponding button before proceeding with the installation. 

4. Once the installation is complete, click “Finish”.  The NuVJ software is now ready to be used. 
5. Ensure that the controller is connected to your computer’s USB port and start NuVJ by going to 

Start -> Arkaos NuVJ -> Arkaos NuVJ. 
Please note:  If the controller is connected after the NuVJ software has been launched, it may not 
function.  You will need to restart the software.  In general, please always connect the controller 
before starting the software. 

6. Enter the serial number (16 characters) that came with NuVJ. 
7. Once the correct serial number has been entered, you may wish to register your copy of NuVJ.  You 

need to be connected to the Internet to register NuVJ.  Registering will allow you to access 
additional online content and program updates. 

 
 

 

INSTALLING THE SOFTWARE - MAC 
 

 
 

1. To install the NuVJ software, please insert the NuVJ installation CD into your computer’s CD-ROM 
drive. 

2. Click on the NuVJ installer located on the CD. 
3. Follow the on-screen instructions. 
4. Once installation is complete, you will see a shortcut on the desktop.  The application will also 

appear in your Applications -> NuVJ folder. 
5. Ensure that the controller is connected to your computer’s USB port and launch NuVJ. 

Please note:  If the controller is connected after the NuVJ software has been launched, it may not 
function.  You will need to restart the software.  In general, please always connect the controller 
before starting the software. 

6. Enter the serial number (16 characters) that came with NuVJ. 
7. Once the correct serial number has been entered, you may wish to register your copy of NuVJ.  You 

need to be connected to the Internet to register NuVJ.  Registering will allow you to access 
additional online content and program updates. 
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INTRODUCTION TO THE SOFTWARE 
 

 
In this section, we will take a quick tour of the software and explain some key concepts to its operation.  We 
highly recommend reading this section – it will give you a good overview of NuVJ’s functionality, as well as 
teach you some fundamental concepts of video mixing. 
 

Basics 
 

 
NuVJ allows you to mix videos and images in real time in a very intuitive way. It is built around a 
DJ-deck like setup where you have two playback decks and can mix the output of the decks using a 
mixing slider. 

 

              

 Movie A Movie B

Video 
Mixer 

Output

 
 
 

This setup is reflected both in the software interface and on the controller: deck A is represented 
by the left area of the main panel, while deck B by the right side and the mixer and master effect 
controls are in the middle, as shown in the following graphic: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
On each deck zone, you can see a series of squares.  These are called ‘cells’ and are placeholder 
for video clips, images or flash files (we’ll globally refer to them as ‘clips’.  Each deck can play one 
cell at the time. 

 
To assign a clip to a cell, simply drag and drop any image or video from the file browser located on 
the left most side of the interface or directly from the explorer/finder window. Once assigned, you 
can then click on the cell to trigger it or, alternatively, press the corresponding pad on the NuVJ 
controller.  By starting a cell in each deck, you can see each of them playing in their respective 
preview window and see the result of the mixing in the central window.  Move the mixing slider 
either using the mouse or the crossfader on the controller to see the mixing balance change in the 
preview window.   
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The big picture 
When doing a performance, you usually need to project the output in full 
resolution.  To do so, you will need to activate the full screen mode in the 
software interface.  This is done by clicking on Display > Toggle 
Fullscreen or, alternatively, by pressing CTRL+A (Command+A on Mac) on 
the computer keyboard.  To exit full screen mode, press CTRL+A again. As 
we will see later on (see Preferences/Display further in this document), if 
your video card allows multiple video outputs, you can have the interface 
displayed on your main monitor while the full screen output result is sent to 
the secondary monitor output to which you can attach a projection device. 
 

 
 

Overview 
 

 
As we’ve just seen, NuVJ runs around a simple A/B deck & mixing set-up.  In this chapter, we’ll 
explore more of its features in detail. 
 

Decks:  

As said previously, decks are sources for video streams. 
They contain cells that are placeholders for clips. When 
you trigger a cell in a deck, you can see the preview of 
the movie/image running in the preview window located 
on the top of the deck area. Only one cell at a time can 
play in a deck. The cell currently running on the deck is 
highlighted in red on the software interface and a LED is 
also providing feedback on the control surface. 

Cells:  
 
Cells are placeholders to which you assign the clips you 
intend to use in your mix.  In addition to containing a clip, 
cells can also be assigned an effect which will then 
automatically be applied to the clip loaded in that 
particular cell.  To assign an effect to a cell, simply drag 
and drop an effect from the Effects browser list on the left 
onto the desired cell.  If a cell with an effect has been 
triggered, two knobs on top of the cell area become active 
and allow you to modify the effect parameters.  Effect 
parameters can be changed either using the mouse on the 
interface or with the two effect parameter knobs (PMTR1 
and PMTR2) on each deck side of the controller.  For 
example, on the figure on the right, a directional blur has 
been set on the top left cell, and its two parameters, 
LEVEL and DIRECTION, are available for tweaking.  When 
a cell is selected (right-click) or played (left-click) with the 
mouse, a panel with advanced cell parameters is updated 
on the lower side of the screen.  It allows modifying 
playback and mixing parameters, as well as the default 
parameters for the effect when the cell is triggered. For 
special ‘text files’, the text to be displayed can also be 
edited there.  Cell parameters will be explained in more 
detail further in this manual. 

 

Files:  
 
Files are source material to be played in cells.  You can either 
drag and drop files directly from an explorer/finder window or 
use NuVJ’s integrated file browser on the left of the interface.  
NuVJ supports a number of video, image and flash file formats. 
See the Performance Tips section at the end of the manual for a 
discussion of the various fille formats and their efficiency.  In 
addition to playing individual files, you can also drag and drop a folder to a cell – NuVJ will play all videos 
and images located in that folder, one after the other in a slide show fashion.  
 

Please note:  for memory reasons, the files played when using a folder are not pre-cached 
and switching from one visual to another is less effective when played through a folder than 
when triggered directly. 

                                   DECK 

 

 

 

 

 

 

 

 

   CELL 
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Effects:  
 
Effects are used to alter clips in various ways. NuVJ provides a 
wide collection of effects sorted in different categories. They are 
listed in the second tab of the browser section on the leftmost 
side of the interface. Effects can either be applied on cells to 
alter individual clips or on the master output to alter the result 
of the mixing. Note that depending on the capacity of your 
video hardware, not all effects might be available as some 
require high end video hardware to work. 
 
 
 
Sources:  
 
Sources are like clips except they are not related to files on the 
hard drive.  The sources are listed in the third tab of the 
browser section on the leftmost side of the interface.  Sources 
are divided in three main categories: live inputs, generators, 
and texts.  Live inputs collect all available camera inputs on the 
system.  Using these, you can feed NuVJ directly with USB or 
Firewire web cams, DV cams, acquisition boards, and other 
video devices. The Inputs category shows all live inputs 
recognized by the system. Generators are elements that 
automatically generate patterns using internal effects processing and the signal from the audio input, much 
like the visualization modules from iTunes or Windows Media Player.  To assign a source to a cell, simply 
drag and drop it onto the desired cell. The third categorie, ‘texts’ contain special files that can be used to 
dispay text for presentation, announcement and so on. 

 
 

USING AUDIO INPUT:   
 

NuVJ allows you to synchronize your video clips and performance to signal from your audio input.  To 
make use of this feature, please connect an audio source to the line-level input on your computer’s 
soundcard.  You will need to make sure that the line input is selected as an input source.   

PC: Please go to My Computer -> Control Panel -> Sounds and Audio Device Properties, click on the 
Audio tab and then click on Advanced – this will pull up the Volume Control panel.  Click on Options -
> Properties -> Recording – this allows you to view the recording input sources.  Please make sure 
that Line In is checked and that the volume slider is up. 

To be able to hear the audio input through your computer’s soundcard, you will need to go back to 
Options -> Properties -> Playback and make sure that Line In is not muted and that the volume slider 
is up.  

On some soundcards, you can select the output of the card as recording device. It is generally found 
in the recording sources as ‘Stereo mix’.  If your card has such a channel, selecting it will allow you to 
directly synchronize NuVJ to the audio playing on the same PC. 

MAC: Please go to Finder -> Applications -> System Preferences, and click on the Sound icon.  Select 
Input to view the available input sources.  Select the device that you would like to use as the input 
device – once this device is selected, NuVJ will synchronize its session BPM to this device. 

 
The visual library:  
 
The visual library is a convenient way to find clips that are 
already loaded in the application. Once a clip is loaded in NuVJ, 
it will become available in the visual library and can be accessed 
at any time during your session.  The library is located on the 
fourth tab of the browser section. You can directly drag and drop 
visuals from the library onto the cells without having to search 
for them again on your hard drive. 

 

Banks:  
 
Banks are collections of nine cells.  There is always 
one bank selected on each deck.  The current bank 
number is displayed in the blue area just 
underneath the deck preview window.  You can 
change banks at any time by pressing the up and 
down arrows, or by rotating the BANK knob on the 
controller.  Using banks, you can organize your 
clips according to themes, mood, or type of 
sequences. 
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Deck Playback control:  
 
Next to the bank selection display, there are a few controls which can be used to alter the playback of the 
cells on that deck: 

 
The top indicator is the playback position inside the current clip. 
 
The bottom indicator controls the speed at which the clip is playing.  The center represents a speed of 
zero (the clip will be frozen).  If the indicator is located in the right side region, the movie will be 
played forward while if on the left side region, the movie will be playing backward.  The further you 
get from the center, the faster the movie will play.  To modify the speed of playback using the 
interface, simply click inside the control to move the speed indicator to that point.  You can also 
adjust the speed of playback using the SPEED sliders on the controller. A vertical bar in the speed 
indicator shows the speed point where the movie is playing at nominal speed. When the speed is set 
around the nominal speed, the speed indicator will turn red 
 
 
 
 
 
 
 
 
The [LATCH] button influences how cell triggering reacts.  If it is activated, the cell will keep on 
playing after you release the mouse or the pad on the control surface.  If it is deactivated, the cell will 
stop playing as soon as you release the mouse/controller pad.  You can also activate/deactivate the 
mode using the LATCH button on the control surface. 
 
The [SYNC] button engages a ‘synchronized playback’ mode for the clips.  When activated, NuVJ 
adapts the movie speed to be ‘in sync’ with the BPM detected from the audio input.  You can toggle 
the sync mode from the controller using the dedicated button. When sync is engaged, movie speed 
can still be altered by the speed sliders. 
 
The [AUTO] button engages the automated mode for the deck.  In automated mode, NuVJ will 
automatically trigger cells from the current bank in a random fashion, following the BPM detected 
from the audio input.  This can be useful if you need a rest in the middle of a performance or simply 
want to automatically blend visuals together. 

 
 
The Crossfader:  
 
The crossfader is located in a central position. Using either 
the mouse or the slider on the controller, you can use the 
crossfader to blend your movies together.  If the fader is on 
the far left side, only the output of deck A will be visible, 
while if on the far right side, only the output of deck B will be 
shown.  In intermediate position, both A & B will be blended according to a ‘transition’ curve that can be 
chosen.  To select the transition curve, right-click the crossfader and select one of the available transitions.  
The controller also features a FADER MODE switch on the front panel that allows selecting among 3 pre-
defined transition curves.  For more information on defining the transitions used by the control surface, see 
further in the Preferences section. 
 
The Master Effect:  
 
The master effect is an additional effect that can be applied to the 
output of the image mix.  The master effect can be selected either 
from the software interface or from the MASTER FX knob on the 
control surface.  Each effect allows up to two parameters to be 
tweaked with the PMTR1 and PMTR2 knobs on the control surface. 
The FX LEVEL (Master FX Mix) knob allows setting the percentage 
of the effected image that will go in the final output.  You can also 
completely bypass the master effect by pressing the MASTER FX 
button on the controller. 

 
 
Brightness/Contrast control:  
 
Before the image is sent to the main output, you can adjust 
its brightness and contrast. This allows you to adjust the 
image to the room’s lighting conditions or to compensate for 
a loss/gain of brightness due to heavy image processing and 
blending. The contrast and brightness settings can be 
controlled either from the user interface or directly from the control surface with the CONTRAST and BRIGHT 
knobs.  If you don’t use this feature, you can bypass it in the Preference dialog – this will save some CPU 
power and could slightly improve performance. 

 

Please note that the efficiency of playback at non-nominal speed 
depends a lot on the type of movie and compression used for the clips.  
See Performance Tips section of this manual for more information on 
this topic. 
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Advanced Features 
 

 
Background:  
 
NuVJ allows the possibility to put a background clip that will be displayed if no clip is played on neither of 
the two decks or if the [INSTA BLACK] button on the controller is pressed. The background clip is defined in 
the Preferences dialog by going to File > Preferences, and can also be replaced ‘on the fly’ by drag and 
dropping a clip on the master preview window. In the Preferences menu you can also activate the usage of 
copy & blending modes (see further) between deck A and the background.  This option is not activated by 
default to avoid any confusion. 
 
Cell parameters and advanced mixing:  
 
When clicking on a cell with the mouse or triggering it with one of the pads, the cell parameter panel at the 
bottom of the interface is updated to show settings for the selected cell. To edit a cell’s parameters without 
triggering it, simply click on the cell using the right mouse button. The parameter panel contains advanced 
options that will allow you to take mixing and performances a step further.  To illustrate these options, we’ll 
imagine mixing the two following images: 

 
Deck A: 

 
 

 
Deck B: 

 

 
Copy modes:  
 
Copy modes express the way cells from deck A & B are blended together in the mixer.  Unless a special 
option is set (see Preferences / Advanced), theses settings will be effective only when a cell is running on 
deck B.  This is because deck B is virtually considered to be ‘on top’ of deck A and copy modes define the 
way B is ‘merged’ onto A. 

 
The copy mode defines the mathematical operation used 
to combine the pixel color from deck B with the pixel 
color from deck A. Let’s review them in order, from left to 
right. 
 

 
The default is the copy mode. In this mode, the cell on deck B will simply be mixed with the cell 
on deck A, that is to say that the resulting output will be some pixel averaging of each image. 

 
The addition mode is where pixels from B will be added to pixels of A.  If this mode is selected 
(as well as the subtraction, multiplication, maximum and minimum modes), the effect is maximal 
when the mixing slider is all the way on the right.  

 
 

The subtraction mode is where pixel colors from deck B are subtracted from deck A, resulting 
into an ‘inverse’ blending of B into A.  

 
 

         The multiplication mode is where pixels from deck B are multiplied with the pixels from deck A.  
 
 

The maximum mode selects pixels from either deck A or B, depending on which one has the 
strongest luminance. 

 
 

The minimum mode selects pixels from either deck A or B, depending on which one has the 
lowest luminance.  

 
 
 

Please Note:  Deck A is also considered to be on top of the background 
color or visual selected in NuVJ.  This means that you can use copy and 
masking options to have the background visual be shown through deck A. 
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Masking options:   
 
The masking options allow removing (masking) part on the clip content, based on either a color or 
brightness characteristic. This process is also known as color or luminance ‘keying’. As for the copy modes, 
the masking settings are only applied to cells when running on 
deck B, since deck B is on top of deck A. When luminance or 
chrominance keying are activated, two knobs underneath the 
selection become active. These knobs allow defining the 
characteristics (center and width) of a band reject filter that will 
be applied either on the brightness levels or hue of the clip’s 
image. Any luminance or color belonging in that zone will be 
made transparent and A will be seen through. 

 
The default and leftmost mode disables keying. In this case, the center and width knobs are disabled as 
well. 

 
Luminance keying allows making a range of brightness values transparent. For example, if you 
put the center parameter all the way to the maximum, you will make all bright values (white) 
transparent and see the content of deck A underneath. The center defines the range of gray 
levels to be discarded. 

 
 

Chrominance keying allows making a color range transparent. The center knob position defines 
what color will be rejected and the width will define how spread the range of color around the 
center value will be removed. I  

 
Playback options:  
 
The playback options affect the way the clip will be played. There are three modes: One Shot, Loop and 
Ping-Pong. 

 
In One Shot mode, the movie plays once when triggered and stops if it 
reaches the end. 

  
In Loop mode, the clip will continuously loop. This is the default mode. 

 
In Ping-Pong mode, the clip will loop alternatively playing forward, then backward, then forward again...  

 
Effect options:  
 
The effect options on the right side allow setting up the default 
values for the effect parameters. These values will be recalled 
automatically each time the cell is triggered. They can always be 
changed live using the deck effect parameters (see deck section) but 
the default values set here will come back each time the cell is re-
triggered. To ‘copy’ the current live settings to the default 
parameters for that cell (so that they are remembered next time you trigger the cell), press down on the 
controller’s BANK knob for the selected deck.   
 
Text settings: 
 
When using texts from the source browser, you can alter the text displayed by modifying it in the text input 
located in the cell parameter panel. 

 

Bank import/export:  
 
As well as being able to load and save the whole content of you performance by going to the file menu, you 
can also import and export single banks by holding down right-click over a cell and selecting the entry from 
a pop up menu (see more explanation in the user interface description). This feature makes it easy to load 
groups of pre-defined visuals during your performance. It allows you to save an unlimited number of pre-
configured sets of clips and effects and recall them without having to stop the performance at any time. 

 
Double monitoring:  
 
To do a proper VJ performance, it is more convenient to use video cards that support double monitors. That 
way, you can project the output of the mixer to your second monitor (linked to a projection system for 
example) and still access the user interface alongside the controller on the primary monitor. To set up 
double monitoring within NuVJ, you first need to make sure your system is configured to work with two 
independent screen outputs (and not using cloning where both adapter outlets output the same image). 
Once you have set up your system, start NuVJ and go to the Preferences dialog (File > Preferences).  In the 
Display section select which monitor you would like to use for the full screen output. Once that is done, you 
can enter full screen mode by going to Display > Toggle Fullscreen or by pressing CTRL+A (command+A on 
Mac).  You can also exit full screen mode by pressing CTRL+A (command+A on Mac). 
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USING THE SOFTWARE 
 

 
This section details the various elements of the user interface as well as the way to fully interact with the 
program: 
 
The user interface is split into 4 different areas: the menu/browser zone (top left), the mixing zone (top right), 
the information window (bottom left) and the cell parameters panel (bottom right).            
         

 
 

Menus 
 

 
Menus are organized as follows: 

 
File 
    New: Clears all data and starts with a blank performance 
    Open: Opens a performance (.nvj) file 
    Save: Saves the current performance 
    Save As...: Saves the current performance as a new file 

       Preferences: Brings up the preferences dialog 
Quit: Quits the application. Only works when full screen is not active, in order to 
prevent shutting down in the middle of a performance 

 
Edit 

     Cut Cell: Removes the current edited cell and copies its content to the clipboard 
     Copy Cell: Copies the current edited cell to the clipboard 

       Paste Cell: Copies the clipboard to the current edited cell 
       Clear Background: removes the current background clip 

   Purge Visuals: removes any unused clips from memory. 
  

Display 
     Toggle Fullscreen: switches from/to full screen mode 

 
Help 
   Getting Started: opens pdf of NuVJ Quickstart Guide 
   Reference Manual: opens pdf of the NuVJ Reference Manual 
   Release Notes: displays pdf containing current software version information and      
   additional information regarding the software release. 
   NuVJ Web Site: opens NuVJ web site in your internet browser 
   Register: allows you to register NuVJ on the internet 
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The Browser Zone 
 

 
The browser zone provides various tree views for picking content and effects needed to build your 
performance. The zone contains four tabs that access Files, Effects, Sources, and the Library.  To 
use any of these, simply drag and drop an element from the browser onto a cell. Additionally, you 
can also drag and drop elements to any of the preview windows: If you drag to one of the deck 
preview windows, the element will replace the visual or effect on the cell that is currently playing.  
If you drag an element to the master preview, it will set the background clip or the master effect. 
 
Under the browser zone, you can find a file filter box that lets you select which files are going to be 
visible in the file browser. The default is to show all compatible files (videos, pictures and flash 
files) but you may wish to change it to show only pictures, only movies, only flash files or display 
all files present on your hard drive. 
 
Under the filter there is also a trash icon. This icon can be used to remove visuals and effects from 
cells by simply drag and dropping the cell or the effect icon of the cell to the trash icon. 
 

The Mixing Zone 
 

 
The mixing zone contains all the information related to deck content and preview, as well as the 
mixing slider and master effect. The leftmost column is Deck A, the rightmost is Deck B and the 
center is the Mixing and Master Effect Zone. 
 
Deck Zones (A and B): 

 

Each deck contains the following elements from top to bottom: 
  

The Deck Preview: Shows the cell output from the deck. You can drag and drop 
elements from the browser directly to the Deck preview, which will replace the visual or 
effect on the cell currently playing. 

 
Deck Controls: Contain the elements which allow you to control bank selection, deck 
playback speed, and set latch, auto and sync modes. See ‘Deck Playback Control’ in the 
‘Introduction to the Software” section of this manual for more information about these 
controls. 

 
Deck Effect Parameters: Allows altering the effect parameters of the cell currently 
playing. Please note that these modifications are only temporary: as soon as a new cell 
is triggered, the effect parameter values are reset to the value defined in the cell’s 
parameter panel. If you wish to copy the current effect parameters to the cell’s default 
parameters so they are used next time you trigger the cell, simply press down on the 
[BANK] button of the deck. 

 
Cells: In the lower part of the Deck, you see the nine cells of the selected bank. Drag 
and drop any file, effect or source from the browser to a cell to alter its content. Cell 
will show a snapshot of the clip it has been assigned to as well as a few informative 
icons as follows: 

 
A cell in gray scale, surrounded by a red outline means the cell is 
currently playing in the Deck. A pencil icon in the top left corner 
means the cell is selected for edition and that its parameters are 
visible in the cell parameter panel. It also means it is the current 
target for any copy/paste operation. To select a cell, click the cell 
either with the left mouse button (in which case the cell will be 
triggered and selected for edition) or with the right mouse button 
(in which case the cell will be selected but not triggered). 

 
The icon on the lower right means the cell has an effect applied on it. The one on the 
left of it means the cell has non-default copying and masking modes. 

 
You can drag and drop visuals and effect between cells cell. To drag a clip from one cell 
to another, simply click in the image area and drag it to another cell. To drag an effect 
from one cell to the other, drag the effect icon from one cell to another. 
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If you right-click a cell and hold it for a little while, a pop-up 
menu will appear with the following entries: 

  
Clear Visual: Removes the visual from the cell 
Clear Effect: Removes the effect from the cell 
Reset Cell: Remove all settings, visual and effects from the cell 
Import Bank: Imports a whole bank from a .nvjb file replacing 
the bank to which the cell belong. 
Export Bank: Allows to export all the bank to which the cell belong in a .njvb file. 
Clear Bank: Clear the content of the bank. The clips are still kept in memory for further 
access (through the visual library browser). To free the space used by clips not 
selected in any banks, use the ‘Purge Visuals’ from the edit menu. 

 
 
Mixing and Master Effect Zone: 

 
The middle zone contains all the elements relative to master output and mixing processing. It 
contains, from top to bottom: 

 
Output Preview: The output preview duplicates the images sent to a second monitor when in full 
screen mode. You can drag and drop browser element to the output preview. If you drag a Clip, a 
Camera Source or Generator, that element will replace the background currently selected (see 
background in the Concept section). If you drag an effect, that effect will be used as current Master 
Effect. 

 
Brightness and Contrast: These two controls allow correcting the contrast and brightness of the 
image, either to adapt to the room lighting condition or to compensate the result of heavy 
effecting. 

 
Master Effect Section: The master effect section lets you apply an additional effect to the output of 
the mixer. The effect can be selected using the combo box and three knobs below allow altering 
the effect itself. The first one determines the wet/dry percentage between the original output and 
the effected one while the two other allow modifying the specific parameters of the selected effect. 

 
Crossfader: Controls the mixing between Deck A and 
Deck B. On the far left it will only let through Deck A 
in the output, while on the far right, only B will be 
displayed. The way the image is mixed from A to B 
depends on the transition used. Transitions can be 
selected by right-clicking on the crossfader or by 
using the configured switch on the control surface. 
Note that the number of transitions available 
depends on the capabilities of your hardware. 
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The Information Zone 
 

 
The information zone on the bottom left of the screen shows dynamic information based on the 
element on which the mouse is located. If you need to get information on a specific item, simple 
hover your mouse on top of it and read the information here. 
 

The Cell Parameter Panel 
 

 
The cell parameter panel allows editing the parameters related to the cell currently 
selected for edition. There is only one such cell at the time and it can be recognized 
through the following icon overlaid on top of the visual’s snapshot:   

 
As explained in detail in the ‘Concept’ section, the panel allows modifying the playback and mixing 
characteristics of each cell. It is also used to set up the default effect parameters values that will 
be restored each time the cell is re-triggered. 
 

The Preferences Dialog 
 

 
The preferences dialog sets various settings regulating the way the program works. The settings 
are sorted in four categories, each of them accessible through a tab in the dialog: 
 
 General: 
 

Background Visual: 
Specifies the file to be used 
as background clip. This file 
will be played/shown when 
no cell is playing on either 
deck or when the ‘Fade to 
Black’ button from the 
controller is pushed. Either 
enter the full path of the file 
or use the select button to 
open a file browser. This file 
is used as default 
background and will be 
restored when you start the 
application, load a 
performance file or reset the 
data using the File>New 
menu. You can override the value set here either by selecting the Edit>Clear Background 
menu or by drag and dropping a clip directly on the master preview window.  
 
Automation Beat Count: Selects the number of beats that the automation  
waits before triggering a new visual. See ‘Concepts/Deck Playback controls’ 
 
Slide Show Time: NuVJ allows you to drag and drop folders on a cell. In that case, all 
movies/images/flashes located in that folder (and recursively) will be played one after 
the other in a slide show fashion. The ‘slide show time’ parameter sets how much time 
images will be displayed (in seconds) before displaying to the next visual in the 
hierarchy. 
 
Transition 2 & Transition 3: The controller has a switch setting that allows choosing 
between 3 transitions on the fly. The first transition will always be the default transition 
(Exponential Transparency) but the two others are configurable. These two lists allow to 
select which transition you would like to see associated with settings ‘2’ & ‘3’ of the 
transition switch. 
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Display:  

 
The display tab defines the options related to the full screen mode of the application. 

  
Full Screen Monitor: 
Defines the monitor to be 
used by the full screen 
mode of the application. By 
choosing a different output 
than your main monitor, you 
will be able to send the mix 
to the alternate output while 
keeping the user interface 
still visible for tweaking & 
visual feedback on your 
default monitor. 
  
Resolution: Specifies the 
resolution used internally to 
process all graphics. The 
lower value you specify, the 
faster calculations will be (and hence a better frame rate) but the lower the image 
quality. Experiment with different settings to achieve a proper balance between image 
quality and frame rate. Usually 800x600 is fine for projection devices. 
 
Exclusive Mode: Forces Windows to work in Exclusive mode. In this mode, 
performances are slightly better but it has a big drawback: once in this mode, you can 
only use NuVJ. Activating any other program will force NuVJ to exit full screen mode. 
This mode is therefore not recommended if you intend to run other applications while 
using the NuVJ. 

 
 

Performances:  
 

The performance tab allows you to tune some performance elements in order to get a 
better frame rate. 

 
GPU Level: This first field is 
an indicator of how powerful 
your graphic hardware is. 
The level can be between 0 
and 5. Although the 
program will run on any of 
those levels, we recommend 
at least a GPU Level 2 in 
order to fully enjoy NuVJ. 
Under Level 2, some 
features might not be 
available, as the hardware 
provides no support for 
them.  
 
Rendering Quality: This 
slider is used to specify a 
quality level for various aspect of the rendering process. It expresses the tradeoff 
between image quality and rendering speed. If all the way to the right, full quality is 
preserved. If all the way on the left, quality of various aspects (preview, internal 
processing, etc…) will be degraded and frame rate will increase due to a lesser amount of 
processing. Try various setting, and remember that the resolution selected in the 
‘Display’ tab will automatically influence the performance of your system. 

 
Disable Contrast/Brightness Control: On slow performing hardware, you can disable 
the contrast/brightness controls to leave room for the main processing. 
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Advanced 
 

Auto purge after: When a 
movie is imported into NuVJ, 
it stays in memory even 
when not allocated to any 
cell. Freeing the unused 
movies is important to avoid 
unused movies to hog the 
computer’s memory. This 
setting allows you to set a 
timer to regularly purge 
unused movies. 
 
Auto purge when 
physical memory left 
reaches: This setting allows 
you to automatically purge 
the unused movie when the 
physical memory of the computer becomes low. This option is only available for PC.  
 
Use Mask and Copy Mode on Deck A: Normally, mask and copy modes defined in the 
cell parameter panel are only active when the cell is playing on Deck B. By activating this 
option, you make the parameters active on Deck A, which means that the cell running on 
deck A will first be composed with the background clip using masking & copy settings 
before being sent to the mixer. Combining this option with the fact that you can change 
the background by drag and dropping visual on the master preview gives more advanced 
mixing capabilities. 
 
Play sound in QuickTime movies: By selecting this option, the sound tracks of 
QuickTime movie won’t be ignored, allowing NuVJ to scratch both video and audio at the 
same time. 

 
 

Controller: 

 
The controller section contains option related to using the controller. 

 
Status: shows the status of the controller (offline/connected) 
Firmware: shows the firmware level of the controller (only available if the controller is 
connected) 
LCD Contrast: Allows you 
to set the LCD contrast of 
the controller. Once set, the 
contrast setting is stored 
permanently in the 
controller and will be 
recalled next time the 
controller is used. 
Scratch sensitivity: sets 
the sensitivity of the jog 
wheels in scratch mode 
Slide Sensitivity: sets the 
sensitivity of the jog wheels 
when using them without 
the scratch button pressed 
(‘pitch bend’). 
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PERFORMANCE TIPS 
 

 
 
 
 
 
 
 
 
 
 
Attaining good performance with video can be difficult because it depends on a lot of different factors.  
 
The most important factors are: 

 
• CPU speed 
• Disk speed 
• RAM access speed 
• Video hardware & video bus speed 
• Movie compression 

 
There is no easy way to give a definitive answer in terms of what is best for every computer setting. In 
NuVJ, most of the graphic processing is done in the video hardware, so the more powerful it is, the better 
performance you are going to get. The CPU is mainly used to decompress movie frames from the disk and 
send them to the video card. The faster your drives are, the faster frames will be loaded in the memory and 
the faster your CPU is, the faster it will decompress the frames. To achieve a good frame rate with a given 
hardware, you can: 
 
• Adapt the resolution of the internal computation. See (Preferences/Display) 
• Use the performance slider to find a balance between quality and performance that is adapted to your 

hardware. 
• Use source material that is adapted to your hardware. If you have a slow disk or older generation of 

hardware, try working with smaller video sources to minimize the impact of loading and 
decompressing the movie. Since all calculations are done inside the video hardware, aliasing effects 
will be minimized by the automatic filtering applied when the images are scaled to the final resolution. 

 

Movie Compression 
 

Beside movie size, their compression scheme has a huge impact both on the fluidity of the display and their 
playability. The more complex the compression scheme, the more work the processor will have to do to 
recover specific frames, resulting in sluggish performance. In addition to the compression method itself, 
there’s the issue of key frames. Most widely spread compression mechanism work using incremental 
methods, which means they construct a frame by storing the difference between a frame and the previous 
one. In order to keep the process from deriving too much from the original material, they store an original 
frame every now and then, and start again coding incremental information from that frame on. These 
original frames are called ‘key frames’. Using sparse key frames will mean that for NuVJ to access a given 
frame, it will have to find the previous key frame and process all the intermediate frame differences until it 
reaches the desired one. As you can imagine, this process is rather slow and prevents fast access to frames, 
which is very important for backward playback or scratching. That’s why compression schemes like mpeg or 
DivX are not at all suited for video performances. 
 

 
 
 
 
 
 
 

Memory usage 
 

Movies are pretty big memory eaters. Depending on their size and length they can use a lot of space very 
fast. When a file is imported in NuVJ, it is kept in memory even if it is not assigned to any cell. This is so 
that you can use the ‘visual’ browser to look for files which have already been loaded, without having to 
browse and import them again. When the memory of the computer is getting full, its performance can 
decrease so it is important to keep an eye on that factor. To release unused movies from the software, you 
have to ‘purge’ them. This can be accomplished in several ways: 

1.  By manually purging the movies using the menu ‘Edit/Purge Visuals’ 

2.  Using the auto-purge feature, which can be set in the Preferences/Advanced dialog. Auto-purge will let 
you select a time or memory threshold which, when reached, will automatically purge the unused movies 
from your computer’s memory. For more information about that feature, please refer to the Preferences 
section of this manual.  
 
 
 

It is very important to note that popular compressions schemes are very inefficient 
for VJ’ing. Video files using these compression schemes will behave ‘correctly’ when 
used at nominal speed (100%), but will be very sluggish if you change their playback 
speed or scratch them. This remark is valid for mpeg, divx and DV codecs, among 
others. If you use these compression formats, you will get poor performance from the 
software. 

From our experience, the best compression scheme for video performance 
is QuickTime’s Photo JPEG with a quality setting of about 80% or more. 
This will ensure smooth playback, effective scratching and decent file size. 
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INTRODUCCIÓN 
 

 
¡Bienvenido a NuVJ!  NuVJ es un entorno intuitivo para VJ que integra sin discontinuidades software y 
hardware para lograr un desempeño de calidad profesional, libre de problemas.  El entorno NuVJ se basa en 
una configuración estilo DJ que le permite mezclar, rayar y aplicar efectos a los video clips y las imágenes.  
Hemos diseñado el software y el controlador NuVJ de modo que sean sencillos de usar pero permitan al mismo 
tiempo una variedad y creatividad sin precedentes con sus fuentes visuales.  Además, gracias al conjunto 
ampliado de características, tales como entradas en vivo, sincronización con la música y generación de efectos 
visuales en tiempo real, esperamos que disfrute usando este producto tanto como nosotros hemos disfrutado 
construyéndolo para usted. 
 
Atentamente, 
 
La Gente de Numark y Arkaos 
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DESCRIPCIÓN GENERAL DEL CONTROLADOR 
 

 
El controlador NuVJ proporciona una interfaz sencilla y rápida con las funciones y características más 
importantes del software NuVJ.  El controlador está diseñado específicamente para controlar el software NuVJ, 
pero se puede usar también como controlador MIDI genérico para una variedad de otras aplicaciones de 
software y dispositivos de hardware compatibles con el protocolo MIDI.   
 

Para tener en cuenta:  El controlador NuVJ está diseñado específicamente para usar con el 
software NuVJ.  No obstante, se puede usar también como controlador MIDI genérico para otras 
aplicaciones diversas que respondan a los comandos MIDI.  Si usa el controlador NuVJ con otra 
aplicación de software, es posible que note que algunas de las características del controlador están 
inhibidas.  Por ejemplo, los pads y los botones no se encienden.  Esto es normal y el controlador 
funcionará igualmente en forma correcta.   

 
A los fines de este manual, explicaremos únicamente la funcionalidad de la superficie de control cuando se usa 
en conjunto con el software NuVJ.  Para más información sobre el software, lea también las secciones 
“Introducción al software” y “Cómo usar el software” de este manual. 
   

Panel superior  
 

 

 
 

1. PADS: Los 9 pads de cada lado controlan qué ‘clip’ se muestra en cada ‘zona de bandeja’. Al 
tocar el pad se dispara el clip que está asignado a la ‘celda’ particular en el software.  Para 
información sobre clips, celdas y bandejas, lea la sección Introducción al software. 

2. RUEDA: Las ruedas de cada lado se pueden usar para rayar o acelerar/enlentecer el video 
que se está reproduciendo.  Si mantiene pulsado el botón [SCRATCH] que está debajo de la 
rueda, es posible usar esta última para rayar el contenido de video.  Si el botón no se 
mantiene pulsado, se puede usar la rueda para acelerar o enlentecer temporalmente los 
clips, como en el pitch bend (inflexión de tono). 

3. VELOCIDAD: Los dos cursores verticales del centro ajustan la velocidad de la reproducción 
de video, permitiéndole enlentecer, acelerar o invertir el video de cada zona de bandeja 

4. [SCRATCH] (Rayado): Cuando este botón se mantiene pulsado, la rueda de avance lento se 
puede usar para rayar el video que se reproduce en esa bandeja. 
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5. [INSTA A/B]: Estos botones le permiten conmutar rápidamente la salida de video a una de 
las bandejas.  Por ejemplo, si pulsa [INSTA A], la salida de video sólo muestra lo que se está 
reproduciendo en la bandeja A, independientemente de la posición del crossfader, hasta que 
suelte el botón [INSTA A].  La velocidad de la fusión, cuando se pulsan los botones [INSTA 
A/B], está determinada por la perilla Auto Fade Speed (Velocidad de fusión automática) del 
panel frontal. 

6. BANK (Banco): Use esta perilla para seleccionar los distintos bancos de video clips.  Cada 
banco contiene hasta 9 clips que se pueden conmutar pulsando el pad correspondiente.  Hay 
16 bancos diferentes que se pueden usar en cualquiera de las dos zonas de bandeja. 

7. PMTR1: Cada celda de un banco se puede asignar a un efecto mediante el software. La 
perilla PMTR1 ajusta entonces el primer parámetro de efecto de la celda que se está 
reproduciendo en ese banco.  Este parámetro será diferente en función del efecto que haya 
elegido para la celda particular. 

8. PMTR2: La perilla PMTR1 ajusta el segundo parámetro de efecto de la celda que se está 
reproduciendo en ese banco.  Este parámetro será diferente en función del efecto que haya 
elegido para la celda particular. 

9. [LATCH] (Enganche): Si se pulsa el botón [LATCH] para activarlo, los clips de la bandeja se 
reproducirán continuamente cuando se disparen.  Si se desactiva el botón [LATCH], los clips 
de la bandeja se reproducirán mientras esté presionado el pad correspondiente. 

10. [AUTO]: Pulse este botón para reproducir los clips (celdas) del banco actual de manera 
aleatoria. 

11. [SYNC] (Sincronismo): Pulse este botón para sincronizar la reproducción de los video clips 
que se reproducen en la bandeja a los BPM de la sesión. 

12. PANTALLA: La pantalla le ayuda a efectuar el seguimiento de los parámetros del software. 
13. FX LEVEL (Nivel de efectos): Esta perilla ajusta la mezcla del efecto maestro.  Este valor 

describe la proporción del efecto maestro seleccionado que se mezcla con la imagen original.  
A medida que gira la perilla FX Level hacia arriba, verá más de la imagen con efectos.  A 
medida que gira la perilla FX Level hacia abajo, verá más de la imagen original. 

14. [MASTER FX] (Efecto maestro): Pulse este botón para activar y desactivar el efecto 
maestro.  Es posible conmutar efectos sobre la marcha seleccionando el efecto deseado con 
la perilla Master FX.    

15. MASTER FX (Efecto maestro): Gire esta perilla para seleccionar el efecto maestro.  Este 
efecto maestro se aplica a la zona de mezcla de dicho efecto.   

16. PMTR1: Esta perilla ajusta el primer parámetro del efecto maestro.  El parámetro será 
diferente en función del efecto que haya elegido. 

17. [INSTA BLACK] (Negro): Al pulsar este botón la salida de video conmuta a negro o a un 
efecto visual de fondo seleccionado asignado en el software NuVJ.  

18. CONTRASTE: Use esta perilla para ajustar el nivel de la salida de video. 
19. PMTR2: Esta perilla ajusta el segundo parámetro del efecto maestro.  El parámetro será 

diferente en función del efecto que haya elegido. 
20. [BPM TAP] (Golpes de beat): Puede usar este botón para ajustar manualmente el tempo de 

la sesión golpeándolo ligeramente al ritmo del beat.  Si mantiene pulsado el botón por 3 
segundos y luego lo suelta, los BPM de la sesión volverán al valor detectado proveniente de 
la entrada de sonido. 

21. BRILLO: Use esta perilla para ajustar el brillo de la salida de video. 
22. CROSSFADER: El crossfader le permite mezclar los dos elementos visuales que se 

reproducen a cada lado.  Si mueve el crossfader a la derecha, verá más del elemento visual 
derecho.  A la inversa, si lo mueve a la izquierda, verá más del elemento izquierdo en la 
mezcla. 
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Panel posterior 
 

 

 

 

1. Entrada de corriente alterna: Si la unidad no se alimenta por la conexión USB, se puede 
alimentar enchufando un adaptador de alimentación de 6 V-1 A en esta entrada. 

2. USB: Conecte en esta entrada un cable USB desde su computadora.  Este puerto se usa para 
alimentar la unidad, como también para transmitir el control MIDI a su computadora y el 
software.  Como alternativa, puede alimentar el controlador enchufando un adaptador de 
alimentación de 6 V - 1 A. 

3. BLOQUEO KENSINGTON: La unidad se puede fijar y asegurar a una superficie usando esta 
ranura para bloqueo Kensington. 

   

Panel frontal 
 

 

 
 
1. FADER MODE (Modo de fader): Este conmutador determina la operación de la opción Fader 

Start, tal como se especifica en el software. 
2. AUTO FADE SPEED (Velocidad de fusión automática): Este conmutador ajusta la velocidad 

de la fusión automática. De esta forma se determina la velocidad de la fusión desde la 
posición actual a A completa/B completa cuando se usan los botones Insta A/B del panel 
superior. 

3. FADER START: La función Fader Start le permite iniciar un pad seleccionado moviendo el 
fader hacia la bandeja en la que está cargado.  Por ejemplo, si el crossfader está en la 
posición extrema izquierda o derecha, al moverlo hacia el lado opuesto se dispara el video 
seleccionado en esa bandeja.   
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CÓMO CONECTAR EL CONTROLADOR A SU COMPUTADORA 
 

 

 

 

Para conectar el NuVJ a su computadora, conecte el cable de alimentación USB provisto desde el 
puerto USB del NuVJ a un puerto USB disponible en su computadora.  No hay necesidad de 
enchufar un adaptador —el bus USB de su computadora alimenta el controlador— pero si desea 
usar alimentación externa, puede hacerlo enchufando un adaptador de 6 V 1 A.   
El NuVJ es un dispositivo Plug and Play de modo que no es necesario instalar ningún driver ni 
software especial.  Cuando enchufe el controlador, verá que la pantalla se ilumina y aparece 
“NuVJ”.  

 
Para tener en cuenta: Cuando use la superficie de control NuVJ con otro software, 
algunas de las características de la misma se inhiben.  Entre ellas se incluyen las luces de 
LED, como también la lectura de valor en la pantalla.  La pantalla indica simplemente 
“NuVJ”. 
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CÓMO INSTALAR EL SOFTWARE - PC 
 

 
 

1. Para instalar el software NuVJ, inserte el CD de instalación de NuVJ en el lector de CD-ROM de su 
computadora. 

2. Haga doble clic en el archivo de instalación de NuVJ, ubicado en el directorio raíz del CD.  De esta 
forma se lanza el asistente InstallShield Wizard. 

3. Siga las instrucciones de la pantalla.   
Para tener en cuenta:  El programa de instalación explora sus componentes de video disponibles 
antes de instalar el software.  Si hay algún componente que no esté actualizado, instálelo haciendo 
clic en su botón correspondiente antes de continuar con la instalación. 

4. Una vez terminada la instalación, haga clic en “Finish” (Terminar).  De esta forma, el software 
NuVJ queda listo para usar. 

5. Asegúrese de que el controlador esté conectado al puerto USB de su computadora e inicie NuVJ 
yendo a Start (Inicio) -> Arkaos NuVJ -> Arkaos NuVJ. 
Para tener en cuenta:  Si el controlador se conecta después de lanzar el software NuVJ, es posible 
que no funcione.  Será necesario que reinicie el software.  En general, siempre conecte el 
controlador antes de iniciar el software. 

6. Introduzca el número de serie (16 caracteres) que viene con el NuVJ. 
7. Una vez introducido el número de serie correcto, es conveniente que registre su ejemplar de NuVJ.  

Para hacerlo, es necesario que se conecte a Internet.  El registro le permite acceder a contenido 
adicional y actualizaciones de programas en línea. 

 
 

 

CÓMO INSTALAR EL SOFTWARE - MAC 
 

 
 

1. Para instalar el software NuVJ, inserte el CD de instalación de NuVJ en el lector de CD-ROM de su 
computadora. 

2. Haga clic en el instalador de NuVJ incluido en el CD. 
3. Siga las instrucciones de la pantalla. 
4. Una vez terminada la instalación, verá un acceso directo en el escritorio.  La aplicación aparece 

también en su carpeta Applications (Aplicaciones) -> NuVJ. 
5. Asegúrese de que el controlador esté conectado al puerto USB de su computadora y lance NuVJ. 

Para tener en cuenta:  Si el controlador se conecta después de lanzar el software NuVJ, es posible 
que no funcione.  Será necesario que reinicie el software.  En general, siempre conecte el 
controlador antes de iniciar el software. 

6. Introduzca el número de serie (16 caracteres) que viene con el NuVJ. 
7. Una vez introducido el número de serie correcto, es conveniente que registre su ejemplar de NuVJ.  

Para hacerlo, es necesario que se conecte a Internet.  El registro le permite acceder a contenido 
adicional y actualizaciones de programas en línea. 
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INTRODUCCIÓN AL SOFTWARE 
 

 
En esta sección, haremos un rápido recorrido por el software y explicaremos algunos conceptos importantes 
para su operación.  Recomendamos especialmente que lea esta sección —le brindará un buen panorama de la 
funcionalidad de NuVJ y le enseñará algunos conceptos fundamentales de la mezcla de video. 
 

Conceptos básicos 
 

 
NuVJ le permite mezclar videos e imágenes en tiempo real, de manera muy intuitiva. Está 
construido alrededor de una configuración similar a la bandeja de un DJ, donde tiene dos bandejas 
de reproducción y puede mezclar las salidas de las mismas mediante un cursor mezclador. 

 

              

 Movie A Movie B

Video 
Mixer 

Output

 
 
 

Esta configuración se refleja tanto en la interfaz de software como en el controlador: la bandeja A 
está representada por el área izquierda del panel principal, mientras que la bandeja B está en el 
lado derecho y los controles de mezcla y efecto maestro están en el centro, como se ilustra en el 
gráfico siguiente: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
En cada zona de bandeja, puede ver una serie de cuadrados.  Se denominan ‘celdas’ y son los 
lugares reservados para los video clips, las imágenes o los archivos flash (que llamaremos 
normalmente ‘clips’).  En cada bandeja se puede reproducir una celda por vez. 

 
Para asignar un clip a una celda, simplemente arrastre y deje caer la imagen o video desde el 
navegador de archivos ubicado en el extremo izquierdo de la interfaz o directamente desde la 
ventana del explorador/buscador. Una vez asignado puede hacer clic en la celda para dispararla o, 
como alternativa, pulsar el pad correspondiente del controlador NuVJ.  AL iniciar una celda en cada 
bandeja, puede ver cómo se reproduce cada una en sus ventanas de vista preliminar respectivas y 
el resultado de la mezcla en la ventana central.  Para ver cómo cambia el balance de la mezcla en 
la venta de vista preliminar, mueva el cursor de mezcla ya sea mediante el mouse o el crossfader 
del controlador.   
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La pantalla grande 
Cuando realiza una sesión, habitualmente necesita proyectar la salida con máxima 
resolución.  Para hacerlo, es necesario que active el modo de pantalla completa en 
la interfaz de software.  Esto se hace haciendo clic en Display > Toggle 
Fullscreen (Pantalla > Conmutar pantalla completa) o, como alternativa, pulsando 
CTRL+A (Command+A en Mac) del teclado de la computadora.  Para salir del modo 
de pantalla completa, pulse nuevamente CTRL+A. Como veremos más adelante 
(en Preferencias/Pantalla) en este documento, si su tarjeta de video permite varias 
entradas de video, puede hacer que la interfaz aparezca en su monitor principal y 
el resultado de la salida de pantalla completa se envíe a la salida para monitor 
secundario donde puede conectar un dispositivo de proyección. 
 

 
 

Descripción general 
 

 
Como acabamos de ver, NuVJ funciona alrededor de una sencilla configuración de bandejas A/B y 
mezclador.  En este capítulo, exploraremos más características en detalle. 
 

Bandejas:  
Como dijimos anteriormente, las bandejas son las fuentes 
de las corrientes de video. Contienen celdas que son los 
lugares reservados para los clips. Cuando dispara una 
celda de una bandeja, puede ver la vista preliminar de la 
película o imagen en la ventana ubicada en la parte 
superior del área de la bandeja. Sólo se puede reproducir 
en una bandeja una celda por vez. La celda que se está 
reproduciendo en la pantalla se resalta en rojo en la 
interfaz de software y un LED proporciona también 
realimentación en la superficie de control. 
Celdas:  
 
Las celdas son los lugares reservados a los que usted 
asigna los clips que desea usar en su mezcla.  Además de 
contener un clip, las celdas se pueden asignar también a 
un efecto que se aplica entonces automáticamente al clip 
cargado en esa celda particular.  Para asignar un efecto a 
una celda, simplemente arrastre y deje caer el mismo en 
la celda deseada desde la lista del navegador de efectos 
de la izquierda.   Si se dispara una celda con un efecto, las 
dos perillas de la parte superior de la misma se activan y 
le permiten modificar los parámetros del efecto.  Los 
parámetros del efecto se pueden cambiar ya sea mediante 
el mouse en la interfaz o con las dos perillas de 
parámetros de efectos (PMTR1 y PMTR2) del lado de cada 
bandeja del controlador.  Por ejemplo, en la figura de la 
derecha, se colocó un borrón direccional en la celda 
superior izquierda y sus dos parámetros, LEVEL (Nivel) y 
DIRECTION (Dirección), están disponibles para ajuste.  
Cuando se selecciona (clic derecho) o se reproduce (clic 
izquierdo) una celda con el mouse, un panel con 
parámetros avanzados de la celda se actualiza del lado 
izquierdo de la pantalla.  El mismo permite modificar los parámetros de reproducción y mezcla, como 
también los parámetros predeterminados del efecto cuando se dispara la celda. En el caso de los ‘archivos 
de texto’ especiales, el texto a mostrar se puede editar también allí.  Los parámetros de la celda se explican 
con más detalle más adelante en este manual. 

 

Archivos:  
 
Los archivos son material fuente a reproducir en las celdas.  Es 
posible arrastrar y dejar caer archivos directamente desde la 
ventana de un explorador/buscador o usar el navegador de 
archivos integrado de NuVJ que está a la izquierda de la 
interfaz.  NuVJ soporta diversos formatos de video, imágenes y 
archivos flash. Consulte en la sección Consejos para la 
operación del final de este manual una explicación de los diversos formatos de archivo y su eficiencia.  
Además de reproducir archivos individuales, es posible también arrastrar y dejar caer en la celda una 
carpeta —NuVJ reproduce todos los videos e imágenes que contiene esa carpeta, uno después de otro, a la 
manera de una presentación de diapositivas-  
 

Para tener en cuenta:  por razones de memoria, los archivos reproducidos cuando se usa una 
carpeta no son colocados previamente en caché y la conmutación de una presentación visual a 
otra es menos efectiva que cuando se disparan directamente. 

                                   BANDEJA 

 

 

 

 

 

 

 

 

CELDA 
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Efectos:  
 
Los efectos se usan para alterar los clips de diversas maneras. 
NuVJ proporciona una amplia colección de efectos clasificados 
en diferentes categorías. Se enumeran en la segunda pestaña 
de la sección del navegador del extremo izquierdo de la interfaz. 
Los efectos se pueden aplicar en las celdas para alterar los clips 
individuales o en la salida maestra para alterar el resultado de 
la mezcla. Tenga en cuenta que en función de la capacidad de 
su hardware de video, no todos los efectos pueden estar 
disponibles, dado que algunos requieren hardware de primer 
nivel para funcionar. 
 
Fuentes:  
 
Las fuentes son como los clips, excepto en que no están 
relacionados con archivos del disco duro.  Se enumeran en la 
tercera pestaña de la sección del navegador del extremo 
izquierdo de la interfaz.  Las fuentes se dividen en tres 
categorías principales: entradas en vivo, generadores y textos.  
Las entradas en vivo recogen todas las entradas de cámaras 
disponibles en el sistema.  Usándolas, es posible alimentar a 
NuVJ directamente con cámaras web USB o Firewire, cámaras 
DV, tarjetas de adquisición y otros dispositivos de video La 
categoría Inputs (Entradas) muestra todas las entradas en vivo reconocidas por el sistema. Los generadores 
son elementos que generan automáticamente patrones usando el procesamiento de efectos internos y la 
señal proveniente de la entrada de audio, de manera muy similar a los módulos de visualización de iTunes o 
Windows Media Player.  Para asignar una fuente a una celda, simplemente arrástrela y déjela caer en la 
celda designada. La tercera categoría, ‘texts’ (textos) contiene archivos especiales que se pueden usar a fin 
de mostrar texto para presentaciones, anuncios, etc. 

 
CÓMO USAR LA ENTRADA DE AUDIO:   
NuVJ permite sincronizar sus video clips y su sesión con la señal de su entrada de audio.  Para hacer 
uso de esta característica, conecte una fuente de audio a la entrada de nivel de línea de la tarjeta de 
sonido de su computadora.  Es necesario que se asegure de que la entrada de línea esté seleccionada 
como fuente de entrada.   
PC: Vaya a My Computer -> Control Panel -> Sounds and Audio Device Properties (Mi PC -> Panel de 
control -> Propiedades de los dispositivos de sonido y audio) haga clic en la pestaña Audio y luego en 
Advanced (Avanzadas): de esta forma emerge el panel Volume Control (Control de volumen).  Haga 
clic en Options -> Properties -> Recording (Opciones -> Propiedades -> Grabación): esto permite ver 
las fuentes de entrada de grabación.  Asegúrese de que Line In (Entrada de línea) esté marcada y 
que el cursor de volumen esté hacia arriba. 
Para poder oír la entrada de audio mediante la tarjeta de sonido de la computadora, es necesario que 
vuelva a Options -> Properties -> Playback (Opciones -> Propiedades -> Reproducir) y se asegure de 
que Line In no esté silenciada y que el cursor de volumen esté hacia arriba.  
En algunas tarjetas de sonido, es posible seleccionar la salida de la tarjeta como dispositivo de 
grabación. Generalmente se encuentra en las fuentes de grabación como ‘Stereo mix’ (Mezcla 
estéreo).  Si su tarjeta de sonido tiene tal canal, el seleccionarlo le permitirá sincronizar directamente 
el NuVJ con el audio que se está reproduciendo en la misma PC. 
MAC: Vaya a Finder -> Applications -> System Preferences (Buscador -> Aplicaciones -> 
Preferencias del sistema) y haga clic en el icono Sound (Sonido).  Seleccione Input para ver las 
fuentes de entrada disponibles.  Seleccione el dispositivo que desea usar como entrada —una vez 
seleccionado este dispositivo, NuVJ sincroniza los BPM de su sesión a este dispositivo. 

Biblioteca visual:  
 
La biblioteca visual es una manera conveniente para buscar clips 
que ya están cargados en la aplicación. Una vez cargado un clip 
en NuVJ, queda disponible en la biblioteca visual y se puede 
acceder al mismo en cualquier momento durante su sesión.  La 
biblioteca se encuentra en la cuarta pestaña de la sección del 
navegador. Puede arrastrar y dejar caer directamente elementos 
visuales desde la biblioteca hacia las celdas sin tener que 
buscarlos nuevamente en su disco duro. 
 
Bancos:  
 
Los bancos son grupos de nueve celdas.  Siempre hay 
un banco seleccionado en cada celda.  El número del 
banco seleccionado se muestra en el área azul 
inmediatamente debajo de la ventana de vista 
preliminar de la bandeja.  Es posible cambiar de banco 
en cualquier momento pulsando las flechas 
ascendente y descendente o girando la perilla BANK del controlador.  Usando los bancos, es posible 
organizar sus clips de acuerdo a los temas, el humor o el tipo de secuencias. 
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Control de reproducción de la bandeja:  
 
Junto a la pantalla de selección de bancos, hay unos cuantos controles que se pueden usar para alterar la 
reproducción de las celdas de ese banco: 

 
El indicador superior es la posición de reproducción dentro del clip actual. 
 
El indicador inferior controla la velocidad a la que se reproduce el clip.  El centro representa una 
velocidad de cero (el clip se congela).  Si el indicador se encuentra en la región derecha, la película se 
reproduce hacia delante, mientras que si está en la región izquierda, se reproduce hacia atrás.  
Cuando más se aleja del centro, más rápido se reproduce la película.  Para modificar la velocidad de 
la reproducción usando la interfaz, simplemente haga clic dentro del control para mover el indicador 
de velocidad a ese punto.  También es posible ajustar la velocidad de reproducción usando los 
cursores SPEED del controlador. Una barra vertical del indicador de velocidad muestra el punto de 
velocidad donde la película se reproduce a velocidad nominal. Cuando la velocidad se ajusta alrededor 
de la nominal, el indicador de velocidad se pone rojo. 
 
 
 
 
 
 
 
 
El botón [LATCH] (Enganche) influye en la manera en que reacciona el disparo de las celdas.  Si se 
activa, la celda se mantiene reproduciendo después de soltar el mouse o el pad en la superficie de 
control.  Si se desactiva, la celda deja de reproducir tan pronto se suelta el mouse o el pad del 
controlador.  También se puede activar y desactivar el modo con el botón LATCH de la superficie de 
control. 
 
El botón [SYNC] (Sincronismo) activa un modo de ‘reproducción sincronizada’ para los clips.  Cuando 
se activa, NuVJ adapta la velocidad de la película para que esté ‘en sincronismo’ con los BPM 
detectados en la entrada de audio.  Es posible activar y desactivar el modo de sincronismo desde el 
control usando el botón correspondiente. Cuando se activa el sincronismo, sigue siendo posible alterar 
la velocidad de la película con los cursores de velocidad. 
 
El botón [AUTO] activa el modo automatizado de la bandeja.  En el modo automatizado, NuVJ dispara 
automáticamente las celdas del banco seleccionado de manera aleatoria, siguiendo los BPM 
detectados en la entrada de audio.  Esto puede resultar útil si se necesita un descanso en medio de 
una sesión o simplemente se desea mezclar los elementos visuales. 

 
Crossfader:  
 
El crossfader se encuentra en la posición central. Usando el 
mouse o el cursor del controlador, es posible usar el 
crossfader para mezclar sus películas.  Si el fader está en el 
extremo izquierdo, sólo es visible la salida de la bandeja A, 
mientras que si está en el extremo derecho, sólo se muestra 
la salida de la bandeja B.  En las posiciones intermedias, A y B se mezclan de acuerdo a una curva de 
‘transición’ que se puede elegir.   Para seleccionar la curva de transición, haga clic con el botón derecho en 
el crossfader y elija una de las transiciones disponibles.  El controlador cuenta también con un conmutador 
FADER MODE (Modo de fader) del panel frontal que permite seleccionar entre 3 curvas de transición 
predefinidas.  Para más información sobre la definición de las transiciones usadas por la superficie de 
control, consulte la sección Preferencias. 
 
Efecto maestro:  
 
El efecto maestro es un efecto adicional que se puede aplicar a la 
salida de mezcla de imágenes.  El efecto maestro se puede 
seleccionar ya sea desde la interfaz de software o con la perilla 
MASTER FX de la superficie de control  Cada efecto permite ajustar 
hasta dos parámetros con las perillas PMTR1 y PMTR2 de la 
superficie de control. La perilla FX LEVEL (mezcla del efecto 
maestro) permite ajustar el porcentaje de la imagen con efecto que 
irá a la salida final.  Es posible anular completamente el efecto 
maestro pulsando el botón MASTER FX del controlador. 

 
Control de brillo y contraste:  
 
Después de enviar la imagen a la salida principal, es posible 
ajustar su brillo y contraste. Esto permite ajustar la imagen 
a las condiciones de iluminación del ambiente o compensar 
la pérdida o ganancia de brillo debido al procesamiento y 
mezcla intensivos de las imágenes. Los valores de contraste 
y brillo se pueden controlar ya sea desde la interfaz de usuario o directamente desde la superficie de control 
con las perillas CONTRAST y BRIGHT.  Si no usa esta característica, puede anularla en el diálogo 
Preferencias —de esta forma se puede ahorrar algo de energía de la CPU y mejorar levemente el 
rendimiento. 

 

Tenga en cuenta que la eficiencia de la reproducción a velocidad no 
nominal depende en gran medida del tipo de película y compresión 
usada para los clips.  Para más información sobre este tema, consulte 
la sección Consejos para la operación de este manual. 
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Características avanzadas 
 

 
Fondo:  
 
NuVJ tiene la posibilidad de colocar un clip de fondo que se muestra si no se reproduce ningún clip en 
ninguna de las dos bandejas o si se pulsa el botón [INSTA BLACK] del controlador. El clip de fondo se define 
en el diálogo Preferences yendo a File > Preferences (Archivo > Preferencias) y se puede reemplazar 
también ‘sobre la marcha’ arrastrando y dejando caer un clip en la ventana de vista preliminar maestra. En 
el menú Preferences (Preferencias), es posible también activar el uso de los modos de copia y mezcla (vea 
más adelante) entre la bandeja A y el fondo.  Esta opción no se activa por defecto para evitar confusiones. 
 
Parámetros de la celda y mezcla avanzada:  
 
Cuando se hace clic en una celda con el mouse o se la dispara con uno de los pads, el panel de parámetros 
de la celda de la parte inferior de la interfaz se actualiza para mostrar los valores de la celda seleccionada. 
Para editar los parámetros de la celda sin dispararla, simplemente haga clic en la celda usando el botón 
derecho del mouse. El panel de parámetros contiene opciones avanzadas que le permiten llevar la mezcla y 
la reproducción un paso más adelante.  Para ilustrar estas opciones, imaginaremos mezclar las dos 
imágenes siguientes: 

 
 
Bandeja A: 

 
 

 
Bandeja B: 

 

 
Modos de copia:  
 
Los modos de copia expresan la forma en que se mezclan las celdas de las bandejas A y B en el mezclador.  
A menos que se configure una opción especial (vea Preferences / Advanced), estos parámetros tienen efecto 
sólo cuando se está reproduciendo una celda de la bandeja B. Esto se debe a que se considera virtualmente 
que la bandeja B está ‘arriba’ de la bandeja A y los modos de copia definen la manera en que B ‘se fusiona’ 
en A. 

 
Los modos de copia definen la operación matemática 
usada para combinar el color de los píxels de la bandeja 
B con el color de los de la bandeja A. Veámoslos en 
orden, de izquierda a derecha. 
 

 
La opción por defecto es el modo de copia. En este modo, la celda de la bandeja B simplemente 
se mezcla con la celda de la bandeja A, es decir, la salida resultante es cierto promedio de los 
píxels de cada imagen. 

 
El modo de adición es cuando los píxels de B se agregan a los de A.  Si se selecciona este modo 
(como también los de resta, multiplicación, máximo y mínimo), el efecto es máximo cuando el 
cursor de mezcla está totalmente a la derecha.  

 
 

El modo de resta es cuando los colores de píxels de la bandeja B se restan de los de la bandeja 
A, resultando una mezcla ‘inversa’ de B en A.  

 
 

         El modo de multiplicación es cuando los pixels de la bandeja B se multiplican con los de la 
bandeja A.  

 
 

El modo de máximo selecciona los píxels de las bandejas A o B según cuál tenga mayor 
luminancia. 

 
 

El modo de mínimo selecciona los píxels de las bandejas A o B según cuál tenga menor 
luminancia.  
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Opciones de enmascaramiento:   
 
Las opciones de enmascaramiento permiten eliminar (enmascarar) parte del contenido del clip, en función 
de una característica de color o brillo. Este proceso se conoce también como “combinación por transparencia 
de primer plano y fondo (keying) de luminancia o color. Como en 
los modos de copia, los parámetros de enmascaramiento se 
aplican sólo a las celdas de la bandeja B, puesto que esta 
bandeja está arriba de la A. Cuando se activa la combinación por 
transparencia de primer plano y fondo de luminancia o 
crominancia, se activan las dos perillas que están debajo de la 
selección. Estas perillas permiten definir las características 
(centro y ancho) de un filtro de rechazo de banda que se aplica ya sea a los niveles de brillo o al matiz de la 
imagen del clip. Toda luminancia o color perteneciente a esa zona se hace transparente y A se ve a través 
de dicha zona. 

 
El modo predeterminado, totalmente a la izquierda, inhibe la combinación por transparencia de primer plano 
y fondo. En este caso, las perillas de centro y ancho también se desactivan. 

 
La combinación por transparencia de luminancia permite hacer transparente un rango de 
valores de brillo. Por ejemplo, si coloca el parámetro de centro en el tope de máximo, hará 
transparentes todos los valores de brillo (blanco) y verá debajo el contenido de la bandeja A. El 
centro define el rango de niveles de gris a descartar, 

 
 

La combinación por transparencia de crominancia permite hacer transparente una gama de 
color. La posición de la perilla de centro define el color que se rechaza y la de ancho la 
amplitud del rango de color alrededor del valor central que se elimina. I  

 
Opciones de reproducción:  
 
Las opciones de reproducción afectan a la manera en que se reproduce el clip. Hay tres modos: One Shot 
(Una sola vez), Loop (Ciclo) y Ping-Pong. 

 
En modo One Shot, la película se reproduce una vez cuando se dispara 
y se detiene cuando llega al final. 

  
En modo Loop, el clip se reproduce continuamente. Éste es el modo predeterminado. 

 
En modo Ping-Pong, el clip realiza un ciclo reproduciéndose alternadamente hacia delante, hacia atrás y 
luego otra vez hacia delante, etc.  
 
Opciones de efecto:  
 
Las opciones de efecto del lado derecho permiten configurar los 
valores predeterminados de los parámetros de los efectos. Estos 
valores se recuperan automáticamente cada vez que se dispara la 
celda. Siempre se pueden modificar en vivo usando los parámetros 
de efecto de la bandeja (vea la sección de la bandeja) pero los 
valores predeterminados aquí configurados vuelven cada vez que se 
vuelve a disparar la celda. Para ‘copiar’ los valores en vivo actuales a los parámetros predeterminados de 
esa celda (de modo que se recuerden cada vez que se dispara la celda), presione el perilla BANK del 
controlador correspondiente a la celda seleccionada.   
 
Parámetros de texto: 
 
Cuando se usan textos del navegador de fuente, puede alterar el texto que se muestra modificándolo en la 
entrada de texto ubicada en el panel de parámetros de la celda. 
 
Importación/exportación de bancos:  
 
Además de poder cargar y guardar el contenido completo de su sesión accediendo al menú de archivo, 
también se puede importar y exportar bancos individuales manteniendo pulsado el botón derecho del mouse 
sobre una celda y seleccionando la entrada de un menú emergente (consulte una explicación más detallada 
en la descripción de la interfaz de usuario). Esta característica facilita la carga de grupos de elementos 
visuales predefinidos durante su sesión. Permite guardar un número ilimitado de conjuntos de clips y efectos 
preconfigurados y recuperarlos sin tener que detener la sesión en ningún momento. 
 
Doble monitoreo:  
 
Para realizar una sesión correcta como VJ, es más conveniente usar tarjetas de video que soporten 
monitores dobles. De esta forma, es posible proyectar la salida del mezclador en su segundo monitor 
(vinculado a un sistema de proyección, por ejemplo) y acceder al mismo tiempo a la interfaz de usuario de 
al lado del controlador en el monitor primario. Para configurar el doble monitoreo dentro de NuVJ, es 
necesario asegurarse primero de que su sistema esté configurado para funcionar con dos salidas de pantalla 
independientes (y no esté usando el modo clone en el cual las salidas de ambos adaptadores producen la 
misma imagen). Una vez configurado su sistema, inicie NuVJ y acceda al diálogo Preferences (File > 
Preferences).  En la sección Display (Pantalla), seleccione el monitor que desea usar para la salida de 
pantalla completa. Hecho esto, puede entrar al modo de pantalla completa accediendo a Display > Toggle 
Fullscreen (Pantalla > Conmutar pantalla completa) o pulsando CTRL+A (command+A en Mac).  También es 
posible salir del modo de pantalla completa pulsando CTRL+A (command+A en Mac). 
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CÓMO USAR EL SOFTWARE 
 

 
Esta sección detalle los diversos elementos de la interfaz de usuario, como también la manera de interactuar 
plenamente con el programa. 
 
La interfaz de usuario se divide en 4 áreas diferentes: la zona de menú/navegador (superior izquierda), la zona 
de mezcla (superior derecha), la ventana de información (inferior izquierda) y el panel de parámetros de la 
celda (inferior derecha).            
         

 
 

Menús 
 

 
Los menús se organizan de la siguiente manera: 

 
File (Archivo) -------------------- 

New (Nuevo): Borra todos los datos y comienza con una sesión en blanco 
  Open (Abrir): Abre un archivo de sesión (.nvj) 
     Save (Guardar): Guarda la sesión actual 
     Save As... (Guardar como). Guarda la sesión actual como un nuevo archivo 

       Preferences (Preferencias): Activa el diálogo de preferencias 
Quit (Salir): Cierra la aplicación. Funciona sólo cuando no está activa la pantalla completa, a 
fin de evitar cerrar la aplicación en medio de una sesión. 

 
Edit (Editar) -------------------- 

Cut Cell (Cortar celda): Elimina la celda editada actual y copia su contenido al portapapeles 
Copy Cell (Copiar celda): Copia la celda editada actual al portapapeles 
Paste Cell (Pegar celda): Copia el portapapeles a la celda editada actual 
Clear Background (Borrar fondo): elimina el clip de fondo actual 

   Purge Visuals (Purgar elementos visuales): elimina de la memoria los clips sin usar. 
  

Display (Pantalla) -------------------- 
Toggle Fullscreen (Conmutar pantalla completa): activa y desactiva el modo de pantalla 
completa 

 
Help (Ayuda) -------------------- 

Getting Started (Para comenzar): abre el pdf de la Guía de inicio rápido de NuVJ 
    Reference Manual (Manual de referencia): abre el pdf del Manual de referencia de    
    NuVJ 
    Release Notes (Notas de la versión): muestra el pdf que contiene la información de  
    versión de software actual e información adicional relativa a la edición de software. 
    NuVJ Web Site (Sitio web de NuVJ): abre el sitio web de NuVJ en su navegador de Internet 
    Register (Registro): le permite registrar NuVJ por Internet 
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Zona del navegador 
 

 
La zona del navegador proporciona varias vistas de árbol para tomar el contenido y los efectos 
necesarios para armar su sesión de VJ. La zona contiene cuatro pestañas que acceden a Files 
(Archivos), Effects (Efectos), Sources (Fuentes) y Library (Biblioteca).  Para usar cualquiera de 
ellas, simplemente arrastre y deje caer un elemento del navegador en una celda. Adicionalmente, 
es posible también arrastrar y dejar caer elementos en cualquiera de las ventanas de vista 
preliminar: Si lo arrastra a una de las ventanas de vista preliminar de la bandeja, el elemento 
reemplaza al clip o efecto visual de la celda que se está reproduciendo.  Si arrastra un elemento a 
la vista preliminar maestra, establece el clip de fondo o el efecto maestro. 
 
Debajo de la zona del navegador, se encuentra un cuadro de filtro de archivos que permite 
seleccionar qué archivos van a ser visibles en el navegador. La opción predeterminada es mostrar 
todos los archivos compatibles (videos, imágenes y archivos flash) pero es posible cambiarla para 
mostrar sólo imágenes, sólo películas, sólo archivos flash o todos los archivos presentes en el disco 
duro. 
 
Bajo este filtro también hay un icono de papelera. Este icono se puede usar para eliminar 
elementos visuales y efectos de las celdas simplemente arrastrando y dejando caer la celda o el 
icono de efecto de la celda al icono de la papelera. 
 

Zona de mezcla 
 

 
La zona de mezcla contiene toda la información relacionada con el contenido y la vista preliminar 
de las bandejas, así como el cursor de mezcla y el efecto maestro. La columna del extremo derecho 
es la bandeja, la del extremo derecho la B y la central es la zona de mezcla y efecto maestro. 
 
Zonas de bandejas (A y B): 

 
Cada bandeja contiene los siguientes elementos, de arriba a abajo: 

  
Vista preliminar: Muestra la salida de la celda de la bandeja. Es posible arrastrar y 
dejar caer elementos desde el navegador directamente a la vista preliminar de la 
bandeja, que reemplazarán al elemento visual o efecto de la celda que se está 
reproduciendo. 

 
Controles: Contienen los elementos que le permiten controlar la selección de banco y la 
velocidad de reproducción de la bandeja, así como configurar los modos de enganche, 
automático y de sincronismo. Para más información acerca de estos controles, consulte 
‘Control de reproducción de la bandeja’ en la sección ‘Introducción al software” de este 
manual. 

 
Parámetros de efectos: Permite alterar los parámetros de efectos de la celda que se 
está reproduciendo. Tenga en cuenta que estas modificaciones son sólo temporarias: 
tan pronto se dispara una nueva celda, los valores de los parámetros de efectos se 
reinicializan al valor definido en el panel de parámetros de la celda. Si desea copiar los 
parámetros de efectos actuales a los predeterminados de la celda, de modo que se 
usan la próxima vez que la dispare, presione simplemente el botón [BANK] de la 
bandeja. 

 
Celdas: En la parte inferior de la bandeja, aparecen las nueve celdas del banco 
seleccionado. Arrastre y deje caer a una celda cualquier archivo, efecto o fuente del 
navegador para alterar su contenido. La celda muestra una instantánea del clip que se 
le asignó, así como unos pocos iconos informativos, a saber: 

 
Una celda en escala de grises, rodeada por un recuadro rojo, 
significa que la celda se está reproduciendo en la bandeja en ese 
momento. El icono de un lápiz en la esquina superior izquierda 
significa que la celda está seleccionada para edición y que sus 
parámetros son visibles en el panel de parámetros de la misma. 
También significa que es la destinataria de cualquier operación 
de copiar/pegar. Para seleccionar una celda, haga clic en la 
misma ya sea con el botón izquierdo del mouse (en cuyo caso la 
celda se dispara y selecciona para edición) o con el derecho (en cuyo caso la celda se 
selecciona pero no se dispara). 

 
El icono de abajo a la derecha significa que la celda tiene aplicado un efecto. El de la 
izquierda del mismo significa que los modos de copia y enmascaramiento de la celda no 
son los predeterminados. 

 
Es posible arrastrar y dejar caer elementos visuales y efectos entre celdas. Para 
arrastrar un clip de una celda a otra, simplemente haga clic en el área de la imagen y 
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arrástrela a otra celda. Para arrastrar un efecto de una celda a otra, arrastre el icono 
del efecto. 

 
Si hace clic con el botón derecho en una celda y la mantiene 
oprimida unos instantes, aparece un menú emergente con las 
siguientes entradas: 

  
Clear Visual (Borrar elemento visual): Elimina el elemento 
visual de la celda 
Clear Effect (Borrar efecto): Elimina el efecto de la celda 
Reset Cell (Reinicializar celda): Elimina todos los ajustes, 
elementos visuales y efectos de la celda 
Import Bank (Importar banco): Importa un banco completo desde un archivo .nvjb 
reemplazando el banco al que pertenece la celda. 
Export Bank (Exportar banco): Permite exportar todo el banco al que pertenece la 
celda en un archivo .njvb. 
Clear Bank (Borrar banco): Borra el contenido del banco. Los clips se siguen 
manteniendo en memoria para acceso ulterior (a través del navegador de la biblioteca 
visual). Para liberar el espacio usado por los clips no seleccionados en ningún banco, 
use  ‘Purge Visuals’ de menú de edición. 

 
 
Zona de mezcla y efecto maestro: 

 
La zona central contiene todos los elementos relativos al procesamiento de la salida maestra y la 
mezcla. Contiene, de arriba a abajo: 

 
Vista preliminar: La vista preliminar de la salida duplica las imágenes enviadas a un segundo 
monitor en modo de pantalla completa. Es posible arrastrar y dejar caer elementos del navegador 
en la vista preliminar de la salida. Si arrastra un clip, una fuente de cámara o generador, ese 
elemento reemplaza al fondo que está seleccionado en ese momento (vea la información sobre el 
fondo en la sección Concepto). Si arrastra un efecto, dicho efecto se usará como efecto maestro 
actual. 

 
Brillo y contraste: Estos dos controles permiten corregir el brillo y el contraste de la imagen, ya sea 
para adaptarla a las condiciones de luminosidad del ambiente o para compensar el resultado de la 
aplicación intensiva de efectos. 

 
Sección de efecto maestro: Esta sección permite aplicar un efecto adicional a la salida del 
mezclador. El efecto se puede seleccionar usando el recuadro combinado y las tres perillas de 
abajo permiten alterar el efecto propiamente dicho. La primera determina el porcentaje de imagen 
original/efecto (wet/dry) entre la salida original y la salida con efectos, mientras que las otras dos 
modifican los parámetros específicos del efecto seleccionado. 

 
Crossfader: Controla la mezcla entre las bandejas A 
y B. En el extremo izquierdo, sólo deja pasar a la 
salida la bandeja A, mientras que el extremo 
derecho, sólo se muestra B. La manera en que se 
mezcla la imagen de A a B depende de la transición 
usada. Las transiciones se pueden seleccionar 
haciendo clic con el botón derecho en el crossfader o 
usando el conmutador configurado en la superficie 
de control. Tenga en cuenta que el número de 
transiciones disponibles depende de las capacidades 
de su hardware. 
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Zona de información 
 

 
La zona de información de la esquina inferior izquierda de la pantalla muestra información dinámica 
basada en el elemento en el que está posicionado el mouse. Si necesita obtener información sobre 
un elemento específico, simplemente pase el mouse sobre él y lea aquí la información. 
 

Panel de parámetros de la celda 
 

 
El panel de parámetros de la celda permite editar los parámetros relacionados con la celda 
que está seleccionada para edición. Hay una sola celda en esas condiciones por vez y se 
puede reconocer mediante el siguiente icono superpuesto a la instantánea del elemento 
visual:   

 
Como se explica en detalle en la sección ‘Concepto’, el panel permite modificar las características 
de reproducción y mezcla de cada celda. También se usa para configurar los valores de parámetros 
predeterminados que se restauran cada vez que se vuelve a disparar la celda. 
 

Diálogo de preferencias 
 

 
El diálogo de preferencias configura varios parámetros que regulan la manera en que funciona el 
programa. Estos parámetros se clasifican en cuatro categorías, cada uno de ellas accesible a través 
de una pestaña del diálogo: 
 
 General (Generales): 
 

Background Visual 
(Elemento visual de fondo): 
Especifica el archivo a usar 
como clip de fondo. Este 
archivo se 
reproduce/muestra cuando 
no se está reproduciendo 
ninguna celda de las 
bandejas o cuando se pulsa 
el botón ‘Fade to Black’ 
(Fundir a negro) del 
controlador). Introduzca la 
ruta completa del archivo o 
use el botón de selección 
para abrir un navegador de 
archivos. Este archivo se 
usa como fondo 
predeterminado y se restaura cuando se inicia la aplicación, se carga un archivo de 
sesión o se reinicializan los datos usando el menú File>New (Archivo>Nuevo). Es posible 
sobrescribir el valor aquí configurado ya sea seleccionando el menú Edit>Clear 
Background (Editar>Borrar fondo) o arrastrando y dejando caer un clip directamente en 
la ventana de vista preliminar maestra.  
 
Automation Beat Count (Cuenta de beats de automación): Selecciona el número de 
beats que la automación espera antes de disparar un nuevo elemento visual. Consulte 
‘Conceptos/Controles de reproducción de la bandeja’ 
 
Slide Show Time (Tiempo de exhibición de diapositivas): NuVJ le permite arrastrar y 
dejar caer carpetas a una celda. En ese caso, todas las películas, imágenes o archivos 
flash que contiene dicha carpeta (y en forma recursiva) se reproducen uno tras otro a la 
manera de una presentación de diapositivas. El parámetro ‘tiempo de exhibición de 
diapositivas’ establece el tiempo (en segundos) que se muestran las imágenes antes de 
mostrar el siguiente elemento visual de la jerarquía. 
 
Transition 2 (Transición 2) y Transition 3 (Transición 3): El controlador tiene un 
ajuste de conmutación que permite elegir entre 3 transiciones sobre la marcha. La 
primera transición es siempre la predeterminada (transparencia exponencial), pero las 
otras dos son configurables. Estas dos listas permiten seleccionar la transición que desea 
ver asociada con los ajustes ‘2’ y ‘3’ del conmutador de transición. 
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Display (Pantalla):  
 

La ficha de pantalla define las opciones relacionadas con el modo de pantalla completa 
de la aplicación. 

  
Full Screen Monitor 
(Monitor de pantalla 
completa): Define el monitor 
a usar por el modo de 
pantalla completa de la 
aplicación. Eligiendo una 
salida diferente a su monitor 
principal, será capaz de 
enviar la mezcla a la salida 
alternativa mientras se 
mantiene visible la interfaz 
de usuario para el ajuste y 
la realimentación visual en 
su monitor predeterminado. 
  
Resolution (Resolución): 
Especifica la resolución 
usada internamente para procesar todos los gráficos. Cuando más bajo sea el valor que 
especifique, más rápidos serán los cálculos (y por lo tanto mejor la velocidad de 
cuadros), pero peor la calidad de imagen. Experimente con diferentes valores para lograr 
un equilibrio adecuado entre la calidad de imagen y la velocidad de cuadros. 
Normalmente, 800x600 es correcta para los dispositivos de proyección. 
 
Exclusive Mode (Modo exclusivo): Fuerza a Windows a funcionar en modo exclusivo. En 
este modo, los rendimientos son levemente mejores pero tiene un gran inconveniente: 
Una vez en este modo, sólo se puede usar NuVJ. Si se activa cualquier otro programa, se 
fuerza a NuVJ a salir del modo de pantalla completa. Por lo tanto, no se recomienda este 
modo si piensa ejecutar otras aplicaciones mientras usa NuVJ. 

 
 

Performances (Rendimientos):  
 

La ficha de rendimientos permite afinar ciertos elementos del funcionamiento a fin de 
obtener una mejor velocidad de cuadros. 

 
GPU Level (Nivel de GPU): 
Este primer campo es un 
indicador de la potencia de 
su hardware gráfico. El nivel 
puede estar entre 0 y 5. Si 
bien el programa funciona 
en cualquiera de esos 
niveles, recomendamos 
como mínimo un nivel de 
GPU de 2 a fin de disfrutar 
plenamente el NuVJ. Por 
debajo del nivel 2, ciertas 
funciones pueden no estar 
disponibles, puesto que el 
hardware no las soporta.  
 
Rendering Quality 
(Calidad de la producción): Este cursor se usa para especificar un nivel de calidad de 
diversos aspectos del proceso de producción de imágenes. Expresa el compromiso entre 
la calidad de imagen y la velocidad de producción. Si está totalmente a la derecha, se 
preserva la calidad máxima. SI está totalmente a la izquierda, la calidad de diversos 
aspectos (vista preliminar, procesamiento interno, etc.) se degrada y la velocidad de 
cuadros aumenta debido a la menor cantidad de procesamiento. Pruebe varios valores y 
recuerde que la resolución seleccionada en la ficha ‘Display’ influye automáticamente 
sobre el rendimiento de su sistema. 

 
Disable Contrast/Brightness Control (Desactivar control de contraste y brillo): En el 
hardware de funcionamiento lento, es posible inhibir los controles de contraste y brillo 
para dejar más lugar al procesamiento principal. 
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Advanced (Avanzadas) 
 

Auto purge after (Purga 
automática después de): 
Cuando se importa una 
película a NuVJ, permanece 
en memoria aunque no se 
asigne a ninguna celda. 
Liberar las películas no 
usadas es importante para 
evitar que congestionen la 
memoria de la computadora. 
Este parámetro permite 
ajustar un temporizador 
para purgar periódicamente 
las películas sin usar. 
 
Auto purge when 
physical memory left 
reaches (Purga automática cuando la memoria física remanente llega a): Este 
parámetro permite purgar automáticamente las películas sin usar cuando la memoria 
física remanente de la computadora se reduce demasiado. Esta opción está disponible 
sólo para PC.  
 
Use Mask and Copy Mode on Deck A (Usar modo de máscara y copia en bandeja A): 
Normalmente, los modos de máscara y copia definidos en el panel de parámetros de la 
celda sólo están activos cuando la celda se está reproduciendo en la bandeja B. Al 
activar esta opción, se activan los parámetros en la bandeja A, lo que significa que la 
celda que está funcionando en esa bandeja se compondrá primero con el clip de fondo 
usando los parámetros de enmascaramiento y copia antes de ser enviada al mezclador. 
Combinando esta opción con el hecho de que es posible cambiar el fondo arrastrando y 
dejando caer elementos visuales en la vista preliminar maestra, se obtienen capacidades 
de mezcla más avanzadas. 
 
Play sound in QuickTime movies (Reproducir sonido en películas de QuickTime): Si se 
selecciona esta opción, las pistas sonoras de la película de QuickTime no son ignoradas, 
lo que permite a NuVJ rayar tanto el video como el audio al mismo tiempo. 

 
 

Controller (Controlador): 

 
La sección del controlador contiene opciones relacionadas con el uso de este 
dispositivo. 

 
Status (Estado): muestra el estado del controlador (fuera de línea/conectado) 
Firmware: muestra el nivel de firmware del controlador (sólo disponible si éste está 
conectado) 
LCD Contrast (Contraste de la LCD): Permite ajustar el contraste de la pantalla LCD del 
controlador. Una vez ajustado, el valor de contraste se almacena permanentemente en 
el controlador y se 
recupera la próxima vez 
que éste se usa. 
Scratch sensitivity 
(Sensibilidad del rayado): 
ajusta la sensibilidad de 
las ruedas de avance 
lento en el modo de 
rayado 
Slide Sensitivity 
(Sensibilidad del cursor): 
ajusta la sensibilidad de 
las ruedas de avance 
lento cuando se usan sin 
pulsar el botón de rayado 
(‘pitch bend’). 
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CONSEJOS PARA LA OPERACIÓN 
 

 
 
 
 
 
 
 
 
 
Lograr un buen rendimiento con video puede ser difícil, porque depende de muchos factores diferentes:  
 
Los factores más importantes son: 

 
• Velocidad de la CPU 
• Velocidad del disco 
• Velocidad de acceso a RAM 
• Velocidad del hardware y el bus de video 
• Compresión de la película 

 
No hay una manera sencilla de dar respuesta definitiva en términos de qué es lo mejor para cada entorno 
de computadora. En NuVJ, la mayoría del procesamiento gráfico se realiza en el hardware de video, de 
modo que cuanto más potente sea, mejor será el rendimiento que usted obtendrá. La CPU se usa 
principalmente para descomprimir los cuadros de las películas del disco y enviarlos a la tarjeta de video. 
Cuanto más rápidas sean sus unidades de disco, más rápido se cargarán los cuadros en la memoria y, 
cuanto más rápida sea su CPU, más rápido descomprimirá los cuadros. Para lograr una buena velocidad de 
cuadros con un hardware determinado, es posible hacer lo siguiente: 
 
• Adaptar la resolución de la computación interna. Consulte (Preferencias/Pantalla) 
• Usar el cursor de rendimiento para encontrar un equilibrio entre calidad y rendimiento que se adapte 

a su hardware. 
• Usar material fuente que se adapte a su hardware. Si tiene un disco lento o una generación de 

hardware antigua, trate de trabajar con fuentes de video más pequeñas para minimizar el impacto de 
la carga y descompresión de la película. Puesto que todos los cálculos se realizan dentro del hardware 
de video, los efectos de generación de alias se minimizan mediante el filtrado automático aplicado 
cuando las imágenes se ajustan a escala de la resolución final. 

 

Compresión de la película 
 

Además del tamaño de la película, su esquema de compresión tiene un alto impacto tanto en la fluidez de la 
imagen como en su posibilidad de reproducción. Cuanto más complejo es el esquema de compresión, más 
trabajo debe realizar el procesador para recuperar cuadros específicos, lo que resulta en un funcionamiento 
lento. Además del método de compresión propiamente dicho, está el problema de los marcos clave (key 
frames). Los mecanismos de compresión más difundidos funcionan usando métodos incrementales, lo que 
significa que construyen un cuadro almacenando la diferencia entre un cuadro y el anterior. A fin de evitar 
que el proceso derive demasiado del material original, almacenan un cuadro original de vez en cuando y 
luego comienzan nuevamente a codificar la información incremental a partir de ese cuadro. Estos cuadros 
originales se denominan ‘key frames’ (marcos clave). Usar marcos clave dispersos significa que para que 
NuVJ pueda acceder a un cuadro dado, tiene que encontrar el cuadro clave anterior y procesar todas las 
diferencias de los cuadros intermedios hasta alcanzar el deseado. Como podemos imaginar, este proceso es 
algo lento e impide el acceso rápido a los cuadros, lo que es muy importante para la reproducción hacia 
atrás o el rayado. Es por esto, que los esquemas de compresión tales como mpeg o DivX no son adecuados 
en absoluto para las sesiones de video. 
 

 
 
 
 
 
 

Utilización de la memoria 
 

Las películas ocupan grandes espacios de memoria. Según su tamaño y duración, pueden usar mucho 
espacio muy rápidamente. Cuando se importa un archivo a NuVJ, se mantiene en memoria aunque no esté 
asignado a ninguna celda. De esta forma se puede usar el navegador ‘visual’ para buscar archivos que ya 
estén cargados sin tener que navegar e importarlos nuevamente. Cuando la memoria de la computadora 
comienza a llenarse, su rendimiento puede disminuir, de modo que es importante no perder de vista ese 
factor. Para liberar películas no usadas del software, es necesario ‘purgarlas’.  Esto se puede lograr de 
diversas maneras: 
1.  Purgando manualmente las películas mediante el menú ‘Editar/Purgar elementos visuales’ 

2. Usando la función de purga automática, que se puede configurar en el diálogo Preferencias/Avanzadas. La 
purga automática le permite seleccionar un umbral de tiempo o memoria que, cuando se alcanza, se purga 
automáticamente las películas no usadas de la memoria de la computadora. Para más información acerca de 
esa función, consulte la sección Preferencias de este manual. 
 

Es muy importante tener en cuenta que los esquemas de compresión populares son muy 
ineficientes para la operación como VJ. Los archivos de video que usan estos esquemas de 
compresión se comportan “correctamente” cuando se usan a velocidad nominal (100%) pero 
pueden ser muy lentos y pesados si se cambia la velocidad o se los raya. Esta observación es 
válida para los códecs de mpeg, divx y DV, entre otros. Si los usa, obtendrá un pobre 
rendimiento del software.

Nuestra experiencia indica que el mejor esquema de compresión para la 
reproducción de video es usar Photo JPEG de QuickTime  con un ajuste de 

calidad de alrededor del 80% o más. De esta forma se asegura una reproducción 
pareja, un rayado eficaz y tamaños de archivos decentes. 
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INTRODUCTION 
 

 
Bienvenue dans NuVJ!  NuVJ est un environnement intuitif qui permet de fusionner une application logicielle et 
matérielle pour une performance de qualité professionnelle en toute simplicité.  L’environnement NuVJ s’inspire 
de l’environnement de travail du DJ qui permet le mixage, le scratch et l’application d’effets aux vidéo-clips et 
aux images.  Nous avons conçu le logiciel et le contrôleur NuVJ pour qu’ils soient simples à utiliser tout en vous 
permettant une plénitude de variations créatives pour vos sources visuelles.  Nous avons également ajouté des 
caractéristiques telles que la possibilité d’utiliser un signal d’entrée en direct, la synchronisation à la musique 
et la génération d’effets en temps réel, en espérant que ce produit vous procure autant d’amusement que nous 
avons eu à le créé. 
 
Cordialement, 
 
L’équipe de chez Numark et Arkaos 
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VUE D’ENSEMBLE DU CONTRÔLEUR 
 

 
Le contrôleur NuVJ permet de communiquer rapidement et efficacement avec les fonctions et les 
caractéristiques les plus importantes du logiciel NuVJ.  Le contrôleur a été conçu spécialement pour 
commander le logiciel NuVJ mais peut être également utilisé comme contrôleur MIDI pour d’autres applications 
logicielles et matérielles qui supportent le protocole MIDI.   
 

Remarque :  Le contrôleur NuVJ a été conçu spécifiquement pour être utilisé avec le logiciel NuVJ.  
Cependant, il peut également être utilisé comme contrôleur MIDI pour d’autres applications qui 
répondent aux commandes MIDI.  Si vous utilisez le contrôleur NuVJ avec d’autres applications 
logicielles, il se peut que vous notiez que certaines des fonctions du contrôleur soient désactivées.  
Par exemple, les pads et les touches ne s'allumeront pas.  Ceci est tout à fait normal, le contrôleur 
fonctionnera tout de même correctement.   

 
Aux fins du présent guide, nous nous en tiendrons au fonctionnement du contrôleur lorsqu’utilisé avec le 
logiciel NuVJ seulement.  Veuillez lire les sections « Introduction au logiciel » et « Utilisation du logiciel » de ce 
guide pour plus d'information sur le logiciel. 
   

Panneau supérieur  
 

 

 
 

1. PADS : Les 9 pads de chaque section permettent de sélectionner le vidéo-clip qui sera affiché 
sur l’écran du lecteur de cette section.  Taper le pad permet de lancer le vidéo-clip assigné à 
cette cellule dans le logiciel.  Veuillez consulter la section « Introduction au logiciel » pour 
plus d'information sur les vidéo-clips, cellules et les lecteurs. 

2. Molette : Les molettes de chaque section peuvent être utilisées pour le scratch ou pour 
augmenter/diminuer la vitesse de lecture du vidéo-clip en cours.  Si vous maintenez la 
touche [SCRATCH] enfoncée sous la molette, vous pouvez l’utiliser pour faire du scratch sur 
le vidéo-clip.  Si la touche n’est pas enfoncée, la molette permet d’augmenter et de diminuer 
la vitesse de lecture des vidéo-clips temporairement. 

3. SPEED : Les deux potentiomètres dans le milieu permettent de régler la vitesse de lecture du 
vidéo-clip, soit de l’augmenter, la diminuer ou d’inverser le vidéo-clip de chaque lecteur. 



 

45 

4. [SCRATCH] : Lorsque la touche est maintenue enfoncée, la molette peut être utilisée pour le 
scratch du vidéo-clip en cours de lecture sur ce lecteur. 

5. [INSTA A/B] : Ces touches vous permettent de commuter rapidement d’un lecteur à l’autre.  
Par exemple, si vous appuyez sur la touche [INSTA A] la sortie vidéo affiche uniquement ce 
qui est en cours de lecture sur le lecteur A, peu importe la position de l’atténuateur, jusqu’à 
ce que vous relâchiez la touche [INSTA A].  La vitesse du fondu lorsque les touches [INSTA 
A/B] sont enfoncées est déterminée par le bouton Auto Fade Speed situé sur le panneau 
avant. 

6. BANK : Utilisez ce bouton pour sélectionner les différentes banques de vidéo-clips.  Chaque 
banque contient jusqu’à 9 clips qui peuvent être lancés en appuyant sur le pad 
correspondant.  Il y a 16 banques différentes qui peuvent être utilisées sur une des deux 
sections lecteur. 

7. PMTR1 : Chaque cellule d’une banque peut être assignée à un effet. Le bouton PMTR1 
permet de régler le premier paramètre d’effet pour la cellule de la banque présentement en 
cour de lecture sur ce lecteur.  Ce paramètre sera différent, selon l’effet sélectionné pour la 
cellule. 

8. PMTR2 : Le bouton PMTR2 permet de régler le second paramètre d’effet pour la cellule de la 
banque présentement en cour de lecture sur ce lecteur.  Ce paramètre sera différent, selon 
l’effet sélectionné pour la cellule. 

9. [LATCH] : Si la touche [LATCH] est enfoncée, les clips sur ce lecteur joueront en continu 
lorsqu'ils seront lancés.  Si la touche [LATCH] n’est pas enfoncée, les clips sur ce lecteur 
joueront jusqu’à ce que le pad correspondant soit relâché. 

10. [AUTO] : Cette touche permet de faire jouer les clips (cellules) de la banque en cours de 
façon aléatoire. 

11. [SYNC] : Cette touche permet de synchroniser les vidéo-clips en cours de lecture sur le 
lecteur au BPM de la session. 

12. ÉCRAN D’AFFICHAGE : L’écran permet de visionner les paramètres du logiciel. 

13. FX LEVEL : Ce bouton permet de régler le Master FX Mix.  Ce réglage permet de déterminer 
la quantité de l'effet sélectionné (Master Effect) qui sera mixée à l’image originale.  Plus vous 
augmenterez le niveau, plus l'image sera saturée.  Plus vous diminuerez le niveau, plus vous 
verrez l'image originale. 

14. [MASTER FX] : Cette touche permet d’activer et de désactiver l’effet général.  Vous pouvez 
changer d’effet rapidement en sélectionnant l’effet désiré à l’aide du bouton Master FX.    

15. MASTER FX : Tournez ce bouton pour sélectionner l’effet général.  L’effet général sera 
appliqué à la section de mixage principale.   

16. PMTR1 : Ce bouton permet de régler le premier paramètre de l’effet général.  Ce paramètre 
sera différent, selon l’effet sélectionné. 

17. [INSTA BLACK] : Cette touche permet de faire passer l’image de la sortie vidéo au noir ou à 
un fond visuel assigné dans le logiciel NuVJ.  

18. CONTRAST : Utilisez ce bouton pour régler le contraste de la sortie vidéo. 

19. PMTR2 : Ce bouton permet de régler le second paramètre de l’effet général.  Ce paramètre 
sera différent, selon l’effet sélectionné. 

20. [BPM TAP] : Cette touche permet de régler manuellement le tempo de la session en la 
tapant au rythme de la musique.  Si vous maintenez la touche enfoncée pendant 3 secondes, 
puis la relâchez, le BPM de la session retourne au BPM de l’entrée audio. 

21. BRIGHT : Utilisez ce bouton pour régler la luminosité de la sortie vidéo. 

22. CROSSFADER : Le crossfader permet de mixer les deux images en cours de lecture sur 
chaque côté.  Si vous le déplacez vers la droite, plus il y aura de l’image droite dans le mix.  
Si vous le déplacez vers la gauche, plus il y aura de l’image gauche dans le mixe. 
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Panneau arrière 
 

 

 

 

1. AC IN : Si l’appareil ne peut être alimenté pas le port USB, il peut être alimenté par un câble 
d’alimentation 6 V 1A c.c. branché à cette entrée.  

2. USB : Branchez un câble USB de votre ordinateur à cette entrée.  Ce port permet d’alimenter 
l’appareil, tout en lui permettant de transmettre des données de commandes MIDI à votre 
ordinateur et au logiciel.  Vous pouvez également alimenter le contrôleur à l’aide d’un câble 
d’alimentation de 6 V 1A c.c. 

3. VERROU KENSINGTON : L’appareil peut être fixer et verrouiller à une surface à l’aide de ce 
verrou de sécurité Kensington. 

   

Panneau avant : 
 

 

 
 
1. FADER MODE : Ce commutateur détermine le mode de fonctionnement de la commande 

automatique, tel que spécifié dans le logiciel. 

2. AUTO FADE SPEED : Ce commutateur permet de régler la vitesse du fondu automatique. La 
vitesse du fondu automatique détermine la vitesse du fondu à partir de la position courante 
jusqu’à l’extrémité A/l’extrémité B lorsque les touches Insta A/B du panneau supérieur sont 
utilisés. 

3. FADER START : Ce commutateur permet d'activer un pad sélectionné en déplaçant le 
potentiomètre vers le lecteur sur lequel il est chargé.  Par exemple, si le crossfader est placé 
à l’extrémité gauche ou droite, le déplacer vers le côté opposé lance le vidéo-clip sélectionné 
sur ce lecteur.   
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RACCORDEMENT DU CONTRÔLEUR À L’ORDINATEUR 
 

 

 

 

Pour raccorder le NuVJ à votre ordinateur, veuillez brancher le câble USB depuis le port USB de 
votre ordinateur au port USB du NuVJ.  Il n’est pas nécessaire de brancher un câble d’alimentation 
– le contrôleur est alimenté via le port USB de votre ordinateur, cependant, si vous désirez utiliser 
une alimentation externe, vous pouvez utiliser un câble de 6 V 1A.    

Le NuVJ est un appareil prêt à l’utilisation (Plug and Play), il n’y a donc pas de pilotes ou de 
logiciels spéciaux à installer.  Lorsque vous branchez le contrôleur, l'écran s'allume et affiche 
« NuVJ ».  

 
Veuillez noter : Lorsque vous utilisez le contrôleur NuVJ avec d’autres logiciels, 
certaines des fonctions du contrôleur sont désactivées.  Ces fonctions incluent les 
témoins DEL et l’affichage des valeurs.  « NuVJ » apparaît tout simplement à l’écran. 
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INSTALLATION DU LOGICIEL SUR PC 
 

 
 

1. Pour installer le logiciel NuVJ, insérez le CD d’installation NuVJ dans le lecteur de votre ordinateur. 
2. Double-cliquez sur le fichier d’installation NuVJ, situé dans le répertoire de base du CD.  Ceci 

lancera l’assistant d’installation InstallShield. 
3. Suivez ensuite les instructions à l’écran.   

Remarque :  Le programme d’installation fera un balayage de vos composantes vidéo disponibles 
avant d’installer le logiciel.  S’il y a des composantes qui ne sont à jour, veuillez les installer en 
cliquant le bouton correspondant avant de faire l’installation du logiciel. 

4. Une fois l'installation complétée, cliquez sur Terminer.  Le logiciel NuVJ est maintenant prêt à 
utiliser. 

5. Assurez-vous que le contrôleur est branché au port USB de votre ordinateur, puis lancer le logiciel 
NuVJ, Démarrer -> Arkaos NuVJ -> Arkaos NuVJ. 
Remarque :  Si le contrôleur est branché après que le logiciel NuVJ soit lancé, il peut ne pas 
fonctionner.  Vous devrez relancer le logiciel.  Assurez-vous de toujours brancher le contrôleur 
avant de lancer l’application. 

6. Entrez le numéro de série de 16 caractères fourni avec le NuVJ. 
7. Une fois que le numéro de série est correctement entré, vous pouvez enregistrer votre copie du 

NuVJ.  Vous devez être branché à l’Internet pour enregistrer le NuVJ.  L’enregistrement vous 
permettra d’accéder à du contenu supplémentaire en ligne et à des mises à jour du logiciel. 

 
 

 

INSTALLATION DU LOGICIEL SUR MAC 
 

 
 

1. Pour installer le logiciel NuVJ, insérez le CD d’installation NuVJ dans le lecteur de votre ordinateur. 
2. Cliquez sur le fichier d’installation NuVJ, situé sur CD. 
3. Suivez ensuite les instructions à l’écran. 
4. Une fois l’installation terminée, un raccourci s’affiche sur le bureau.  L’application apparaît 

également dans Applications -> NuVJ. 
5. Assurez-vous que le contrôleur est branché au port USB de votre ordinateur, puis lancez le logiciel 

NuVJ. 
Remarque :  Si le contrôleur est branché après que le logiciel NuVJ soit lancé, il peut ne pas 
fonctionner.  Vous devrez relancer le logiciel.  Assurez-vous de toujours brancher le contrôleur 
avant de lancer l’application. 

6. Entrez le numéro de série de 16 caractères fourni avec le NuVJ. 
7. Une fois que le numéro de série est correctement entré, vous pouvez enregistrer votre copie du 

NuVJ.  Vous devez être branché à l’Internet pour enregistrer le NuVJ.  L’enregistrement vous 
permettra d’accéder à du contenu supplémentaire en ligne et à des mises à jour du logiciel. 
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INTRODUCTION DU LOGICIEL 
 

 
Dans cette section, nous vous offrons une vue d’ensemble du logiciel et de son fonctionnement de base.  Nous 
vous recommandons fortement de lire cette section – elle vous permet de voir une vue d’ensemble des 
fonctions du NuVJ, en plus des concepts de base du mixage vidéo. 
 

Éléments de base 
 

 
NuVJ vous permet de mixer des vidéos et des images en temps réel et de façon très intuitive. Il est 
conçu comme une station de travail pour DJ avec deux lecteurs que vous pouvez mixer la sortie 
des lecteurs à l'aide d'un potentiomètre. 

 
               

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
Cette configuration est la même pour l’interface logicielle et le contrôleur : le lecteur A est 
représenté dans la section gauche du panneau principal, alors que le lecteur B est à droite, le 
mixeur et les commandes d’effet général sont au milieu. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Sur les sections lecteur, il y a une série de carrés.  Ces carrés sont appelés des cellules et sont des 
emplacements pour assigner des vidéo-clips, images ou des fichiers flash (clips).  Chaque lecteur 
peut faire la lecture d'une cellule à la fois. 

 
Pour assigner un clip à une cellule, faites tout simplement glisser une image ou vidéo du navigateur 
de fichier situé à l’extrême gauche de l’interface ou directement de la fenêtre de l’explorateur. Une 
fois assigné, vous pouvez cliquer la cellule pour le lancer ou encore, appuyer sur le pad 
correspondant sur le contrôleur NuVJ.  En lançant une cellule sur chaque lecteur, vous pouvez les 
prévisionner dans leur fenêtre respective et voir le résultat du mixage dans la fenêtre centrale.  
Déplacez le potentiomètre de mixage à l’aide de la souris ou du crossfader sur le contrôleur pour 
visionner le mixage sur l'écran.   

 Film A Film B

Mixage 
Vidéo 

Sortie
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L’image finale 
Lors d’une performance, vous devez habituellement projeter l’image finale 
en pleine résolution.  Pour le faire, vous devrez activer le mode plein écran 
à partir de l’interface du logiciel.  Vous pouvez cliquer sur Display > 
Toggle Fullscreen ou en appuyant sur CTRL+A (Commande+A sur Mac) 
sur le clavier.  Pour sortir du mode plein écran, appuyez de nouveau sur 
CTRL+A. Comme nous le verrons plus loin dans ce guide (voir 
Préférences/Affichage), si votre carte vidéo permet plusieurs sorties vidéos, 
vous pouvez afficher l’interface sur votre moniteur principal alors que la 
sortie plein écran est acheminée à la sortie de votre moniteur secondaire 
auquel vous pouvez brancher un appareil de projection. 
 

 
 

Vue d’ensemble 
 

 
Comme nous venons tout juste de le voir, NuVJ fonctionne simplement avec deux lecteurs A/B et 
une fonction de mixage.  Dans ce chapitre, nous verrons ses fonctions plus en détail.  
 

Lecteurs :  

Comme nous le mentionnions, les lecteurs sont les 
sources de données vidéo. Ils contiennent des cellules qui 
sont des emplacements pour les clips. Lorsque vous 
lancez une cellule d’un lecteur, vous pouvez visionner le 
film/l’image dans la fenêtre de visionnement  située sur la 
partie supérieure du lecteur.  Chaque lecteur peut faire la 
lecture d'une cellule à la fois. La cellule en cours de 
lecture est surlignée en rouge sur l'interface du logiciel et 
un témoin DEL est également allumé sur le contrôleur. 

Cellules :  
 
Les cellules sont des emplacements auxquels vous 
assignez des clips que vous désirez utiliser dans votre 
mix.  En plus de contenir un clip, les cellules peuvent être 
assignées un effet qui est automatiquement appliqué au 
clip chargé à cette cellule.  Pour assigner un effet à une 
cellule, faites glisser un effet de la liste du navigateur des 
effets situé à gauche sur la cellule désirée.  Si une cellule 
avec un effet est activée, deux boutons au dessus de la 
section des cellules deviennent actifs et vous permettent 
de modifier les paramètres des effets.  Les paramètres 
des effets peuvent être modifiés à l’aide de la souris sur 
l’interface ou avec les deux boutons des effets des 
paramètres (PMTR1 et PMTR2) de chaque lecteur.  Par 
exemple, sur la figure de droite, un flou directionnel a été 
assigné sur la cellule supérieure gauche, et les deux 
paramètres, LEVEL et DIRECTION, sont maintenant 
disponibles pour effectuer des modifications.  Lorsqu’une 
cellule est sélectionnée avec la souris (bouton droit) ou jouée (bouton gauche), un panneau avec des 
paramètres évolués pour cellule est actualisé dans la partie inférieure de l’écran.  Il permet de modifier les 
paramètres de lecture et de mixage, aussi bien que les paramètres par défaut de l’effet lorsque la cellule est 
activée. Pour les « fichiers texte » spéciaux, le texte à afficher peut également être modifié.  Les paramètres 
des cellules seront explorés plus en détail plus loin dans ce guide. 

 

Fichiers :  
 
Les fichiers sont le matériel source contenu dans les cellules.  
Vous pouvez faire glisser les fichiers directement de la fenêtre 
navigateur de fichier ou du navigateur de fichier intégré du 
NuVJ situé à gauche de l’interface.  NuVJ supporte plusieurs 
formats de fichiers vidéo, image et flash. Voir la section Conseils 
pour performances à la fin du guide pour connaître les différents 
formats et leurs utilités.  En plus de pouvoir faire la lecture de 
fichiers individuels, vous pouvez également faire glisser un dossier dans une cellule, le NuVJ jouera tous les 
vidéo-clips et images contenus dans ce dossier, un après l'autre comme un diaporama.  
 

Remarque :  Pour des raisons de gestion de mémoire, les fichiers qui sont lus à partir d’un 
dossier ne sont pas mis dans l’antémémoire et il est également moins efficace de faire la 
lecture d’un visuel un après l’autre à partir d’un dossier que lorsqu'activé directement. 

                                 LECTEUR 

 

 

 

 

 

 

 

 

CELLULE 
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Effets :  
 
Les effets sont utilisés pour modifier les clips de façons 
différentes. NuVJ offre une grande collection d’effets triés dans 
plusieurs catégories. Ils sont listés sous le deuxième onglet 
(Effects) de la section navigateur à l'extrême gauche de 
l'interface. Les effets peuvent être ajoutés à la cellule pour 
modifier des clips individuels ou la sortie principale du mixage. 
Selon la capacité de votre matériel vidéo, il se peut que certains 
effets ne soient pas disponibles, comme certains effets 
nécessitent du matériel plus performant pour fonctionner. 
 
 
Sources :  
 
Les sources sont comme des clips sauf qu’elles ne sont pas 
associées à des fichiers sur votre disque dur.  Les sources sont 
listées sous le troisième onglet (Sources) de la section 
navigateur à l'extrême gauche de l'interface.  Les sources sont 
divisées en trois catégories principales : entrées en direct, 
générateurs et textes.  Les entrées en direct recueillent toutes 
les entrées caméra sur le système.  Avec celle-ci, vous pouvez 
alimenter le NuVJ directement avec des webcaméras USB ou 
Firewire, caméras numériques, cartes d’acquisition et autres 
appareils vidéo. La catégorie Inputs indique toutes les entrées en direct reconnues par le système. La 
catégorie Generators est fait d’éléments qui génèrent automatiquement des modèles à l’aide du traitement 
d’effets internes et du signal provenant d'entrée audio, un peu comme le fait les modules de visualisation de 
iTunes ou du Windows Media Player.  Pour assigner une source à une cellule, vous n’avez qu’à la glisser-
déposer sur la cellule désirée. La troisième catégorie, Texts contient des fichiers spéciaux qui peuvent être 
utilisé pour afficher un texte de présentation, pour annoncer, etc. 

 
UTILISATION D’ENTRÉE AUDIO   

 

Le NuVJ vous permet de synchroniser vos vidéo-clips et vos prestations avec un signal provenant 
d’une entrée audio.  Pour utiliser cette fonction, veuillez brancher une source audio à l’entrée niveau 
ligne de la carte de son de votre ordinateur.  Vous devez vous assurer que l’entrée niveau ligne est 
sélectionnée en tant que source d’entrée.   

PC : Veuillez cliquer sur Mon ordinateur -> Panneau de configuration -> Sons et périphériques audio, 
sur l’onglet Audio, puis sur le bouton Avancé, ceci devrait faire apparaître le panneau du Contrôle du 
volume.  Cliquez sur Options -> Propriétés -> Enregistrement  afin de voir les sources d’entrées 
d’enregistrement.  Veuillez vous assurer que l’entrée ligne est cochée et que le potentiomètre du 
volume est réglé correctement. 

Afin de pouvoir entendre l’audio par le biais de la carte de son de votre ordinateur, vous devrez 
retournez au menu Options -> Propriétés -> Lecture et vous assurer que l’entrée niveau ligne n’est 
pas mis en sourdine et que le potentiomètre du volume est réglé correctement.  

Sur certaines cartes de son, vous pouvez sélectionner la sortie de la carte comme appareil 
d’enregistrement. Habituellement, vous pouvez la trouver dans les sources d’enregistrement comme 
« Stéréo Mix ».  Si votre carte est dotée d’un tel canal, le sélectionner vous permettra de 
synchroniser directement le NuVJ à l’audio qui joue sur le même PC. 

MAC : Veuillez cliquer sur Finder -> Applications -> Préférences système et cliquez sur l’icône du son.  
Sélectionner Entrée pour voir les sources d’entrée disponibles.  Sélectionnez l’appareil que vous 
voudriez utiliser comme source d'entrée, une fois l'appareil sélectionné, le NuVJ synchronise sa 
session au BPM de cet appareil. 

 
La bibliothèque visuelle :  
 
La bibliothèque visuelle est une façon simple de trouver les clips 
qui sont déjà chargés dans l’application. Une fois qu’un clip est 
chargé dans NuVJ, il devient disponible dans la bibliothèque 
visuelle et peut être accédé en tout temps, durant la session.  La 
bibliothèque se trouve sur le quatrième onglet (Visuals) de la 
section navigateur. Vous pouvez glisser-déposer directement les 
clips de la bibliothèque sur les cellules sans avoir à les chercher 
à nouveau sur votre disque dur. 
 
Banques :  
 
Les banques sont une collection de neuf cellules.  Il y a 
toujours une banque de sélectionnée pour chaque lecteur.  
Le numéro de la banque sélectionnée est affiché dans la 
section bleutée sous la fenêtre de visionnement  du 
lecteur.  Vous pouvez modifier la banque en tout temps 
en appuyant sur les flèches de défilement, ou en tournant le bouton BANK du contrôleur.  Grâce aux 
banques, vous pouvez organiser vos clips par thèmes, ambiance ou type de séquence. 
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Commandes de lecture :  
 
À côté de l'affichage de la sélection de banque, il y a quelques commandes qui peuvent être utilisées pour 
modifier la lecture des cellules sur ce lecteur :  

 
L’indicateur supérieur est la position de lecture pour le clip en cours. 
 
L’indicateur inférieur commande la vitesse de lecture du clip en cours.  Le centre représente une 
vitesse de zéro, il y a alors arrêt sur image du clip.  Si l’indicateur est situé du côté droit, le film 
avance, alors que si l’indicateur est du côté gauche, le film recule.  Plus vous vous éloignez du centre, 
plus la vitesse de lecture augmente.  Pour modifier la vitesse de lecture à l'aide de l’interface, cliquez 
simplement sur la commande pour déplacer l’indicateur de vitesse.  Vous pouvez également modifier 
la vitesse de lecture à l'aide des potentiomètres SPEED sur le contrôleur. Une barre verticale sur 
l’indicateur de vitesse indique lorsque le film a atteint sa vitesse nominale. Lorsque la vitesse est 
réglée près de la vitesse nominale, l’indicateur devient rouge. 
 
 
 
 
 
 
 
 
La touche [LATCH] permet de régler la lecture des cellules.  Si elle est activée, la cellule continue de 
jouer après que vous ayez relâché la souris ou la surface de commande.  Si elle est désactivée, la 
cellule arrête de jouer aussitôt que vous relâchez la souris/le contrôleur.  Vous pouvez également 
activer/désactiver ce mode à l’aide de la touche LATCH de la surface de commande. 
 
La touche [SYNC] permet d’activer un mode de lecture synchronisée des clips.  Lorsqu’activé, le NUVJ 
s’adapte à la vitesse de lecture afin d’être synchronisé avec le BPM détecté de l’entrée audio.  Vous 
pouvez activer le mode sync à partir du contrôleur à l’aide de la touche [SYNC]. Lorsque le mode sync 
est activé, la vitesse de lecture des films peut tout de même être modifiée à l’aide des potentiomètres 
SPEED. 
 
La touche [AUTO] permet d’activer le mode de lecture automatique.  En mode automatique, le NuVJ 
lance de façon aléatoire la lecture des cellules de la banque sélectionnée en suivant le BPM de l'entrée 
audio.  Ce mode peut être utile si vous désirez faire une pause durant votre prestation ou encore, 
vous désirez mixer des clips de façon automatique. 

 
 
Le crossfader :  
 
Le crossfader est en position centrale. À l’aide de la souris ou 
du potentiomètre sur le contrôleur, vous pouvez utiliser le 
crossfader pour mixer vos films.  Si le crossfader est déplacé 
à l’extrémité gauche, seule l’image sur le lecteur A sera 
visible, alors que s’il est déplacé à l'extrémité droite, seule 
l'image sur le lecteur B sera visible.  Dans la position centrale, les deux images seront mixées en fonction de 
la courbe de transition configurée.  Pour sélectionner une courbe de transition, cliquez sur le crossfader et 
sélectionnez une des transitions disponibles.  Le contrôleur est doté également d’un commutateur FADER 
MODE sur le panneau avant qui permet de sélectionner entre 3 courbes de transition prédéfinies.  Pour plus 
d’information concernant la définition des transitions utilisées par le contrôleur, consultez la section 
« Préférences ». 
 
L’effet général :  
 
L’effet général est un effet supplémentaire qui peut être ajouté au 
résultat du mixage.  L’effet général peut être sélectionné à partir 
de l’interface du logiciel ou du bouton MASTER FX du contrôleur.  
Chaque effet permet de régler jusqu’à deux paramètres à l’aide des 
boutons PMTR1 et PMTR2 du contrôleur. Le bouton FX LEVEL 
(Master FX Mix) permet de régler quel pourcentage de l’image 
traitée qui sera acheminée à la sortie finale.  Vous pouvez 
également contourner l’effet général en appuyant sur la touche 
MASTER FX du contrôleur. 

 
 
Contrôle de la luminosité/du contraste :  
 
Il est possible de régler la luminosité et le contraste de 
l’image avant qu'elle ne soit acheminée à la sortie. Ceci vous 
permet de régler l’image en tenant compte de l’éclairage de 
la pièce ou de compenser pour la perte/gain de luminosité en 
raison du traitement et du mixage de l’image. Les réglages 
du contraste et de la luminosité peuvent être configurés à partir de l’interface ou directement du contrôleur 
à l’aide des boutons CONTRAST et BRIGHT.  Si vous ne voulez pas utiliser cette fonction, vous pouvez la 
contourner dans le « Preference dialogue », cela permettra d’économiser des ressources allouées et 
d’améliorer légèrement la performance du logiciel. 

 
 

Veuillez noter que l’efficacité de la lecture à une vitesse non nominale 
dépend du type de film et de la compression utilisée pour les clips.  
Vous trouverez plus d’information concernant ses fonctions dans la 
section Conseils pour une meilleure performance de ce guide. 
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Fonctions évoluées 
 

 
Arrière-plan :  
 
NuVJ vous offre la possibilité d’ajouter une image en arrière-plan qui s’affiche lorsqu’il n’y a pas de clip en 
cours de lecture sur aucun des lecteurs ou si la touche [INSTA BLACK] du contrôleur est enfoncée. Le clip 
d’arrière-plan peut être défini dans la fenêtre « Preferences », que vous pouvez accéder à partir du menu 
File, et peut être modifié en glissant un clip sur la fenêtre de prévisionnment principale. Vous pouvez 
également activer les modes copie et mélange (voir ci-dessous) entre le lecteur A et l’arrière-plan dans le 
menu Preferences.  Cette option n’est pas activée par défaut pour éviter toute confusion. 
 
Paramètres des cellules et du mixage évolué :  
 
Lorsqu’une cellule est activée à l’aide de la souris ou d'un des pads, le panneau de configuration des cellules 
dans le bas de l’interface est mise à jour afin d’indiquer les paramètres de la cellule sélectionnée. Pour 
éditer les paramètres d’une cellule sans l’activer, cliquez sur la cellule à l’aide du bouton droit de la souris. 
Le panneau des paramètres contient des options évoluées qui permettent d'améliorer vos prestations.  Afin 
d'illustrer ces options, nous utiliserons les deux images suivantes : 

 
 
Lecteur A : 

 
 

 
Lecteur B : 

 

 
Modes Copy :  
 
Les modes Copy expriment comment les cellules des lecteurs A et B sont mélangées ensemble durant le 
mixage.  À moins que vous n’ayez coché une option spéciale (Preference/Advanced), ces paramètres seront 
actifs uniquement lorsqu’une cellule jouera sur le lecteur B.  C’est parce que le lecteur B est considéré 
comme étant « situé sur » le lecteur A et que les modes Copy définissent la façon dont B est intégré à A. 

 
Le mode Copy défini l’opération mathématique utilisée 
pour combiner les couleurs des pixels du lecteur B à 
celles du lecteur A. Nous allons passer en revue les 
différents modes en ordre, de gauche à droite. 
 

 
Le mode par défaut est le mode Copy. Ce mode permet de mixer une des cellules du lecteur B 
avec une cellule du lecteur A, c.-à-d, que la sortie sera une moyenne des pixels de chacune des 
images.  

 
Le mode Addition permet d’additionner les pixels de l’image B aux pixels de l’image A.  En mode 
addition (également disponible, soustraction, multiplication, maximum et minimum), l’effet est 
optimal lorsque le potentiomètre de mixage est à l’extrémité droite.  

 
 

En mode soustraction, les couleurs des pixels du lecteur B sont soustraites du lecteur A, 
résultant en un mélange inversé de l’image B dans l’image A.  

 
 

         En mode multiplication, les couleurs des pixels du lecteur B sont multipliées avec celles du 
lecteur A.  

 
 

Le mode maximum permet de sélectionner les pixels d'un des deux lecteurs, selon celui des deux 
qui a le plus de luminance. 

 
 

Le mode minimum permet de sélectionner les pixels d'un des deux lecteurs, selon celui des deux 
qui a le moins de luminance.  
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Options de masquage :   
 
Les options de masquage permettent de supprimer (masquer) une partie du contenu du clip, à l'aide des 
couleurs ou de la luminosité. Ce processus est également connu comme procédé de transparence 
électronique. En ce qui concerne les modes Copy, les réglages du 
masquage sont ajoutés aux cellules du lecteur B, comme le 
lecteur B est sur le lecteur A. Lorsque le procédé de luminance ou 
de chrominance est activé, deux boutons sous la sélection 
deviennent actifs. Ces boutons permettent de définir les 
caractéristiques (Center et Width) du filtre appliqué sur la 
luminosité ou la teinte de l’image. Toute luminosité ou couleur 
dans cette section deviendra transparente et l’image A deviendra visible. 

 
Le mode par défaut et celui à extrême gauche désactivent ce procédé de transparence. Dans ce cas, les 
boutons Centre et Width sont également désactivés. 

 
Le procédé de transparence permet différents niveaux de luminosité transparente. Par 
exemple, si vous réglez le paramètre Center au maximum, toutes les valeurs de luminosité 
(blanche) deviendront transparentes et l’image du lecteur A sera affichée en dessous. Le 
Center définit la portée en niveaux de gris à supprimer. 

 
 

La chrominance permet de rendre une tranche de couleur transparente. La position du bouton 
Center définit quelle couleur sera supprimée et le bouton Width définit la largeur de la tranche 
de couleur de la valeur du centre sera supprimée.   

 
Options de lecture :  
 
Les options de lecture affectent la lecture du clip. Il y a trois modes : One Shot, Loop et Ping-Pong. 

 
En mode One Shot, le film, une fois activé, joue une fois et s'arrêt 
lorsqu’il atteint la fin. 

  
En mode Loop, le clip joue en boucle. C’est le mode par défaut. 

 
En mode Ping-Pong, le clip joue en boucle en alternant la lecture avant et la lecture arrière.  

 
Options de l’effet :  
 
Les options d’effet sur le côté droit permettent de configurer les 
valeurs par défaut pour les paramètres d’effet. Ces valeurs sont 
appelées automatiquement chaque fois que la cellule est activée. 
Elles peuvent être modifiées à l’aide des paramètres d’effet du 
lecteur (voir section lecteur) mais les valeurs par défaut réglées de 
cette façon sont appelées chaque fois que la cellule est activée. Pour 
« copier » les réglages en cours aux paramètres par défaut pour cette cellule (afin qu’ils soient sauvegardés 
la prochaine fois qu’elle est activée), appuyez sur le bouton BANK du lecteur correspondant sur le 
contrôleur.   
 
Réglages du texte : 
 
Lorsque vous utilisez des textes provenant du navigateur Sources, vous pouvez changer le texte affiché en 
le modifiant dans l’entrée texte située dans le panneau des paramètres de la cellule. 

 

Importation/exportation des banques :  
 
En plus de pouvoir charger et sauvegarder tout le contenu de votre prestation en cliquant sur le menu File, 
vous pouvez également importer et exporter des banques individuelles en cliquant sur la cellule, tout en 
maintenant le bouton enfoncé, pour sélectionner une entrée du menu contextuel (pour plus d’information, 
voir la description de l’interface). Cette fonction facilite le chargement de visuels prédéfinis durant vos 
prestations. Elle vous permet de sauvegarder un nombre illimité de préréglages de clips et d’effets afin de 
pouvoir les appeler sans avoir à arrêter votre prestation. 

 
Double monitorage  :  
 
Pour faire une prestation VJ en bonne et due forme, il est plus pratique d’utiliser des cartes vidéo qui 
supportent deux moniteurs.  De cette façon, vous pouvez projeter le signal vidéo du mixage à votre second 
moniteur (raccordé à un système de projection, par exemple) et avoir accès à l’interface du contrôleur sur le 
moniteur principal. Afin d’utiliser le double monitorage à partir du NuVJ, vous devez d’abord vous assurer 
que votre système peut acheminer à deux sorties indépendantes (sans l’utilisation du clonage où les deux 
sorties transmettent la même image). Une fois votre système configuré, lancez NuVJ et ouvrez la fenêtre 
Preferences en cliquant sur File > Preferences.  Dans le menu Display, sélectionnez le moniteur que désirez 
utiliser pour la sortie plein écran. Ensuite, vous pouvez entrer en mode plein écran en cliquant sur Display > 
Toggle Fullscreen ou en appuyant sur CTRL+A (command+A sur Mac).  Vous pouvez également sortir du 
mode plein écran en cliquant sur CTRL+A (command+A sur Mac). 
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UTILISATION DU LOGICIEL 
 

 
Cette section permet de voir les différents éléments de l’interface en plus du fonctionnement du logiciel : 
 
L’interface est divisée en 4 sections : la section menu/navigateur de fichiers (coin supérieur gauche), la section 
de mixage (coin supérieur droit), la fenêtre d’information (coin inférieur gauche)  et le panneau de 
configuration des cellules (coin inférieur droit).            
         

 
 

Menus 
 

 
Les menus sont organisés de la façon suivante : 

 
File ------------------------------------ 

New : Permet de supprimer toutes les données et de recommencer la prestation. 
Open : Permet d’ouvrir un fichier de prestation (.nvj). 

     Save : Permet de sauvegarder la prestation en cours. 
     Save As... : Permet de sauvegarder la prestation en cours dans un nouveau fichier. 

   Preferences : Permet d’appeler la fenêtre des préférences 
Quit : Permet de fermer l’application. Fonctionne uniquement lorsque le mode plein écran est 
désactivé, afin d'éviter de fermer l’application par mégarde au milieu d’une prestation. 

 
Edit ------------------------------------ 

Cut Cell : Permet de supprimer la cellule en cours d’édition et de copier son contenu sur le 
presse-papiers.  
Copy Cell : Permet de copier la cellule en cours d’édition sur le presse-papiers.  

       Paste Cell : Permet de copier le contenu du presse-papiers sur la cellule en cours d’édition.  
    Clear Background : Permet de supprimer le clip assigné à l’arrière-plan. 

   Purge Visuals : Permet de supprimer les clips inutilisés de la mémoire. 
  

Display ------------------------------------ 
      Toggle Fullscreen : Permet d’activer/désactiver le mode plein écran. 
 

Help ------------------------------------ 
    Getting Started : Permet d’ouvrir le Guide d'utilisation simplifié du NuVJ en format PDF. 
    Reference Manual : Permet d’ouvrir le Guide de référence du NuVJ en format PDF. 

Release Notes : Permet d d’ouvrir le fichier PDF contenant de l’information sur la version du 
logiciel et des détails supplémentaires concernant la mise à jour.      

    NuVJ Web Site : Permet d’ouvrir votre navigateur Internet sur la page Web du NuVJ. 
    Register : Permet d’enregistrer le NuVJ en ligne. 
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La section Navigation 
 

 
La section de navigation permet de visualiser et de sélectionner le contenu et les effets dont vous 
avez besoin pour vos prestations. Cette section contient quatre onglets : Files (fichiers), Effects 
(effets), Sources et Library (bibliothèque).  Pour utiliser un de ces éléments, glissez-déposer en un 
à partir du navigateur jusqu'à la cellule. Vous pouvez également glisser-déposer un élément sur 
une des fenêtres de previsionnement. Si vous en glissez une sur une des fenêtres de 
prévisonnement d’un des lecteurs, l’élément remplacera le visuel ou l’effet en cours de lecture.  Si 
vous glissez un élément à la fenêtre de visionnement principale, il devient le nouveau clip d’arrière-
plan ou d’effet général. 
 
Sous la section de navigation, il y a un filtre pour fichiers qui vous permet de sélectionner les 
fichiers qui visibles à partir du navigateur de fichiers. Par défaut, tous les fichiers compatibles 
(fichiers vidéo, images et flash) sont visibles, mais vous pouvez modifier le réglage pour que seuls 
les images, les films ou les fichiers flash, ou encore, tous les fichiers de votre disque dur soient 
visibles. 
 
Il y a également une poubelle sous le filtre. Cette icône peut être utilisée pour supprimer les visuels 
et les effets des cellules en glissant-déposant l’icône de la cellule ou de l’effet sur l’icône de la 
poubelle. 
 

La section de mixage 
 

 
La section de mixage contient toute l’information concernant la visualisation du contenu du lecteur, 
en plus du potentiomètre de mixage et de l’effet général. La colonne de gauche concerne le lecteur 
A, la colonne droite, le lecteur B, et celle au centre, la section du mixage et de l’effet général. 
 
Section des lecteurs (A et B) : 

 
Chaque lecteur contient les éléments suivants, de haut en bas : 

  
Fenêtre de visionnement  : Affiche la sortie de la cellule du lecteur. Vous pouvez glisser 
un des éléments du navigateur directement la fenêtre de visionnement d’un des 
lecteurs; l’élément remplacera le visuel ou l’effet de la cellule en cours de lecture. 

 
Commandes de lecture : Contient des éléments qui vous permettent de faire la 
sélection d’une banque, de la vitesse de lecture du lecteur, d’activer/désactiver les 
modes Latch, Auto et Sync. Vous trouverez plus d‘information concernant « Les 
commandes de lecture » dans la section « Introduction du logiciel » de ce guide. 

 
Paramètres des effets du lecteur : Vous permet de modifier les paramètres des effets 
de la cellule en cours de lecture. Veuillez noter que ces modifications ne sont que 
temporaires : aussitôt que vous aurez activé une autre cellule, les valeurs des 
paramètres d’effet par défaut sont restaurées sur le panneau de configuration de la 
cellule. Si vous désirez copier les paramètres d’effet en cours aux paramètres par 
défaut de la cellule afin de les réutiliser la prochaine fois, appuyez sur la touche [BANK] 
du lecteur. 

 
Cellules : Dans la partie inférieure du lecteur, vous pouvez voir les neuf cellules du 
lecteur sélectionné. Vous pouvez glisser-déposer n’importe quel fichier, effet ou source 
contenu dans le navigateur sur une cellule pour la modifier. La cellule affichera une 
image du clip qui lui est assigné en plus des icônes informatives suivantes : 

 
Une cellule en niveaux de gris, entourée de rouge indique que la 
cellule est en cours de lecture. Une icône de crayon dans le coin 
supérieur gauche indique que la cellule est sélectionnée pour 
l’édition et que ses paramètres sont visibles sur le panneau de 
configuration. Cela indique également qu’elle est sélectionnée 
pour la fonction copier/coller. Pour sélectionner une cellule, 
cliquez sur la cellule, soit avec le bouton gauche de la souris 
(dans ce cas, la cellule sera activée et sélectionnée pour l’édition) 
ou soit avec le bouton droit de la souris (dans ce cas, la cellule sera sélectionnée, mais 
pas activée). 

 
L’icône dans le coin inférieur droit indique qu’un effet a été ajouté à la cellule. Celle sur 
sa gauche, indique que les modes Copy et Masking ont été cochés dans les paramètres 
de la cellule.  

 
Vous pouvez glisser-déposer des visuels et des effets entre les cellules. Cliquez 
simplement dans la section image d’une cellule et glissez-déposez sur une autre cellule. 
Pour déplacer un effet d’une cellule à une autre, glissez-déposez l’icône effet d’une 
cellule sur une cellule. 
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Si vous cliquez une cellule avec le bouton de droite de la 
souris quelques instants, une fenêtre contextuelle apparaît 
avec les options suivantes : 

  
Clear Visual : Permet de supprimer le visuel de la cellule. 
Clear Effect : Permet de supprimer l’effet de la cellule. 
Reset Cell : Permet de supprimer tous les réglages, les 
visuels et les effets de la cellule. 
Import Bank : Permet d’importer une banque complète d’un fichier .nvjb, remplaçant la 
banque à laquelle la cellule était assignée. 
Export Bank : Permet d’exporter la banque complète à laquelle la cellule était assignée 
sur fichier .nvjb. 
Clear Bank : Permet de supprimer tout le contenu de la banque. Les clips sont tout de 
même gardés en mémoire pour référence et accessibles dans l’ongle Library. Pour 
libérer l’espace des clips que ne sont pas dans les banques, utilisez la fonction « Purge 
Visuals » à partir du menu Edit. 

 
 
Section mixage et effet général : 

 
La section centrale contient tous les éléments concernant le signal de sortie et le processus de 
mixage. Il contient les éléments suivants, de haut en bas : 

 
Visionnement du signal de sortie : Cette fonction permet de faire une duplication du signal de 
sortie à un second moniteur lorsque le mode plein écran est activé. Vous pouvez glisser-déposer 
tout élément du navigateur sur la fenêtre de visionnement. Si vous glissez-déposez un clip, une 
source vidéo ou un générateur, cet élément remplacera l’arrière-plan sélectionné (voir arrière-plan 
dans la section Concept). Si vous glissez-déposez un effet, cet effet deviendra le nouvel effet 
général. 

 
Luminosité et contraste : Ces deux commandes vous permettent de régler la luminosité et le 
contraste de l’image en tenant compte de l’éclairage de la pièce ou de compenser pour la 
perte/gain de luminosité en raison du traitement et du mixage de l’image. 

 
Section de l’effet général : La section de l’effet général vous permet d’ajouter un effet 
supplémentaire sur le signal de sortie du mixage. L’effet peut être sélectionné à l’aide de la section 
combinée et des trois boutons ci-dessous, lui permettant de se modifier lui-même. Le premier 
détermine le pourcentage de traitement ajouté au signal original et au signal traité, alors que les 
deux autres permettent la modification des paramètres spécifiques de l’effet sélectionné. 

 
Crossfader : Permet de commander le niveau de 
mixage entre le lecteur A et le lecteur B. L'extrémité 
gauche, seul le signal provenant du lecteur A est 
visible, à l’extrémité droite, seul le signal provenant 
du lecteur B est visible. L'image est mixée en 
fonction de la transition utilisée. Vous pouvez 
sélectionner les transitions en cliquant le crossfader 
à l’aide du bouton droit de la souris ou en utilisant le 
commutateur sur le contrôleur. Remarquez que le 
numéro de transitions disponibles dépend des 
capacités matérielles de votre ordinateur. 
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La section information 
 

 
La section information située dans le coin inférieur gauche de l’écran affiche de l’information 
dynamique sur l'élément sur lequel pointe la souris. Si vous désirez de l’information concernant un 
élément, déplacez la souris sur cet élément et l'information s'affichera. 
 

Panneau de configuration des paramètres de la cellule 
 

 
Le panneau de configuration de la cellule permet de modifier les paramètres de la cellule 
sélectionnée. Seulement une cellule peut être modifiée à la fois et elle peut être identifiée 
par l’icône de droite au-dessus de l’image du visuel :   

 
Tel que nous l’avons vu dans la section « Concept », le panneau permet de modifier les 
caractéristiques de lecture et de mixage de chaque cellule. Il est également utilisé pour configurer 
les valeurs des paramètres d’effet par défaut qui sont restaurées sur le panneau de configuration 
de la cellule dès que celle-ci est réactivée. 
 

La fenêtre des préférences 
 

 
La fenêtre des préférences permet de configurer les différents paramètres qui affectent le 
fonctionnement du logiciel.  Ces configurations sont divisées en quatre catégories, chacune d’elle 
accessible à partir d’un onglet de la fenêtre : 
 
 General : 
 

Background Visual : 
Permet de spécifier le fichier 
à utiliser comme clip 
d’arrière-plan. Ce fichier 
sera affiché lorsqu’aucune 
cellule ne sera sélectionnée 
sur aucun des lecteurs ou 
lorsque la touche FADE TO 
BLACK du contrôleur est 
enfoncée. Vous pouvez 
entrer le chemin d’accès en 
entier du fichier ou utiliser le 
bouton Select pour ouvrir un 
navigateur de fichier. Ce 
fichier sera utilisé comme 
arrière-plan par défaut et 
est restauré lorsque vous 
relancez l’application, charger un fichier de prestation ou en utilisant le menu File>New.  
Vous pouvez contourner cette valeur, soit en sélectionnant le menu Edit>Clear 
Background, soit  en glissant-déposant un clip directement sur la fenêtre de 
visionnement principale.  
 
Automation Beat Count : Permet de sélectionner le nombre de battements que 
l’application attend avant d’activer un nouveau visuel. Voir la section concernant les 
concepts et les commandes de lecture. 
 
 
Slide Show Time : NuVJ vous permet également de cliquer-déposer des dossiers sur 
les cellules. Dans ce cas, le NuVJ jouera tous les films, images, et flashs contenus dans 
ce dossier (et de façon récurrente), un après l'autre comme un diaporama. Le paramètre 
Slide Show Time permet de régler combien de temps les images seront affichées (en 
secondes) avant de passer au visuel suivant du dossier. 
 
Transition 2 et Transition 3 : Le contrôleur est doté d’un réglage de commutateur que 
permet de sélectionner entre trois transitions à la volée. La première transition est 
toujours la transition par défaut (Exponential Transparency) mais les deux autres sont 
configurables. Il est possible de sélectionner les deux transitions qui seront assignées 
aux positions 2 et 3 du commutateur parmi ces deux listes de transitions. 
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Display :  
 

L’onglet Display permet de définir les options en rapport avec le mode plein écran de 
l’application. 

  
Full Screen Monitor : 
L’onglet Display permet de 
définir les options en rapport 
avec le mode plein écran de 
l’application. En 
sélectionnant une sortie 
autre que votre moniteur 
principal, vous pourrez 
acheminer le signal mixé à 
un second moniteur, vous 
permettant de continuer 
d’utiliser l’interface afin 
d’apporter des 
modifications. 
  
Resolution : Spécifie la 
résolution utilisée par le 
logiciel pour traiter tous les graphiques. Plus la valeur est basse, plus rapides seront les 
calculs (donc, meilleure sera la vitesse de défilement), mais moindre sera la qualité 
d’image. Essayez différents réglages afin d’obtenir un bon équilibre entre la qualité 
d’image et la vitesse de défilement. Généralement, une résolution de 800 x 600 est 
adéquate pour les appareils de projection. 
 
Exclusive Mode : Oblige Windows à fonctionner en mode Exclusive (exclusif). En mode 
Exclusive, la performance est améliorée, mais il comporte un grand désavantage : une 
fois ce mode activé, vous ne pouvez utiliser que NuVJ. L’activation de tout autre logiciel 
forcera NuVJ à sortir du mode plein écran. Ce mode n’est donc pas recommandé si vous 
désirez utiliser d’autres applications en même temps que NuVJ.  

 
 

Performances :  
 

L’ongle Performance permet de faire des ajustements à certains éléments afin 
d’augmenter la vitesse de défilement. 

 
GPU Level : Le premier 
champ est la puissance de 
votre matériel graphique. Le 
niveau peut varier en 0 à 
5.Même l’application peut 
rouler sur n’importe lequel 
de ces niveaux, nous vous 
recommandons un GPU 
Level 2 minimum afin de 
réellement apprécier le 
NuVJ. Sous le niveau 2, 
certaines des fonctionnalités 
peuvent ne pas être 
disponibles, comme le 
matériel ne peut les 
supporter.  
 
Rendering Quality : Ce réglage est utilisé pour spécifier le niveau de qualité de 
plusieurs des aspects du processus de rendu. Il démontre les compromis entre la qualité 
d'image et la vitesse du rendu. S’il est réglé complètement à droite, toute la qualité est 
préservée. S’il est réglé complètement à gauche, la qualité de différents aspects 
(visionnement, processus interne, etc.) sera dégradée et la vitesse de défilement sera 
augmentée en raison d’un processus de traitement moins important. Essayez différents 
réglages, et rappelez-vous que la résolution sélectionnée dans l’onglet Display 
influencera automatiquement la performance de votre système. 

 
Disable Contrast/Brightness Control : Sur un matériel plus lent, vous pouvez 
désactiver les commandes de réglage du contraste et de luminosité afin d'améliorer le 
processus principal. 
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Advanced 
 

Auto purge after : 
Lorsqu’un film est importé 
dans NuVJ, il demeure en 
mémoire même s’il n’est 
plus assigné à une cellule. Il 
est important de libérer 
l’espace mémoire de 
l’ordinateur des films 
inutilisés pour améliorer la 
performance du système. Ce 
réglage vous permet de 
purger à intervalle régulier 
les films inutilisés. 
 
Auto purge when 
physical memory left 
reaches : Ce réglage vous 
permet de purger automatiquement les films inutilisés lorsque la mémoire de l’ordinateur 
devient pleine. Cette option est disponible uniquement sur PC.  
 
Use Mask and Copy Mode on Deck A : Normalement les modes Mask et Copy définis 
dans le panneau de configuration des cellules sont uniquement actifs lorsque la cellule 
est en cours de lecture sur le lecteur B. En activant cette option, vous activez les 
paramètres sur le lecteur A, ce qui signifie que la cellule en cours de lecture sur le 
lecteur A sera composée avec le clip d’arrière-plan avec les réglages pour le mode Copy 
et Mask avant d’être acheminée au mixage. En combinant cette option avec la possibilité 
de changer l'arrière-plan en glissant-déposant un visuel sur la fenêtre de visionnement 
principale cela vous permet plus de possibilités de mixage. 
 
Play sound in QuickTime movies : En sélectionnant cette option, les bandes audio des 
films QuickTime ne seront plus ignorées, permettant au NuVJ de faire du scratch sur le 
vidéo-clip et l’audio en même temps. 

 
 

Controller : 

 
La section contrôleur contient des options reliées à son fonctionnement. 

 
Status : Indique l'état du contrôleur (offline/connected) 
Firmware : Indique le niveau du micrologiciel du contrôleur (uniquement disponible si le 
contrôleur est branché) 
LCD Contrast : Ce 
paramètre vous permet de 
régler le contraste de 
l’affichage ACL du 
contrôleur. Une fois réglé, le 
paramètre est sauvegardé 
de façon permanente dans 
le contrôleur et sera chargé 
chaque fois que le 
contrôleur est utilisé. 
Scratch sensitivity : 
Permet de régler la 
sensibilité des molettes en 
mode scratch. 
Slide Sensitivity : Permet 
de régler la sensibilité des 
molettes lorsqu’elles sont utilisées sans que la touche Scratch soit enfoncée (modification 
de la vitesse de lecture). 

 



 

61 

 

CONSEILS POUR UNE MEILLEURE PERFORMANCE 
 

 
 
 
 
 
 
 
 
 
Plusieurs facteurs peuvent faire obstacle à une bonne performance vidéo.   
 
Les facteurs les plus importants sont : 

 
• Vitesse du processeur 
• Vitesse de lecture du disque 
• Rapidité d'accès à la mémoire vive 
• Matériel vidéo et vitesse du port vidéo 
• Compression des films 

 
Il n'y a pas de réponse simple à savoir quel est le meilleur réglage pour chaque ordinateur.  Dans NuVJ, 
pratiquement tout le traitement graphique est fait avec le matériel vidéo, alors plus il est performant, plus 
les résultats seront meilleurs. La vitesse du processeur est utilisée pour décompresser les images du disque 
et les acheminer à la carte vidéo. Plus rapides sont vos pilotes, plus les images seront chargées dans la 
mémoire, plus rapide est votre processeur, plus rapidement les images sont décompressées. Afin d’atteindre 
une meilleure vitesse de défilement,  vous pouvez : 
 
• Adapter la résolution au calcul interne, Voir (Preference/Display) 
• Utiliser le potentiomètre de performance pour trouver un équilibre entre la qualité et la performance 

pour votre équipement. 
• Utiliser des sources matérielles qui sont adaptées à votre équipement. Si vous utilisez disque lent ou 

du matériel de génération antérieure, utilisez des sources vidéo plus petites afin de minimiser le 
temps de chargement et de décompression. Comme tous les calculs sont faits à l'intérieur du matériel 
vidéo, le repliement d'effet peut être minimisé par le filtrage automatique appliqué aux images 
lorsque celles-ci sont réduites à leur résolution finale. 

 

Compression des films 
 

En plus de la taille des films, le schéma de compression a un gros impacte sur la fluidité de l’affichage et sur 
leur jouabilité. Plus le schéma de compression est complexe, plus le processeur doit travailler pour 
récupérer les trames spécifiques, diminuant la rapidité d’exécution. En plus de la méthode de compression, 
il y a également le problème des trames clés. La plupart des mécanismes de compression utilisent des 
méthodes différentielles, ce qui veut dire qu’il construisent une trame en stockant les différences entre une 
trame et la trame suivante. Afin de s'assurer que le processus ne s'éloigne pas trop du matériel original, ils 
stockent une trame originale de façon aléatoire, puis recommencent à coder l’information à partir de cette 
trame. Ces trames originales sont appelées trames clés. En utilisant des trames clés, NuVJ doit trouver les 
trames clés précédentes et traiter toutes les différences intermédiaires entre les trames, jusqu’à ce qu’il 
trouve celle désirée.  Comme vous pouvez vous l’imaginer, c’est un processus très lent et qui empêche 
l'accès rapide aux trames, très importantes à la lecture inversée ou au scratch. C’est pourquoi les schémas 
de compression comme le mpeg ou le DivX ne sont pas faits pour les prestations vidéo. 
 

 
 
 
 
 
 
 

Utilisation de la mémoire 
 

Les films nécessitent beaucoup de mémoire. Selon leur taille et leur longueur, ils peuvent utiliser très 
rapidement beaucoup d’espace mémoire. Lorsqu’un fichier est importé dans NuVJ, il est gardé en mémoire 
même s’il n’est pas assigné à une cellule. Ceci est pour que vous puissiez utiliser le navigateur de fichier 
pour chercher des fichiers qui ont déjà été chargés, sans être obligé de parcourir les répertoires et de les 
importer de nouveau. Lorsque la mémoire de l’ordinateur se remplit, sa performance diminuée, c’est 
pourquoi il faut toujours vérifier ce facteur. Pour supprimer les films inutilisés du logiciel, vous devez utiliser 
la fonction « purge ». Ceci peut être accompli de plusieurs façons :  

1.  En supprimant manuellement les films à l’aide du menu « Edit/Purge Visuals». 

2. En utilisant la fonction de suppression automatique dans la fenêtre Preference/Advanced. Cette fonction 
vous permet de sélectionner un moment spécifique ou un seuil, lorsqu’atteint, supprime automatiquement 
les films inutilisés de votre ordinateur. Pour plus d’information à propos de cette fonction, consultez la 
section Préférences de ce guide. 
 

Il est très important de noter que les schémas de compression populaires ne sont pas 
très efficaces pour le VJing. Les fichiers vidéo qui utilisent ces schémas de 
compression se comporteront « correctement » à une vitesse nominale (100 %), 
mais de viendront très lents si vous modifiez leur vitesse ou si vous faites du scratch 
avec. C’est remarque est valide pour les mpeg, divx and DV codecs, entre autres.  Si 

Selon notre expérience, le meilleur schéma de compression pour une 
performance vidéo optimale est d’utiliser le format QuickTime’s Photo 
JPEG avec un réglage de qualité à 80 %. Ceci permettra d’assurer une 
lecture fluide, un scratchage efficace et des fichiers de taille correcte. 
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INTRODUZIONE 
 

 
Benvenuti nel NuVJ! NuVJ è un ambiente VJ intuitivo che integra in maniera continua software e hardware per 
garantire prestazioni di qualità professionale, senza problemi. L’ambiente NuVJ è basato su un dispositivo dallo 
stile DJ che consente di mixare, scratchare e applicare effetti a videoclip e immagini. Abbiamo progettato il 
software e il controller NuVJ in modo che siano facili da usare e che offrano al tempo stesso una variabilità e 
una possibilità di liberare la creatività a livelli senza precedenti, servendovi delle vostre fonti visuali. Dotato di 
un esteso insieme di funzioni quali ingressi live, sincronizzazione musicale e creazione di effetti visuali in tempo 
reale, ci auguriamo che proverete altrettanto piacere nel servirvi di questo prodotto quanto noi nel crearlo per 
voi! 
 
Cordialmente, 
 
La squadra Numark ed Arkaos 
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PANORAMICA DEL CONTROLLER  
 

 
Il controller NuVJ rappresenta un facile e veloce modo di interfacciarsi con le funzioni e le caratteristiche più 
importanti del software NuVJ. Il controller è stato progettato specificamente per comandare il software NuVJ, 
ma può anche essere utilizzato come controller MIDI generico per una serie di altre applicazioni software e 
dispositivi hardware che supportino il protocollo MIDI.   
 

Nota bene: il controller NuVJ è stato progettato specificamente per essere utilizzato con il 
software NuVJ. Tuttavia, può anche essere utilizzato come controller MIDI generico per varie altre 
applicazioni che rispondano a comandi MIDI. Servendosi del controller NuVJ con un’altra 
applicazione software, si potrebbe notare che alcune delle funzioni del controller sono disattivate. 
Ad esempio, i pad e i tasti non si illumineranno. Ciò è normale e il controller funzionerà ugualmente 
bene.   

 
In questo manuale, spiegheremo le funzioni dei comandi se utilizzati in abbinamento al software NuVJ. Leggere 
inoltre i paragrafi "Introduzione al software" e "Uso del software" del manuale per maggiori informazioni sul 
software stesso. 
   

Pannello superiore  
 

 

 
 

1. PAD: i 9 pad posti su ciascun lato controllano quale ‘clip’ viene visualizzata su ciascuna area 
del deck. Battendo il pad verrà attivata la clip assegnata a quella particolare “cella” del 
software. Vedi paragrafo Introduzione al Software per informazioni su clip, celle e deck. 

2. ROTELLA: le rotelle poste su ciascun lato possono essere utilizzate per scratchare o 
accelerare/rallentare il video in corso di riproduzione. Tenendo premuto il tasto [SCRATCH] 
che si trova sotto alla rotella, la si può utilizzare per scratchare il contenuto video. Se il tasto 
non viene mantenuto premuto, si può utilizzare la rotella per accelerare o rallentare le clip 
temporaneamente, come un bend del pitch. 

3. SPEED (velocità): i due cursori verticali posti al centro, impostano la velocità della 
riproduzione del video, permettendo di rallentare, accelerare o invertire il video su ciascuna 
zona del deck. 
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4. [SCRATCH]: tenendo premuto questo pulsante, è possibile servirsi della rotella jog per 
scratchare il video riprodotto su quel deck. 

5. [INSTA A/B]: questi tasti consentono di far passare rapidamente l’uscita video a uno dei 
deck. Ad esempio, premendo [INSTA A] l’uscita video mostrerà solo ciò che viene riprodotto 
sul deck A, indipendentemente dalla posizione del crossfader, fino a quando non viene 
rilasciata la pressione da [INSTA A]. La velocità di dissolvenza, quando i tasti [INSTA A/B] 
sono premuti, è determinata dalla manopola Auto Fade Speed (velocità dissolvenza 
automatica) posta sul pannello anteriore. 

6. BANK (banco): servirsi di questa manopola per selezionare diversi banchi di videoclip. Ogni 
banco contiene fino a 9 clip tra cui è possibile commutare premendo il pad corrispondente. Vi 
sono 16 banchi diversi che possono essere utilizzati su ciascuno dei due deck. 

7. PMTR1: è possibile assegnare un effetto tramite il software ad ogni cella di un banco. La 
manopola PMTR1 regolerà quindi il primo parametro di effetto della cella attualmente 
riprodotta su quel banco. Questo parametro cambierà a seconda dell’effetto prescelto per 
quella determinata cella. 

8. PMTR2: la manopola PMTR2 regola il secondo parametro di effetto della cella attualmente 
riprodotta su quel banco. Questo parametro cambierà a seconda dell’effetto prescelto per 
quella determinata cella. 

9. [LATCH]: se il tasto [LATCH] viene premuto e attivato, le clip sul deck verranno riprodotte in 
maniera continua quando avviate. Se il tasto [LATCH] viene premuto e disattivato, le clip sul 
deck verranno riprodotte fino a quando viene tenuto premuto il pad corrispondente. 

10. [AUTO]: premere questo tasto per riprodurre automaticamente le clip (celle) del banco 
attuale in ordine casuale. 

11. [SYNC]: premere questo tasto per sincronizzare la riproduzione dei videoclip sul deck al BPM 
della sessione. 

12. DISPLAY: il display aiuta a tenere sotto controllo i parametri del software. 

13. FX LEVEL: questa manopola regola il livello del Mix Master FX. Questa impostazione descrive 
quanto dell’effetto Master selezionato verrà mixato all’immagine originale. Alzando la 
manopola FX Level, si vedrà di più il mix con gli effetti.  Abbassando la manopola FX Level, si 
vedrà di più l’immagine originale. 

14. [MASTER FX]: premere questo tasto per attivare e disattivare l’effetto Master. Si possono 
invertire gli effetti al volo selezionando l’effetto desiderato con la manopola Master FX.    

15. MASTER FX: girare questa manopola per selezionare l’effetto Master. L’effetto Master verrà 
applicato alla zona di mixaggio master.   

16. PMTR1: questa manopola regola il primo parametro dell’effetto Master. Questo parametro 
sarà diverso a seconda dell’effetto prescelto. 

17. [INSTA BLACK]: la pressione di questo tasto commuta l’uscita video a nero o ad un effetto 
visuale assegnato nel software NuVJ.  

18. CONTRAST: servirsi di questa manopola per regolare il contrasto dell’uscita video. 

19. PMTR2: questa manopola regola il secondo parametro dell’effetto Master. Questo parametro 
sarà diverso a seconda dell’effetto prescelto. 

20. [BPM TAP]: ci si può servire di questo tasto per regolare manualmente il tempo della 
sessione battendolo al beat. Se si tiene premuto per 3 secondi e quindi lo si rilascia, il BPM 
della sessione tornerà al BPM individuato dall’ingresso sonoro. 

21. BRIGHT: servirsi di questa manopola per regolare la luminosità dell’uscita video. 

22. CROSSFADER: il crossfader permette di mixare gli effetti visuali riprodotti su ciascun lato. 
Spostando il crossfader verso destra, si vedrà maggiormente l’effetto visuale di destra. 
Viceversa, spostando il crossfader a sinistra, verrà miscelato maggiormente l’effetto visuale 
di sinistra. 
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Pannello posteriore 
 

 

 

 

1. AC IN: se l’apparecchio non è alimentato dal collegamento USB, può esserlo inserendo un 
adattatore di alimentazione 6V-1A CC a livello di questo ingresso . 

2. USB: collegare un cavo USB dal computer a questo ingresso. Questa porta serve per 
alimentare l’apparecchio, oltre a trasmettere il comando MIDI al computer e al software. Si 
può inoltre alimentare il controller servendosi di un adattatore 6V-1A CC. 

3. LUCCHETTO KENSINGTON: l’apparecchio può essere bloccato in maniera sicura servendosi 
di questa fessura per il lucchetto Kensington. 

   

Pannello anteriore 
 

 

 
 
1. FADER MODE: questo interruttore determina il funzionamento dell’opzione Fader Start, 

come specificato nel software. 

2. AUTO FADE SPEED: questo interruttore regola la velocità di dissolvenza automatica. Il 
comando velocità di dissolvenza automatica determina la velocità della dissolvenza dalla 
posizione attuale a fade full A/full B quando ci si serve dei tasti Insta A/B sul pannello 
superiore. 

3. FADER START: permette di attivare un determinato pad spostando il fader verso il deck su 
cui è caricato. Ad esempio, se il crossfader si trova all’estrema destra o all’estrema sinistra, 
spostandolo verso il lato opposto si attiverà il video selezionato su quel deck.   
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COLLEGAMENTO DEL CONTROLLER AL COMPUTER 
 

 

 

 

Per collegare il NuVJ al computer, collegare il cavo di alimentazione USB in dotazione dalla porta 
USB del NuVJ ad una porta USB libera del computer. Non è necessario servirsi di un adattatore in 
quanto il bus USB del computer alimenterà il controller, ma se si desidera utilizzare una fonte di 
alimentazione esterna, basterà collegare un adattatore 6v1a.   

Il NuVJ è un dispositivo Plug and Play, quindi non vi sono driver o software speciali da installare. 
Quando si collega il controller, lo schermo si illumina e a display appare la scritta “NuVJ”.  

 
Nota bene: al momento di utilizzare il controller NuVJ con altro software, alcune delle 
funzioni del controller stesso saranno disattive. Queste funzioni comprendono i LED e la 
lettura dei valori a display.  A display appare semplicemente la scritta “NuVJ”. 
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INSTALLAZIONE DEL SOFTWARE - PC 
 

 
 

1. Per installare il software NuVJ, inserire il CD d’installazione del NuVJ nel lettore CD-ROM del 
computer. 

2. Fare doppio clic sul file d’installazione di NuVJ, situato nella directory principale del CD. Questo 
lancerà il wizard InstallShield. 

3. Seguire le istruzioni da schermo.   
Nota bene: prima d’installare il software, il programma d’installazione eseguirà una scansione dei 
componenti video disponibili. Se alcuni dei componenti non fossero aggiornati, installarli cliccando 
sul pulsante corrispondente prima di procedere con l’installazione. 

4. Una volta completata l’installazione, cliccare “Finish” (Fine). Il software NuVJ è ora pronto all’uso. 
5. Assicurarsi che il controller sia collegato alla porta USB del computer e lanciare il NuVJ tramite il 

percorso Start -> Arkaos NuVJ -> Arkaos NuVJ. 
Nota bene: se il controller viene collegato dopo aver lanciato il software NuVJ, potrebbe non 
funzionare. Sarà necessario riavviare il software. In generale, collegare sempre il controller prima 
di lanciare il software. 

6. Inserire il numero di serie (16 cifre) del NuVJ. 
7. Una volta inserito il giusto numero di serie, registrare la copia del NuVJ. Per farlo, è necessario 

essere collegati a Internet. La registrazione dà accesso a ulteriori contenuti presenti online e agli 
aggiornamenti del programma. 

 
 

 

INSTALLAZIONE DEL SOFTWARE - MAC 
 

 
 

1. Per installare il software NuVJ, inserire il CD d’installazione del NuVJ nel lettore CD-ROM del 
computer. 

2. Clicccare sul file di installazione NuVJ contenuto nel CD. 
3. Seguire le istruzioni da schermo. 
4. Una volta completata l’installazione, sul desktop apparirà un collegamento. Questa applicazione 

apparirà anche nella cartella Applicazioni -> NuVJ. 
5. Assicurarsi che il controller sia collegato alla porta USB del computer e lanciare il NuVJ. 

Nota bene: se il controller viene collegato dopo aver lanciato il software NuVJ, potrebbe non 
funzionare. Sarà necessario riavviare il software. In generale, collegare sempre il controller prima 
di lanciare il software. 

6. Inserire il numero di serie (16 cifre) del NuVJ. 
7. Una volta inserito il giusto numero di serie, registrare la copia del NuVJ. Per farlo, è necessario 

essere collegati a Internet. La registrazione dà accesso a ulteriori contenuti presenti online e agli 
aggiornamenti del programma. 
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INTRODUZIONE AL SOFTWARE 
 

 
In questo paragrafo, vedremo una breve panoramica sul software e spiegheremo alcuni concetti chiave sul suo 
funzionamento. Si raccomanda di leggerlo attentamente, in quanto fornisce una buona idea generale delle 
funzioni del NuVJ, oltre ad insegnare alcuni concetti fondamentali del mixaggio video. 
 

Principi fondamentali 
 

 
NuVJ permette di mixare video e immagini in tempo reale in maniera molto intuitiva. Ruota attorno 
ad un’impostazione simile a quella di un deck per DJ, in cui vi sono due deck per la riproduzione e 
si può mixare l’uscita dei deck stessi servendosi di un cursore di mixaggio. 

 

              

 Filmato A Filmato B

Mixer 
Video 

Uscita

 
 
 

Questa impostazione si riflette sia nell’interfaccia del software che sul controller: il deck A è 
rappresentato dalla zona sinistra del pannello principale, il deck B dal lato destro, mentre i comandi 
del mixer e dell’effetto master si trovano al centro, come illustrato di seguito: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Su ciascuna area del deck, si vedono una serie di quadrati. Questi sono detti “celle” e servono da 
segnaposto per videoclip, immagini o file flash (li nomineremo in generale ‘clip’). Ogni deck può 
riprodurre una cella per volta. 

 
Per assegnare una clip ad una cella, basterà trascinarvi un'immagine o un video dal browser dei file 
posto all’estrema sinistra dell’interfaccia o direttamente dalla finestra di explorer/finder. Una volta 
assegnato, si può cliccare sulla cella per attivarla oppure premere il pad corrispondente sul 
controller NuVJ. Attivando una cella su ogni deck, si ne può vedere la riproduzione nelle rispettive 
finestre di anteprima, e vedere il risultato del mixaggio nella finestra centrale. Spostare il cursore 
di mixaggio servendosi del mouse o del crossfader sul controller per vedere come l’equilibrio di 
mixaggio varia nella finestra di anteprima.   
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L'immagine in grande 
Durante un'esibizione, di solito è necessario proiettare l'uscita a risoluzione 
massima. Per fare ciò, bisognerà attivare la modalità schermo intero a 
livello dell'interfaccia del software. Per fare questo si deve cliccare su  
Display > Schermo intero o, alternativamente, premere CTRL+A 
(Command+A su Mac) sulla tastiera del computer.  Per uscire dalla modalità 
schermo intero, premere nuovamente CTRL+A. Come vedremo più avanti 
(vedi Preferenze/Display più avanti in questo documento), se la scheda 
video permette uscite video multiple, l'interfaccia può essere visualizzata sul 
monitor principale, mentre l'uscita a schermo intero viene inviata ad 
un’uscita monitor secondaria a cui può essere collegato un proiettore. 
 

 
 

Panoramica 
 

 
Come appena visto, il NuVJ ruota attorno a una semplice impostazione deck A/B & mixaggio. In 
questo capitolo esploreremo le sue funzioni in maggior dettaglio. 
 

Deck:  

Come detto in precedenza, i deck sono sorgenti per 
stream video. Contengono celle che sono segnaposto per 
clip. Quando si attiva una cella su un deck, si può notare 
l'anteprima del filmato/immagine nella finestra di 
anteprima posta sulla parte superiore dell'area del deck. 
In un deck può essere riprodotta una sola cella per volta. 
La cella attualmente riprodotta sul deck è evidenziata in 
rosso sull'interfaccia del software; un LED fornisce inoltre 
indicazioni sulla superficie di controllo. 

Celle:  
 
Le celle sono segnaposti a cui si assegnano le clip che si 
intende utilizzare nel mix. Oltre a contenere una clip, alle 
celle può anche essere assegnato un effetto che verrà 
quindi applicato automaticamente alla clip caricata in 
quella determinata cella. Per assegnare un effetto a una 
cella basterà trascinarlo dall'elenco degli effetti situato a 
sinistra alla cella desiderata. Se è stata attivata una cella 
con un effetto, due manopole poste al disopra dell'area 
della cella diventano attive e consentano di modificare i 
parametri dell’effetto. I parametri dell'effetto possono 
essere modificati servendosi del mouse sull'interfaccia, 
oppure con le due manovre dei parametri effetto (PMTR1 
e PMTR2) sul lato di ciascun deck del controller. Ad 
esempio, nella figura a destra, sulla cella superiore 
sinistra è stato impostato un contrasto direzionale, e i suoi 
due parametri, LIVELLO e DIREZIONE, sono disponibili per 
la messa a punto. Quando una cella viene selezionata 
(doppio clic) o riprodotta (clic semplice) con il mouse, 
sulla parte inferiore dello schermo viene aggiornato un 
pannello che presenta parametri avanzati della cella. 
Questo consente la modifica dei parametri di riproduzione 
e di mixaggio, oltre che dei parametri predefiniti per l'effetto quando la cella viene attivata. Per speciali “file 
di testo”, il testo da visualizzare può essere a sua volta modificato a questo livello. I parametri della cella 
saranno discussi in maggior dettaglio più avanti nel manuale. 

 

File:  
 
I file sono materiale sorgente da riprodurre nelle celle. I file 
possono essere trascinati direttamente dalla finestra 
explorer/finder oppure servendosi del browser integrato di NuVJ 
posto alla sinistra dell'interfaccia. NuVJ supporta una serie di 
formati video, immagine e flash. Vedi il paragrafo Consigli sulle 
prestazioni alla fine del manuale per trovare una descrizione dei 
vari formati dei file e della loro efficienza. Oltre a riprodurre file singoli, si può anche trascinare un'intera 
cartella su una cella: NuVJ riprodurrà tutti i video e le immagini situati nella cartella, uno dopo l'altro come 
una presentazione di diapositive.  
 

Nota bene: per ragioni di memoria, i file riprodotti servendosi di una cartella non si servono di 
un pre-cache, quindi passare da una visuale a un'altra è meno efficace quando si passa 
attraverso una cartella di quando vengono attivate direttamente. 

                                   DECK 

 

 

 

 

 

 

 

 

   CELLA 
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Effetti:  
 
Gli effetti servono ad alterare le clip in vari modi. Il NuVJ 
fornisce un'ampia collezione di effetti classificati in diverse 
categorie. Sono elencati nella seconda linguetta della sezione 
del browser all'estrema sinistra dell'interfaccia. Gli effetti 
possono essere applicati sulla cella per modificare singole clip, 
oppure sull'uscita master per modificare il risultato del 
mixaggio. È da notare che a seconda della capacità 
dell’hardware video, non tutti gli effetti potrebbero essere 
disponibili in quanto alcuni richiedono la presenza di hardware di 
elevate prestazioni. 
 
Sorgenti:  
 
Le sorgenti sono come le clip, tranne per il fatto che non sono 
collegate a file sul disco fisso. Le sorgenti sono elencati nella 
terza linguetta della sezione del browser all'estrema sinistra 
dell'interfaccia. Sono suddivise in tre principali categorie: 
ingressi live, generatori e testi. Gli ingressi live comprendano 
tutti gli ingressi da videocamera disponibili sul sistema. 
Servendosi di questi, si può inviare materiale direttamente al 
NuVJ da webcam USB o Firewire, videocamere DV, moduli 
rivelatori, e altri dispositivi video. La categoria Ingressi mostra 
tutti gli ingressi live riconosciuti dal sistema. I generatori sono elementi che generano automaticamente 
schemi servendosi del sistema di processo interno degli effetti ed il segnale proveniente dall'ingresso audio, 
un po' come avviene per i moduli di visualizzazione di iTunes o Windows Media Player. Per assegnare una 
sorgente ad una cella basterà trascinarla sulla cella desiderata. La terza categoria, ‘testi’ contiene file 
speciali che possono essere utilizzati per visualizzare il testo di presentazioni, annunci e così via. 

 
IMPIEGO DI INGRESSI AUDIO:   

 

Il NuVJ permette di sincronizzare i videoclip e le prestazioni al segnale proveniente dall'ingresso 
audio.  Per servirsi di questa funzione, collegare una sorgente audio all'ingresso a livello di linea della 
scheda audio del computer. Sarà necessario verificare che sia stato selezionato l'ingresso di linea 
come sorgente d'ingresso.   

PC: recarsi su Risorse del computer -> Pannello di controllo -> Suoni e periferiche audio, cliccare 
sulla linguetta Audio e quindi su Avanzate – questo farà apparire in pannello di controllo del volume.  
Cliccare su Opzioni -> Proprietà -> Registrazione – questo permette di visualizzare le sorgenti 
d'ingresso di registrazione.  Verificare che sia segnato Line In e che il cursore del volume sia su. 

Per poter ascoltare l'ingresso audio tramite la scheda audio del computer, sarà necessario tornare a 
Opzioni -> Proprietà -> Riproduzione e assicurarsi che Line In non sia muto e che il cursore del 
volume sia su.  

In alcune schede audio, è possibile selezionare l'uscita della scheda come dispositivo di registrazione. 
Di solito si trova nelle sorgenti di registrazione indicato con ‘Stereo mix’. Se la scheda presenta tale 
canale, selezionandolo sarà possibile sincronizzare direttamente il NuVJ all'audio riprodotto sullo 
stesso PC. 

MAC: recarsi su Finder -> Applicazioni -> Preferiti di sistema, e cliccare sull’icona Audio. Selezionare 
Input per visualizzare le sorgenti d’ingresso disponibili. Selezionare il dispositivo che si desidera 
utilizzare come dispositivo d’ingresso: una volta selezionato quest’ultimo, il NuVJ sincronizzerà il BPM 
della sessione a tale dispositivo. 

 
Libreria effetti visuali:  
 
La libreria degli effetti visuali è un modo conveniente di trovare 
clip che sono già caricate nell’applicativo. Una volta che una clip 
è caricata sul NuVJ, diventerà disponibile nella libreria effetti 
visuali e vi si potrà accedere in qualsiasi momento durante la 
sessione. La libreria si trova a livello della quarta linguetta della 
sezione browser. Si possono trascinare direttamente effetti 
visuali dalla libreria alle celle senza doverli cercare nuovamente 
sul disco fisso. 
 
Banchi:  
 
I banchi sono gruppi di nove celle. Su ogni deck vi 
è sempre un banco selezionato. Il numero del 
banco corrente viene mostrato nella zona blu 
subito sotto alla finestra di anteprima del deck. Si 
possono cambiare banchi in qualsiasi momento 
premendo le frecce direzionali o ruotando la 
manopola BANK sul controller. Servendosi dei 
banchi si possono organizzare le clip per tema, 
ambiente o tipo di sequenze. 
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Comando di riproduzione del deck:  
 
Di fianco al display di selezione del banco, vi sono alcuni comandi che possono essere utilizzati per 
modificare la riproduzione delle celle su quel deck: 

 
L’indicatore superiore è la posizione di riproduzione all'interno della clip in corso. 
 
L’ indicatore inferiore controlla la velocità di riproduzione della clip.  Il centro rappresenta una velocità 
pari a zero (la clip sarà interrotta). Se l'indicatore è posto a destra, il filmato verrà riprodotto in 
avanti, mentre se si trova sulla sinistra verrà riprodotto all'indietro. Più ci si allontana dal centro più il 
filmato verrà riprodotto rapidamente. Per modificare la velocità di riproduzione servendosi 
dell'interfaccia, cliccare sul comando per spostare l'indicatore di velocità a quel punto. Si può anche 
regolare la velocità di riproduzione servendosi dei cursori SPEED sul controller. Una barra verticale a 
livello dell'indicatore di velocità mostra il punto di velocità in cui il filmato gira a velocità nominale. 
Quando la velocità è impostata vicino alla velocità nominale, l'indicatore diventerà rosso. 
 
 
 
 
 
 
 
 
Il tasto [LATCH] influenza la reazione all'attivazione della cella. Se questo tasto è attivato, la cella 
continuerà a essere riprodotta anche dopo aver rilasciato il mouse o il pad sulla superficie di controllo. 
Se disattivato, la cella interromperà la riproduzione appena si rilascia il mouse/pad del controller. Si 
può anche attivare /disattivare la modalità servendosi del tasto LATCH posto sul controller. 
 
Il tasto [SYNC] attiva una modalità di "riproduzione sincronizzata" delle clip. Quando è attivato, il 
NuVJ adatta la velocità del filmato in modo tale che sia ‘in sync’ con il BPM localizzato dall'ingresso 
audio. Si può commutare la modalità sync dal controller servendosi dell'apposito tasto. Quando sync è 
attivato, la velocità del filmato può sempre essere modificata servendosi dei cursori di velocità. 
 
Il tasto [AUTO] attiva la modalità automatica per il deck. In modalità automatica, il NuVJ attiva 
automaticamente le celle per il banco attuale in maniera casuale, seguendo il BPM individuato 
dall'ingresso audio. Questo può essere utile se si desidera riposare durante un'esibizione o se si 
desidera semplicemente mischiare automaticamente gli effetti visuali. 

 
 
Il Crossfader:  
 
Il crossfader si trova in una posizione centrale. Servendosi 
del mouse o del cursore sul controller, si può utilizzare il 
crossfader per mischiare i filmati. Se si trova all'estrema 
sinistra, sarà visibile solo l'uscita del deck A, mentre se si 
trova all'estrema destra, verrà mostrata solo l'uscita del deck 
B. In posizione intermedia, A & B verranno mischiate secondo una curva di ‘transizione’ che può essere 
scelta. Per scegliere la curva di transizione, cliccare con il tasto destro sul crossfader e selezionare uno dei 
passaggi disponibili. Il controller presenta anche un interruttore FADER MODE sul pannello anteriore che 
permette di scegliere tra 3 curve di transizione predefinite. Per maggiori informazioni sulla definizione dei 
passaggi utilizzati dal controller, vedi più avanti nel paragrafo Preferenze. 
 
L’effetto Master:  
 
L'effetto master è un ulteriore effetto che può essere applicato 
all'uscita del mix di immagini. L'effetto master può essere 
selezionato tramite l'interfaccia del software oppure tramite la 
manopola MASTER FX sul controller. È possibile mettere a punto 
due parametri per ogni effetto servendosi delle manopole PMTR1 e 
PMTR2 sul controller. La manopola FX LEVEL (Master FX Mix) 
consente l'impostazione della percentuale di immagine con effetto 
che andrà nell'uscita finale. Si può anche aggirare completamente 
l'effetto master premendo il tasto MASTER FX sul controller. 

 
 
Comando luminosità/contrasto:  
 
Prima di inviare l'immagine all'uscita principale è possibile 
regolarne la luminosità e il contrasto. Questo vi permette di 
regolare l'immagine in base alle condizioni di illuminazione 
della stanza o di compensare per una perdita/guadagno di 
luminosità dovuta ad un forte processo dell'immagine e 
miscela. L'impostazione di contrasto o di luminosità può essere regolata dall'interfaccia utente o 
direttamente dalla superficie di controllo tramite le manopole CONTRAST e BRIGHT. Se questa funzione non 
viene utilizzata, può essere bypassata nel dialogo Preferenze: questo farà risparmiare energia di CPU e può 
portare a un leggero miglioramento delle prestazioni. 

 

Nota bene: l'efficienza della riproduzione a velocità non nominale 
dipende molto dal tipo di filmato e di compressione utilizzata per le  
clip. Per maggiori informazioni su questo argomento, vedi il paragrafo 
Consigli sulle prestazioni del manuale. 
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Funzioni avanzate 
 

 
Sfondo:  
 
Il NuVJ garantisce la possibilità di inserire una clip di sfondo da visualizzare nel caso in cui non vengano 
riprodotte clip su nessuno dei due deck o nel caso in cui il tasto [INSTA BLACK] del controller venga 
premuto. La clip di sfondo viene definita nel dialogo preferenze recandosi su File > Preferenze, e può anche 
essere sostituita “al volo” trascinando una clip nella finestra di anteprima master. A livello del menu 
Preferenze è anche possibile attivare l'uso di modalità di copia & miscela (vedi più avanti) tra il deck A e lo 
sfondo. Questa opzione non è attiva in via predefinita per evitare confusione. 
 
Parametri di cella e mixaggio avanzato:  
 
Quando si fa clic su una cella con il mouse o la si attiva con uno dei pad, il pannello parametri della cella 
posto in fondo all'interfaccia viene aggiornato in modo da mostrare le impostazioni della cella selezionata. 
Per modificare i parametri di una cella senza attivarla, fare clic sulla cella stessa servendosi del tasto destro 
del mouse. Il pannello parametri contiene opzioni avanzate che permetteranno di portare il mix e le 
prestazioni ad un livello superiore. Per illustrare queste opzioni, immaginiamo di voler mixare le due 
seguenti immagini: 

 
Deck A: 

 
 

 
Deck B: 

 

 
Modalità di copia:  
 
Le modalità di copia esprimono il modo in cui le celle dei deck A & B sono miscelate nel mixer. A meno che 
non venga impostata un'opzione speciale (vedi Preferenze / Avanzate),  le impostazioni saranno efficaci solo 
quando una cella si trova sul deck B. Questo perché il deck B è considerato virtualmente ‘sopra’ al deck A e 
le modalità di copia definiscono il modo in cui B viene ‘unito’ su A. 

 
La modalità di copia definisce l'operazione matematica 
impiegata per coordinare il colore dei pixel del deck B con 
il colore dei pixel del deck A. Analizziamoli in ordine, da 
sinistra a destra. 
 

 
Quella predefinita è la modalità copia (copy). In questa modalità, la cella sul deck B verrà 
semplicemente mixata con la cella sul deck A, ossia l’uscita risultante sarà data dalla media dei 
pixel di ciascuna immagine. 

 
La modalità aggiunta (addition) è quella in cui i pixel di B vengono aggiunti ai pixel di A. Se viene 
selezionata questa modalità (oltre alle modalità sottrazione, moltiplicazione, massimo e minimo), 
l’effetto è massimo quando il cursore di mixaggio si trova all’estrema destra.  

 
 

La modalità sottrazione (subtraction) è quella in cui i colori dei pixel del deck B vengono sottratti 
dal deck A, dando una miscela ‘inversa’ di B in A.  

 
 

         La modalità di moltiplicazione (multiplication) è quella in cui i pixel del deck B vengono 
moltiplicati per i pixel del deck A.  

 
 

La modalità massimo (maximum) seleziona i pixel dal deck A o B, a seconda di quale presenta la 
maggiore luminosità. 

 
 

La modalità minimo (minimum) seleziona i pixel dal deck A o B, a seconda di quale presenta la 
minore luminosità.  
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Opzioni maschera:   
 
Le opzioni maschera permettono la rimozione (mascheramento) di parte del contenuto della clip, in base ad 
un colore o ad una caratteristica di luminosità. Questo procedimento è anche noto con il nome di ‘keying’ di 
colore o luminosità. Per quanto riguarda le modalità di copia, le 
impostazioni di mascheramento vengono applicate unicamente a 
celle sul deck B, poiché il deck B si trova sopra al deck A. Quando 
il keying di luminosità o colore sono attivati, le due manopole che 
si trovano sotto alla selezione diventano attive. Queste manopole 
permettono di definire le caratteristiche (center e width) di un 
filtro di repulsione di banda che sarà applicato o sui livelli di 
luminosità o su quelli di colore dell’immagine della clip. Qualsiasi luminosità o colore facente parte di quella 
zona verrà reso trasparente e A apparirà attraverso di essa. 

 
Le modalità predefinite all'estrema sinistra disattivano la funzione di keying. In questo caso, le manopole 
center e width saranno disattivate a loro volta. 

 
La tecnica di keying della luminosità permette di rendere trasparenti una serie di valori di 
luminosità. Ad esempio, impostando il parametro centrale al massimo, si renderanno tutti i 
valori luminosi (bianchi) trasparenti, e si vedrà sotto il contenuto del deck A. Il centro definisce 
la gamma di tonalità di grigio da scartare. 

 
 

La tecnica di keying del colore permette di rendere trasparente una gamma di colore. La 
posizione della manopola centrale definisce quale colore verrà scartato e l’ampiezza definirà 
quanto ampio è il raggio di colore attorno al valore centrale da scartare. 

 
Opzioni riproduzione:  
 
Le opzioni di riproduzione influiscono sul modo in cui verrà riprodotta la clip. Vi sono tre modalità: One Shot, 
Loop e Ping-Pong. 

 
In modalità One Shot, il filmato viene riprodotto una volta quando 
viene attivato e si ferma quando arriva in fondo. 

  
In modalità Loop, la clip continua a riprodursi in maniera circolare. Questa è la modalità predefinita. 

 
In modalità Ping-Pong, la clip effettuerà alternativamente un loop in avanti, quindi indietro, quindi 
nuovamente in avanti...  
 
Opzioni effetti:  
 
Le opzioni effetti sul lato destro permettono l’impostazione dei valori 
predefiniti per i parametri degli effetti. Questi valori verranno 
richiamati automaticamente ogni volta che viene attivata la cella. 
Possono sempre essere modificati dal vivo servendosi dei parametri 
effetti del deck (vedi paragrafo sul deck), ma i valori predefiniti 
impostati a questo livello torneranno ogni volta che la cella viene 
attivata nuovamente. Per ‘copiare’ le attuali impostazioni al posto dei parametri predefiniti per la cella (in 
modo che vengano ricordati la prossima volta che si aziona la cella), premere la manopola BANK del 
controller per il deck selezionato.   
 
Impostazioni di testo: 
 
Quando si usano testi dal browser sorgente, il testo visualizzato può essere modificato nell’ingresso testuale 
situato a livello del pannello dei parametri della cella. 
 
Importa/esporta banco:  
 
Oltre ad essere in grado di caricare e di salvare l’intero contenuto della prestazione recandosi nel menu file, 
si può anche importare ed esportare singoli banchi tenendo premuto il clic con il tasto destro su di una cella 
e selezionando la voce dal menu a pop up che compare (vedi ulteriori spiegazioni nella descrizione 
dell’interfaccia utente). Questa funzione rende facile caricare gruppi di effetti visuali predefiniti durante 
l’esibizione. Permette di salvare un numero illimitato di gruppi di clip ed effetti preconfigurati e di richiamarli 
in qualsiasi momento senza dover interrompere la prestazione. 
 
Doppio monitoraggio:  
 
Per effettuare una prestazione VJ come si deve, conviene usare schede video che supportino doppi monitor. 
In questo modo, è possibile proiettare l’uscita del mixer al secondo monitor (collegato ad un sistema di 
proiezione, ad esempio) e continuare ad avere accesso all’interfaccia utente con il controller sul monitor 
principale. Per impostare il doppio monitoraggio con il NuVJ, bisogna innanzitutto assicurarsi che il sistema 
sia configurato in modo da lavorare con due uscite schermo indipendenti (e che non si stia utilizzando la 
clonazione quando entrambe le prese dell’adattatore emettono la stessa immagine). Una volta impostato il 
sistema, avviare il NuVJ e recarsi su Preferenze (File > Preferenze). Nella sezione Visualizza, selezionare 
quale monitor si desidera utilizzare per l’uscita a schermo intero. Una volta fatto ciò, si può entrare in 
modalità schermo intero recandosi su Visualizza > Schermo intero o premendo CTRL+A (command+A su 
Mac).  Si può inoltre uscire dalla modalità a schermo intero premendo CTRL+A (command+A su Mac). 
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USO DEL SOFTWARE 
 

 
Questo paragrafo indica in dettaglio i vari elementi dell’interfaccia utente oltre al modo di interagire appieno 
con il programma: 
 
L’interfaccia utente è suddivisa in 4 diverse aree: la zona menu/browser (parte superiore sinistra), la zona di 
mixaggio (superiore destra), la finestra delle informazioni (inferiore sinistra) e il pannello dei parametri della 
cella (inferiore destra).            
         

 
 

Menu 
 

 
I menu sono organizzati come segue: 
 
File ---------------------- 

New (nuovo): cancella tutti i dati e dà inizio ad una prestazione vergine 
Open (apri): apre un file prestazione (.nvj)  
Save (salva): salva la prestazione attuale 
Save As...(salva come): salva la prestazione attuale come un nuovo file 

   Preferences (preferenze): fa aprire la finestra di dialogo preferenze 
Quit (esci): lascia l’applicazione. Funziona unicamente quando lo schermo intero non è attivo, 
per evitare lo spegnimento improvviso durante una prestazione 

 
Edit ---------------------- 

Cut Cell (taglia cella): rimuove la cella attuale modificata e ne copia il contenuto sulla 
clipboard 

  Copy Cell (copia cella): copia la cella attuale modificata sullaclipboard 
    Paste Cell (incolla cella): copia la clipboard sulla cella attuale modificata  
    Clear Background (cancella sfondo): rimuove la clip di sfondo attuale 

Purge Visuals (elimina visuali): rimuove clip inutilizzate dalla memoria. 
  

Display ---------------------- 
Toggle Fullscreen (commuta schermo intero): attiva/disattiva la modalità schermo intero 

 
Help ---------------------- 

Getting Started (guida rapida): apre il pdf della Guida rapida del NuVJ  
Reference Manual (manuale di riferimento): apre il pdf del Manuale di riferimento del 
NuVJ  
Release Notes (informazioni): visualizza a display il pdf contenente informazioni relative alla 
versione corrente del software e ulteriori informazioni in merito al software stesso 
NuVJ Web Site (sito NuVJ): apre il sito di NuVJ nel browser internet  
Register (registrazione): consente di registrare il NuVJ su internet 
 



 

76 

 

L’area browser  
 

 
L'area browser fornisce diverse visuali ad albero per la scelta dei contenuti e degli effetti necessari 
all'esibizione. Questa zona contiene quattro linguette che danno accesso a File, Effetti, Fonti, e 
Libreria. Per servirsi di uno di questi, trascinare un elemento dal browser su una cella. Inoltre, è 
anche possibile trascinare elementi ad una qualsiasi delle finestre di anteprima: trascinando un 
elemento su una delle finestre di anteprima del deck, questo prenderà il posto dell’effetto visuale o 
dell'effetto presente sulla cella e attualmente riprodotto. Se si trascina un elemento sull'anteprima 
master, imposterà la clip di sfondo o l'effetto master. 
 
Nell'area browser, si può trovare una finestra di filtro file che permette di selezionare quali file 
saranno visibili nel browser dei file. L'impostazione predefinita è quella di mostrare tutti i file 
compatibili (video, foto e file flash), ma si potrebbe volerlo cambiare in modo da mostrare solo 
foto, solo filmati, solo file flash o di visualizzare tutti i file presenti sul disco fisso. 
 
Sotto il filtro è anche presente un’icona cestino. Questa icona può essere utilizzata per rimuovere 
effetti visuali ed effetti dalle celle semplicemente trascinando la cella o l’icona dell'effetto dalla cella 
al cestino stesso. 
 

L’area di mixaggio 
 

 
L'area di mixaggio contiene tutte le informazioni relative al contenuto e all'anteprima del deck, 
oltre al cursore di mixaggio e all’effetto master. La colonna più a sinistra è il Deck A, quella più a 
destra è il Deck B, mentre quella centrale è la zona di Mixaggio ed Effetto Master. 
 
Zone Deck (A e B): 

 
Ogni deck contiene i seguenti elementi, dall'alto in basso: 

  
L'anteprima Deck: mostra l'uscita della cella dal deck. Si possono trascinare elementi 
dal browser direttamente all'anteprima Deck, che prenderà il posto dell’effetto visuale o 
dell'effetto presente sulla cella e attualmente riprodotto. 

 
Comandi Deck: contiene gli elementi che permettono di controllare la selezione del 
banco, la velocità di riproduzione del deck, e l'impostazione delle modalità latch, auto e 
sync. Vedi ‘Comandi di riproduzione del Deck’ nel paragrafo ‘Introduzione al Software” 
di questo manuale per maggiori informazioni su questi comandi. 

 
Parametri effetti Deck: consente la modifica dei parametri degli effetti della cella 
attualmente riprodotta. Queste modifiche sono solo temporanee: non appena una 
nuova cella viene attivata, i valori dei parametri dell'effetto tornano al valore definito 
nel pannello dei parametri della cella. Se si desidera copiare i parametri degli effetti 
attuali al posto dei parametri predefiniti della cella in modo che vengano utilizzati la 
prossima volta che si attiva la cella stessa, premere il tasto [BANK] del deck. 

 
Celle: nella parte inferiore del Deck, si notano le nove celle del banco selezionato. 
Trascinare qualsiasi file, effetto o fonte dal browser ad una cella per modificarne il 
contenuto. La cella mostrerà un fermo immagine della clip che le è stata assegnata 
oltre ad alcune icone informative: 

 
Una cella grigia, circondata da un bordo rosso, significa che tale 
cella è attualmente riprodotta sul Deck. Un’icona a forma di 
matita nell'angolo superiore sinistro significa che la cella è stata 
selezionata per essere modificata e che i suoi parametri sono 
visibili nel pannello dei parametri della cella. Significa inoltre che 
è l'oggetto attuale delle operazioni di copia/incolla. Per 
selezionare una cella, fare clic con il mouse (in questo caso la 
cella sarà attiva e selezionata per la modifica) o con il tasto 
destro del mouse (nel cui caso la cella sarà selezionata ma non attiva). 

 
L'icona posta in basso a destra significa che sulla cella è applicato un effetto. Quella a 
sinistra significa che la cella ha modalità di copia non predefinita e di mascheramento. 

 
Si possono trascinare effetti visuali ed effetti da cella a cella. Per trascinare una clip da 
una cella all'altra, basta cliccare su di una zona dell'immagine e trascinarla su un'altra 
cella. Per trascinare un effetto da una cella all'altra, trascinare l'icona dell'effetto stesso 
da una cella all'altra. 
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Facendo clic con il tasto destro su una cella per alcuni secondi, apparirà un menu a 
pop-up con le seguenti voci: 

  
Clear Visual: rimuove la visuale dalla cella 
Clear Effect: rimuove l'effetto dalla cella 
Reset Cell: rimuove tutte le impostazioni, visuali ed effetti dalla 
cella 
Import Bank: importa un intero banco da un file .nvjb 
sostituendo il banco a cui appartiene la cella. 
Export Bank: permette di esportare tutto il banco cui appartiene 
la cella in un file.njvb. 
Clear Bank: cancella il contenuto del banco. Le clip sono 
conservate nella memoria dell'ulteriore accesso (tramite browser della libreria effetti 
visuali). Per liberare lo spazio impiegato da clip non selezionato in alcun banco servirsi 
del comando ‘Purge Visuals’ dal menu edit. 

 
 
Zona di mixaggio e di effetto master: 

 
La zona intermedia contiene tutti gli elementi relativi all'uscita master e al processo del mixaggio. 
Contiene dall'alto in basso: 

 
Anteprima uscita: l'anteprima uscita duplica le immagini inviate ad un secondo monitor quando in 
modalità schermo intero. Si possono trascinare elementi del browser all'anteprima uscita. Se si 
trascina una Clip, una forte Camera o un Generatore, quell'elemento sostituirà lo sfondo 
attualmente selezionato (vedi sfondo nel paragrafo Concetti). Se si trascina un effetto, quell'effetto 
sarà utilizzato come effetto Master corrente. 

 
Luminosità e contrasto: questi due comandi permettono la correzione del contrasto e della 
luminosità dell'immagine, o per adattarla alle condizioni di illuminazione della stanza, o per 
compensare il risultato di un pesante uso di effetti. 

 
Sezione effetto Master: la sezione effetto master permette di applicare un ulteriore effetto all'uscita 
del mixer. L'effetto può essere selezionato servendosi del combo box e le tre manopole sottostanti 
permettono di modificare l'effetto stesso. La prima determina la percentuale wet/dry tra l'uscita 
originale e quella effettata, mentre le altre due permettono la modifica di parametri specifici 
dell'effetto selezionato. 

 
Crossfader: controlla il mixaggio tra Deck A e Deck 
B. Se è spostato all'estrema sinistra permetterà il 
passaggio del solo Deck A nell'uscita, mentre, se 
all'estrema destra, sarà visualizzato solo B. Il modo 
in cui l'immagine viene mixata da A a B dipende dal 
passaggio utilizzato. I passaggi possono essere 
selezionati facendo clic con il tasto destro sul 
crossfader oppure servendosi dell'interruttore 
configurato sulla superficie di controllo. Notare che il 
numero di passaggi disponibili dipende dalla capacità 
dell'hardware. 
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La zona informazioni  
 

 
La zona informazioni, posta sulla parte inferiore sinistra dello schermo, mostra informazioni 
dinamiche basate sull'elemento su cui si trova il mouse. Per avere informazioni su un elemento 
specifico, basta spostare il puntatore del mouse su di esso e leggere le informazioni stesse. 
 

Il pannello parametri cella  
 

 
Il pannello parametri cella permette la modifica dei parametri relativi alla cella attualmente 
selezionata per la modifica. Esiste una sola tale cella per volta che può essere riconosciuta 
dall'icona sovrapposta al fermo immagine dell'effetto visuale:   

 
Come spiegato in dettaglio nel paragrafo ‘Concetti’, il pannello consente di modificare la 
riproduzione ed il mixaggio di caratteristiche di ciascuna cella. Serve inoltre per impostare i valori 
dei parametri predefiniti degli effetti che verranno ripristinati ogni volta che viene attivata la cella. 
 

La finestra preferenze  
 

 
La finestra preferenze determina varie impostazioni che regolano il modo in cui lavora il 
programma. Le impostazioni sono suddivise in quattro categorie, ognuna delle quali è accessibile 
tramite una linguetta della finestra stessa: 
 
 General (generale): 
 

Background visual: 
specifica il file da utilizzare 
come clip di sfondo. Questo 
file verrà 
riprodotto/visualizzato 
quando nessuna cella viene 
riprodotta sui deck o quando 
viene premuto il tasto ‘Fade 
to Black’ del controller.  
Inserire l’indirizzo completo 
del file oppure servirsi del 
pulsante select per aprire il 
browser dei file. Questo file 
viene utilizzato come sfondo 
predefinito e verrà 
ripristinato quando si riavvia 
l'applicazione, si carica un 
file di esibizione oppure si azzerano i dati servendosi del menu File>Nuovo. Si può 
sovrascrivere il valore impostato qui o selezionando il menu Edit>Clear Background 
oppure trascinando una clip direttamente sulla finestra di anteprima master.  
 
Automation Beat Count: seleziona il numero di battiti che deve attendere 
l’automazione prima di attivare un nuovo effetto visuale. Vedi ‘Concetti/Comandi di 
riproduzione Deck’ 
 
Slide Show Time: NuVJ permette di trascinare cartelle su di una cella. In tale caso, tutti 
i filmati/immagini/flash posti in tale cartella verranno riprodotti uno di seguito all’altro in 
stile presentazione. Il parametro ‘tempo presentazione’ imposta la durata della 
visualizzazione felle immagini (in secondi) prima della visualizzazione dell’effetto visuale 
che segue nella gerarchia. 
 
Transition 2 & Transition 3: il controller è dotato di un’impostazione a interruttore che 
permette di scegliere al volo tra 3 passaggi. Il primo sarà sempre quello predefinito 
(Exponential Transparency), ma gli altri due sono configurabili. Questi due elenchi 
permettono di decidere quale passaggio si vuole abbinare alle impostazioni ‘2’ e ‘3’ 
dell’interruttore “transition”. 
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Display:  
 

La linguetta display definisce le opzioni relative alla modalità schermo intero. 
  

Full Screen Monitor 
(monitor schermo 
intero): stabilisce quale 
monitor verrà utilizzato in 
modalità schermo intero. 
Scegliendo un’uscita diversa 
dal monitor principale, si 
potrà inviare il mix all’uscita 
alternativa mantenendo 
l’interfaccia utente visibile 
per apportare modifiche e 
per ottenere feedback visivo 
sul monitor predefinito. 
  
Resolution (risoluzione): 
specifica la risoluzione 
impiegata internamente per 
processare tutta la grafica. Più il valore specificato è basso, più i calcoli saranno rapidi (e  
quindi si avrà un migliore frame rate), ma minore sarà la qualità delle immagini. Provare 
diverse impostazioni per trovare il giusto equilibrio tra qualità dell’immagine e frame 
rate. Solitamente, 800x600 è ottimo per i dispositivi di proiezione. 
 
Modalità Exclusive: forza Windows a lavorare in modalità esclusiva In questa modalità, 
le prestazioni sono leggermente migliori, ma si presenta un grosso limite: una volta in 
questa modalità si può utilizzare unicamente il NuVJ. L’attivazione di qualsiasi altro 
programma farà uscire NuVJ dalla modalità schermo intero. Questa modalità non è 
dunque consigliata se si desiderano utilizzare altre applicazioni contemporaneamente al 
NuVJ. 

 
 

Performances (prestazioni):  
 

La linguetta prestazioni permette di sintonizzare alcuni elementi della prestazione in 
modo da ottenere un migliore frame rate. 

 
GPU Level (livello GPU): 
questo primo campo è un 
indicatore della potenza 
dell’hardware grafico. Il 
livello può andare da 0 a 5. 
Sebbene il programma giri 
su tutti questi livelli, si 
raccomanda minimo un 
Livello 2 di GPU per poter 
apprezzare appieno il NuVJ. 
Al di sotto di tale livello, 
alcune funzioni potrebbero 
non essere disponibili, in 
quanto l’hardware non le 
supporta.  
 
Rendering Quality 
(qualità di rendering): questo cursore serve a specificare un livello di qualità per vari 
aspetti del processo di rendering. Esprime il compromesso tra qualità delle immagini e 
velocità di rendering. Se posto all’estrema destra, viene conservata la qualità totale. Se 
all’estrema sinistra, la qualità di vari aspetti (anteprima, processo interno, ecc.) sarà 
degradata e il frame aumenterà grazie ad una minore quantità di processo. Provare 
diverse impostazioni, tenendo a mente che la risoluzione selezionata nella linguetta 
‘Display’ influenzerà automaticamente le prestazioni del sistema. 

 
Disable Contrast/Brightness Control (disattiva comando contrasto/luminosità): 
in caso di hardware lento, si possono disattivare i comandi contrasto/luminosità per 
lasciare spazio alle operazioni di processo principali. 
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Avanzate 
 

Auto purge after 
(cancellazione 
automatica dopo): quando 
un filmato viene importato 
in NuVJ, rimane in memoria 
anche se non viene 
assegnato ad alcuna cella. 
Eliminare filmati inutilizzati è 
importante per evitare che 
riempiano la memoria del 
computer. Questa 
impostazione permette di 
impostare un timer che 
cancelli regolarmente filmati 
inutilizzati. 
 
Auto purge when 
physical memory left reaches (cancellazione automatica quando la memoria 
libera residua raggiunge): questa impostazione permette di cancellare 
automaticamente il filmato inutilizzato quando la memoria fisica del computer diventa 
scarsa. Questa opzione è disponibile solo per PC.  
 
Use Mask and Copy Mode on Deck A (utilizza modalità maschera e copia sul 
Deck A): solitamente, le modalità maschera e copia definite nel pannello dei parametri 
degli effetti sono attive unicamente quando la cella viene riprodotta sul Deck B. 
Attivando questa opzione, si rendono attivi i parametri sul Deck A, il che significa che la 
cella riprodotta sul deck A sarà prima composta con la clip di sfondo servendosi delle 
impostazioni maschera e copia prima di essere inviata al mixer. Combinando questa 
opzione con il fatto che è possibile cambiare lo sfondo trascinando l’effetto visuale 
sull’anteprima master si possono ottenere capacità di mixaggio più avanzate. 
 
Play sound in QuickTime movies (riproduci suono in filmati Quicktime): 
selezionando questa opzione, le tracce sonore dei filmati QuickTime non verranno 
ignorati, consentendo a NuVJ di scratchare contemporaneamente video e audio. 

 
 

Controller: 

 
La linguetta controller contiene opzioni relative all'uso del controller. 

 
Status: mostra lo stato del controller (offline/connesso) 
Firmware: mostra il livello di firmware del controller (disponibile solo se il controller è 
connesso) 
LCD Contrast (contrasto LCD): permette di impostare il contrasto LCD del controller. 
Una volta impostato, il valore del contrasto viene salvato nel controller e viene 
richiamato ogni volta che 
viene utilizzato il 
controller. 
Scratch sensitività 
(sensibilità scratch): 
imposta la sensibilità 
della rotella jog in 
modalità scratch. 
Slide Sensitivity 
(sensibilità del 
cursore): imposta la 
sensibilità delle rotelle 
jog quando vengono 
utilizzate senza premere 
il tasto scratch (‘bend del 
pitch’). 
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CONSIGLI SULLE PRESTAZIONI 
 

 
 
 
 
 
 
 
 
 
Ottenere buone prestazioni con i video può essere difficile perché la qualità dipende da molti fattori diversi.  
 
I fattori più importanti sono: 

 
• velocità CPU  
• velocità disco 
• velocità di accesso RAM  
• velocità hardware video & video bus  
• compressione dei filmati 

 
Non vi è un modo semplice per dare una risposta definitiva su cosa è meglio per ciascuna impostazione 
informatica. Nel NuVJ, la maggior parte del processo della grafica avviene a livello dell’hardware video, 
quindi, più è potente, migliori saranno le prestazioni ottenute. La CPU serve principalmente a decomprimere 
frame di filmati dal disco e a inviarli alla scheda video. Più i dischi fissi sono veloci, più le immagini verranno 
caricate velocemente nella memoria; inoltre, più la CPU è veloce, più i frame saranno decompressi 
velocemente. Per ottenere un buon frame rate con un determinato hardware, si può: 
 
• Adattare la risoluzione della computazione interna. Vedi (Preferenze/Display) 
• Servirsi del cursore prestazioni per trovare un equilibrio tra qualità e prestazioni in base all'hardware 

a disposizione. 
• Servirsi di materiale sorgente adatto al proprio hardware. In caso di un disco lento o di un hardware 

di vecchia generazione, provare a lavorare con sorgenti video più piccole per minimizzare l’impatto 
del caricare e decomprimere il filmato. Poiché tutti i calcoli hanno luogo all’interno dell’hardware 
video, gli effetti di distorsione grafica saranno minimizzati dal filtraggio automatico applicato quando 
le immagini vengono portate in scala alla risoluzione finale. 

 

Compressione del filmato 
 

Oltre alla dimensione del filmato, lo schema di compressione ha un notevole impatto sia sulla fluidità della 
visualizzazione che sulla riproducibilità. Più lo schema di compressione è complesso, più il processore dovrà 
lavorare per recuperare frame specifici, risultando in prestazioni lente. Oltre al metodo di compressione 
stesso, vi è il problema dei frame chiave. I meccanismi di compressione più diffusi lavorano servendosi di 
metodi incrementali: ciò significa che costruiscono un frame salvando la differenza tra un frame e quello 
precedente. Per evitare che il processo devii troppo dal materiale originale, salvano un frame originale di 
tanto in tanto, ed iniziano nuovamente a codificare informazioni incrementali da quel frame in poi. Questi 
frame originali sono chiamati ‘frame chiave’. L’impiego di un numero di frame chiave limitato significa che 
affinché il NuVJ abbia accesso ad un determinato frame, dovrà trovare il frame chiave precedente e 
processare tutte le differenze intermedie fino a raggiungere quella desiderata. Come si può immaginare, 
questo procedimento è piuttosto lento e impedisce un rapido accesso ai frame, che è molto importante per 
la riproduzione inversa o per lo scratch. Ecco perché schemi di compressione quali mpeg o DivX non sono 
adatti a prestazioni video. 
 

 
 
 
 
 
 
 

Uso della memoria 
 

I filmati occupano parecchia memoria. A seconda delle loro dimensioni e lunghezza possono occupare molto 
spazio e in breve tempo. Quando un file viene importato in NuVJ, viene conservato in memoria anche se non 
viene assegnato ad alcuna cella. Perciò si può utilizzare il browser ‘visual’ per cercare file che sono già stati 
caricati senza doverli cercare e caricare nuovamente. Quando la memoria del computer sta per riempirsi, le 
prestazioni possono peggiorare, è quindi importante non perdere di vista questo fattore. Per eliminare 
filmati inutilizzati dal software è necessario cancellarli. Questo può essere fatto in diversi modi: 

1.  Eliminando manualmente i filmati servendosi del menu ‘Edit/Purge Visuals’ 

2. Servendosi della funzione automatica, che può essere attivata nella finestra Preferenze/Advanzate. La 
funzione auto-purge consente di scegliere un tempo o una soglia di memoria che, una volta raggiunti, 
eliminerà automaticamente i filmati inutilizzati dalla memoria del computer. Per maggiori informazioni su 
tale funzione, far riferimento al paragrafo Preferenze del manuale. 
 

È molto importante sottolineare che famosi schemi di compressione sono inefficienti 
per l’uso del VJ. I file video che impiegano questi schemi di compressione si 
comporteranno correttamente se utilizzati a velocità nominale (100%), ma saranno 
molto lenti se se ne modifica la velocità o se vengono scratchati. Questa nota vale per 
codec mpeg, divx e DV, tra gli altri. Se si utilizzano, si otterranno scarse prestazioni 
dal software

In base alla nostra esperienza, la migliore soluzione di compressione per le 
prestazioni video è l’uso di Photo JPEG di QuickTime con 

un’impostazione di qualità di circa 80% o più. Ciò garantirà una 
riproduzione perfetta, uno scratch efficace e dimensioni dei file accettabili. 
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EINFÜHRUNG 
 

 
Willkommen zum NuVJ!  NuVJ ist eine intuitive VJ Produktionsumgebung, die nahtlos angepasste Hard- und 
Software für eine professionelle Performance vereint.  Die NuVJ Umgebung integriert ein DJ-typisches Setup, 
welches das Mixen, Scratchen sowie das Einbinden von Effekten auf Videoclips und Bildern erlaubt. Um 
beispiellose Variationsmöglichkeiten und die Ihre Kreativität beim Umgang mit Ihren visuellen Quellen zu 
unterstützen, wurde Software und Hardware des NuVJs leicht anwendbar gestaltet.  Die vielen ausgefeilten 
Funktionen, wie Live Eingänge, Synchronisation zur Musik und die Echtzeiteffekte geben uns Hoffnung, dass 
Sie bei der Verwendung dieses Produkts genauso viel Spaß haben werden, wie wir ihn bei der Entwicklung 
hatten! 
 
Mit freundlichen Grüßen, 
 
Die Mitarbeiter von Numark und Arkaos 
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ÜBERBLICK ÜBER DEN CONTROLLER  

 
Die wichtigsten Funktionen der NuVJ Software lassen sich leicht und schnell über den NuVJ Controller 
ansprechen.  Obwohl dieser speziell zur Steuerung der NuVJ Software entworfen wurde, kann er auch als 
universeller MIDI Controller für zahlreiche andere Softwareprogramme und Geräte, die das MIDI Protokoll 
unterstützen, verwendet werden.   
 

Hinweis:  Der NuVJ Controller wurde für die Verwendung mit der NuVJ Software extra entworfen.  
Er kann aber auch für zahlreiche andere Programme, die MIDI Befehle unterstützen, als 
universeller MIDI Controller eingesetzt werden. Wenn Sie den NuVJ Controller mit einer anderen 
Software einsetzen, wird Ihnen auffallen, dass einige Funktionen des Controllers nicht zur 
Verfügung stehen.  So sind, beispielsweise, die Pads und Tasten nicht beleuchtet.  Das ist normal, 
der Controller funktioniert trotzdem richtig.  

 
Innerhalb dieser Anleitung erklären wir den Einsatz des Controllers ausschließlich in Zusammenhang mit der 
NuVJ Software.  Beachten Sie auch die Abschnitte “Softwareeinführung” sowie “Verwendung der Software”, um 
weitere Informationen zur Software zu erhalten.  
   

Oberseite 
 

 

 
 

1. PADS: Die 9 Pads auf jeder Seite des Controllers definieren, welcher ‘Clip’ in jeder ‘Deck 
Zone’ angezeigt wird. Das Anschlagen eines Pads triggert den Clip, der zur jeweiligen ‘Zelle’ 
in der Software zugewiesen ist.  Weitere Informationen zu Clips, den Zellen und den Decks 
finden Sie im Abschnitt Softwareeinführung. 

2. RÄDER: Die Räder auf jeder Controller Seite dienen zum Scratchen oder zur 
Geschwindigkeitsänderung des gegenwärtig abgespielten Videos.  Wenn Sie die unter dem 
Rad liegenden [SCRATCH] Taste drücken, wird das Video gescratcht.  Wird diese Taste nicht 
gehalten, verwenden Sie das Rad, wie eine Pitch Bend Funktion,  zum zeitweiligen 
Beschleunigen oder Abbremsen des Videotempos. 

3. SPEED: Diese zwei vertikalen Schieberegler in der Mitte definieren die Geschwindigkeit der 
Videowiedergabe und ermöglichen so das Video jeder Deck Zone abzubremsen, zu 
beschleunigen oder rückwärts wiederzugeben. 
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4. [SCRATCH]: Wird diese Taste gehalten, kann das Rad zum Scratchen des im Deck 
abgespielten Videos verwendet werden.  

5. [INSTA A/B]: Mit Hilfe dieser Tasten können Sie den Videoausgang schnell zu einem der 
beiden Decks umschalten.  Wenn Sie zum Beispiel [INSTA A] drücken, liegt am 
Videoausgang, unabhängig von der Crossfader Position, nur das vom Deck A gespielte Video 
an, bis Sie die [INSTA A] Taste loslassen.  Die Überblendungsgeschwindigkeit beim Drücken 
der [INSTA A/B] Tasten wird mit dem Auto Fade Speed Regler bestimmt. 

6. BANK: Mit diesem Regler wählen Sie die verschiedenen Bänke der Video Clips an.  Jede Bank 
enthält bis zu 9 Clips, die durch Drücken des dazugehörigen Pads getriggert werden.  
Sechzehn verschiedene Bänke können entweder für eines oder beide Deck Zones verwendet 
werden. 

7. PMTR1: In der Software lässt sich jede Zelle einer Bank mit einem Effekt belegen. Der 
PMTR1 Regler justiert dann den ersten Effektparameter der gerade abgespielten Zelle einer 
Bank.  Je nach Effekt kann dieser Parameter verschieden sein. 

8. PMTR2: Der PMTR2 Regler justiert den zweiten Effektparameter der gerade abgespielten 
Zelle einer Bank.  Je nach Effekt kann dieser Parameter verschieden sein. 

9. [LATCH]: Wenn die [LATCH] Taste aktiviert wurde, werden die Clips eines Decks nach dem 
Triggern fortwährend abgespielt. Wird die [LATCH] Taste deaktiviert, werden die Clips eines 
Decks nur solange abgespielt, wie das dazugehörende Pad gedrückt wird. 

10. [AUTO]: Wenn Sie diesen Button drücken, werden die Clips der gegenwärtigen Bank in 
zufälliger Reihenfolge abgespielt.  

11. [SYNC]: Drücken Sie diese Taste, um die Wiedergabegeschwindigkeit des Videos mit dem 
BPM Tempo der Session zu synchronisieren. 

12. DISPLAY: Das Display hilft dabei, Softwareparameter zu überwachen.  

13. FX LEVEL: Dieser Regler definiert den Master FX Mix.  Sie bestimmen somit, wie viel 
Effektanteil des gewählten Master Effekts zum Originalbild hinzugemischt wird.  Wenn Sie 
den FX Level Regler aufdrehen, sehen Sie den Effekt im Mix stärker.  Wird der Regler 
zugedreht, sehen Sie mehr vom Originalbild.  

14. [MASTER FX]: Zur Aktivierung oder Deaktivierung des Master Effekts drücken Sie diese 
Taste.  Effekte lassen sich mit dem Master FX Regler im laufenden Betrieb auswählen.    

15. MASTER FX: Drehen Sie diesen Regler zur Auswahl eines Master Effekts.  Der Master Effekt 
wird in der Master Mixing Zone hinzugefügt.   

16. PMTR1: Dieser Regler ändert den ersten Parameter des Master Effekts.  Je nach gewähltem 
Effekt steuert dieser Regler einen anderen Parameter.  

17. [INSTA BLACK]: Durch Drücken dieser Taste schalten Sie den Videoausgang auf ein 
schwarzes Bild oder auf ein in der NuVJ Software definierten Hintergrund um.  

18. CONTRAST: Verwenden Sie diesen Regler, um den Kontrast des Videoausgangs einzustellen.  

19. PMTR2: Dieser Regler justiert den zweiten Master Effekt Parameter. Je nach gewähltem 
Effekt steuert dieser Regler einen anderen Parameter.  

20. [BPM TAP]: Das Tempo der Session lässt sich manuell bestimmen, indem Sie zum Beat der 
Musik diese Taste drücken.  Wenn Sie die Taste 3 Sekunden lang gedrückt halten und dann 
loslassen, ändert sich das BPM Tempo der Session zum von Soundeingang erkannten Tempo. 

21. BRIGHT: Mit diesem Regler stellen Sie die Helligkeit des Videoausgangs ein. 

22. CROSSFADER: Mit dem Crossfader mixen Sie die Visualisierungen, die auf jeder Seite 
wiedergegeben werden.  Wenn Sie den Crossfader nach rechts bewegen, sehen Sie 
überwiegend die rechte Bildquelle. Im Gegensatz dazu sehen Sie mehr von der linken 
Visualisierung, wenn der Crossfader nach links geschoben wird.  
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Rückseite 
 

 

 

 

1. NETZTEILANSCHLUSS: Wenn das Gerät nicht über die USB Verbindung mit Spannung 
versorgt wird, können Sie das Gerät mit einem 6V-1A DC Netzteil, das hier angeschlossen 
wird, betreiben. 

2. POWER: Drücken Sie diese Taste, wenn Sie das Gerät mit einem Netzteil betreiben möchten. 
Bei einer USB Verbindung erfolgt die Netzspeisung über den USB Bus des Computers.  

3. USB: Verbinden Sie ein USB Kabel vom Computer zu diesem Eingang.  Über diesen USB Port 
erfolgt die Versorgung mit der Betriebsspannung sowie die Übertragung der MIDI Daten zum 
Computer und der Software.  Sie können den Controller alternativ auch mit einem 
Netzadapter betreiben. 

4. KENSINGTON LOCK: Das Gerät lässt sich über den Kensington Lock Slot mit einem festen 
Gegenstand gegen Diebstahl sichern. 

   

Vorderseite 
 

 

 
 
1. FADER MODE: Dieser Schalter definiert die Funktionalität der Fader Start Option, die in der 

Software definiert wird. 

2. AUTO FADE SPEED: Dieser Schalter regelt die Geschwindigkeit der Auto Fade Funktion. Die 
Auto Fade Geschwindigkeit bestimmt die Geschwindigkeit, mit der das Signal A zum Signal B 
übergeblendet wird, wenn die INSTA A/B Tasten der Oberseite verwendet werden.  

3. FADER START: Fader Start ermöglicht den Start eines gewählten Pads durch Bewegung des 
Crossfaders zum  jeweiligen Deck.  Wenn zum Beispiel der Crossfader äußerst links oder 
rechts steht, wird durch die Bewegung des Crossfaders zur anderen Seite das in diesem Deck 
geladene Video getriggert.  
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ANSCHLUSS DES CONTROLLERS AN DEN COMPUTER 
 

 

 

 

Zum Anschluss des NuVJ an den Computer, verbinden Sie bitte das mitgelieferte USB Kabel vom 
USB Port des NuVJs mit einem freien USB Port Ihres Computers.  Einen zusätzlichen Netzadapter 
benötigen Sie nicht – die USB Bus Spannung Ihres Computers versorgt den Controller mit Strom. 
Wenn Sie jedoch einen externen Adapter verwenden möchten, schließen Sie diesen an den 
Netzteilanschluss des Gerätes an (6V 1A)  

Der NuVJ ist ein Plug und Play Gerät. Sie müssen also keine Treiber oder sonstige Spezialsoftware 
installieren.  Beim Anschluss des Controllers leuchtet das Display auf und zeigt “NuVJ” an.  

 
Hinweis: Bei der Verwendung des NuVJ Controllers mit einer anderen Software werden 
einige Funktionen des Controllers deaktiviert. Davon betroffen sind die LEDs als auch 
die Werteanzeige im Display.  Dieses zeigt nur “NuVJ” an. 
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INSTALLATION DER SOFTWARE - PC 
 

 
 

1. Legen Sie die NuVJ Installations-CD in das CD-ROM Laufwerk Ihres Computers. 
2. Klicken Sie die NuVJ Installationsdatei im Hauptverzeichnis der CD doppelt an, um den 

Installationsassistenten zu starten.  
3. Befolgen Sie die Anweisungen im Bildschirm.   

Hinweis:  Das Installationsprogramm durchsucht vor der Softwareinstallation den Computer nach 
verfügbaren Videokomponenten.  Sollten Komponenten, die nicht aktuell sind, gefunden werden, 
installieren Sie diese, indem Sie die dazugehörige Taste drücken. Fahren Sie erst danach mit der 
Installation fort. 

4. Nachdem die Installation abgeschlossen ist, klicken Sie auf “Finish”.  Die NuVJ Software kann nun 
verwendet werden. 

5. Achten Sie darauf, dass der Controller mit dem USB Port des Computers verbunden ist und starten 
Sie NuVJ, indem Sie auf Start -> Arkaos NuVJ -> Arkaos NuVJ gehen. 
Hinweis:  Wenn der Controller nach dem NuVJ Programmstart angeschlossen wird, könnte er nicht 
funktionieren. Dann sollten Sie die Software beenden und neu starten.  Achten Sie immer darauf, 
dass Sie den Controller vor dem Starten der Software anschließen. 

6. Geben Sie die 16-stellige Seriennummer Ihres NuVJs ein. 
7. Nach der richtigen Eingabe der Seriennummer haben Sie die Möglichkeit, über das Internet Ihre 

NuVJ Kopie zu registrieren. Durch die Registrierung erhalten Sie Zugriff auf Zusatzfeatures, die nur 
im Internet zur Verfügung stehen sowie auf Programmupdates. 

 
 

 

INSTALLATION DER SOFTWARE - MAC 
 

 
 

1. Legen Sie die NuVJ Installations-CD in das CD-ROM Laufwerk Ihres Computers. 
2. Klicken Sie den NuVJ Installer auf der CD an. 
3. Befolgen Sie die Anweisungen im Bildschirm. 
4. Nach der Beendigung der Installation finden Sie eine Programmverknüpfung auf dem Schreibtisch.  

Das Programm finden Sie zudem im Programme -> NuVJ Ordner. 
5. Achten Sie darauf, dass der Controller mit dem USB Port des Computers verbunden ist und starten 

Sie NuVJ. 
Hinweis:  Wenn der Controller nach dem NuVJ Programmstart angeschlossen wird, könnte er nicht 
funktionieren. Dann sollten Sie die Software beenden und neu starten.  Achten Sie immer darauf, 
dass Sie den Controller vor dem Starten der Software anschließen. 

6. Geben Sie die 16-stellige Seriennummer Ihres NuVJs ein. 
7. Nach der richtigen Eingabe der Seriennummer haben Sie die Möglichkeit, über das Internet Ihre 

NuVJ Kopie zu registrieren. Durch die Registrierung erhalten Sie Zugriff auf Zusatzfeatures, die nur 
im Internet zur Verfügung stehen sowie auf Programmupdates. 
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SOFTWARE EINFÜHRUNG 
 

 
In diesem Abschnitt nehmen wir Sie mit auf eine kurze Tour durch die Softwarefunktionen und erklären Ihnen 
die grundlegenden Vorgehensweisen bei der Bedienung des Programms.  Wir empfehlen Ihnen, diesen 
Abschnitt aufmerksam zu lesen – Sie erhalten einen umfassenden Überblick über die NuVJ Möglichkeiten und 
Sie erlernen nebenbei einige Techniken zum Video Mixing.  
 

Grundlagen 
 

 
NuVJ ermöglicht sehr intuitive das Mixen von Videos und Bildern in Echtzeit. Der DJ-Deck artige 
Aufbau der Software enthält zwei Wiedergabedecks. Die Ausgänge der Decks lassen sich mit einem 
Schieberegler mischen. 

 

              

 Movie A Movie B

Video 
Mixer 

Output

 
 
 

Dieser Aufbau findet sich sowohl in der Software- als auch in der Controlleroberfläche wieder: Deck 
A befindet sich im linken Bereich der Hauptansicht und Deck B im rechten Bereich. In der Mitte 
finden Sie Mixer und Master Effekt Regler, wie die folgende Abbildung zeigt: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
In jeder Deck Zone erkennen Sie eine Reihe von Rechtecken.  Diese werden ‘Zellen’ genannt und 
sind die Platzhalter für Video Clips, Bilder oder Flash Dateien (wir werden ab jetzt übergreifend von 
‘Clips’ reden).  Jedes Deck kann eine Zelle wiedergeben. 

 
Um einer Zelle einen Clip zuzuweisen, ziehen Sie ihn mit der Maus einfach aus dem an der linken 
Seite zugänglichen Browser oder vom Explorer/Finder auf eine Zelle. Danach können Sie den Clip 
abspielen, indem Sie die Zelle mit der Maus anklicken oder das dazugehörige Pad am NuVJ 
Controller drücken.  Wenn Sie eine Zelle in jedem Deck triggern, sehen Sie im jeweiligen 
Vorschaufenster das Video spielen. Im zentralen Fenster sehen Sie das Ergebnis des Mixings. 
Bewegen Sie den Crossfader der Software mit der Maus oder den Crossfader des Controllers, um 
zu sehen, wie  sich die Balance beider Signale im Vorschaufenster ändert.   
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Vollbild 
Bei einer Performance kann es notwendig sein, dass der Ausgang in voller 
Auflösung angezeigt wird.  Dazu müssen Sie den Vollbildmodus /Full Screen 
Mode) in der Softwareoberfläche aktivieren. Klicken Sie dazu auf Display > 
Toggle Fullscreen oder drücken Sie STRG+A (BEFEHL+A am Mac) auf der 
Computertastatur.  Zum Verlassen des Vollbildmodus drücken Sie noch 
einmal STRG+A. Wie Sie später sehen werden (siehe Voreinstellungen / 
Display), können Sie, falls Ihre Videokarte mehrere Videoausgänge besitzt, 
sich die Softwareoberfläche auf dem Hauptbildschirm und die Vollbildansicht 
auf einem zweiten Monitor ansehen. 
 

 
 

Überblick 
 

 
Wie wir nun bereits wissen, ist der Aufbau des NuVJ ein einfaches A/B Deck & Mixing Setup.  Nun 
wollen wir auf die Funktionen ein bisschen näher eingehen.  
 

Decks:  

Wie bereits angesprochen stellen Decks die Quellen für die 
Videos dar. Sie enthalten Zellen, die als Platzhalter für 
Clips dienen. Wenn Sie eine Zelle in einem Deck triggern, 
sehen Sie eine Vorschau des Films/Bildes im oberen 
Vorschaufenster des Deck Bereiches. In einem Deck kann 
nur jeweils der Inhalt einer Zelle wiedergegeben werden. 
Die gerade abgespielte Zelle wird in der Software rot 
hervorgehoben. Eine LED am Controller zeigt ebenfalls an, 
dass der Inhalt der Zelle abgespielt wird. 

Zellen (Cells):  
 
Zellen sind Platzhalter, in die Sie Ihre im Mix zu 
verwendenden Clips ablegen.  Zusätzlich dazu enthalten 
Zellen auch mit einem Effekt verknüpft werden, der 
automatisch auf den Clip, der geladen wurde, angewandt 
wird. Zur Zuweisung eines Effekts ziehen Sie diesen aus 
dem Effects Browser auf die gewünschte Zelle. Wird eine 
Zelle mit einem Effekt getriggert, werden zwei Regler im 
oberen Zellenbereich aktiviert, die das Justieren der 
Effektparameter ermöglichen. Diese lassen sich entweder 
mit der Maus in der Softwareoberfläche oder mit den zwei 
Effekt Parameter Reglern (PMTR1 und PMTR2) auf jeder 
Seite des Controllers einstellen.  In der linken Abbildung, 
zum Beispiel, wurde ein direktionaler Weichzeichner mit 
der linken oberen Zelle verknüpft. Die beiden Parameter 
LEVEL und DIRECTION sind nun zur Justierung aktiviert.  
Wurde eine Zelle mit der Maus ausgewählt (Rechtsklick) 
oder wird sie wiedergegeben (Linksklick) wird eine Ansicht 
mit erweiterten Zelle Parametern im unteren 
Displaybereich angezeigt und aktualisiert. Hier lassen sich 
Parameter zur Wiedergabe und zum Mixing sowie die 
Grundparameter des Effekts beim Triggern der Zelle 
definieren. Für ‘Text Files’ lässt sich hier zudem der Test anzeigen und verändern.  Auf die Zelle Parameter 
gehen wir später in dieser Anleitung noch genauer ein.  

 

Dateien (Files):  
 
Dateien sind das Quellmaterial, welches in den Zellen abgespielt 
wird. Direkt vom Explorer/Finder lassen sich die Dateien mit der 
Maus in Zellen ziehen. Sie können aber auch zur Auswahl von 
Clips den NuVJ File Browser (links in der Softwareoberfläche) 
verwenden.  NuVJ unterstützt sehr viele Video-, Bild- und Flash 
Dateiformate. Beachten Sie bitte dazu auch die Performance 
Tipps am Ende der Anleitung, in denen wir die verschiedenen Dateiformate und ihre Effizienz erklären. 
Zusätzlich zur Wiedergabe unterschiedlicher Dateien lässt sich auch ein Ordner auf eine Zelle ziehen – NuVJ 
spielt dann alle im Ordner enthaltenen Videos nacheinander wie in einer Slideshow ab.  
 

Hinweis: Zur Speicheroptimierung werden aus Ordner wiedergegebene Dateien nicht 
vorgespeichert. Deshalb ist das Umschalten von einem Clip zum nächsten nicht so flüssig, als 
wenn Sie einzelne Dateien des Ordners direkt triggern würden.  

                                   DECK 

 

 

 

 

 

 

 

 

   ZELLE 



 

91 

Effekte (Effects):  
 
Effekte lassen sich zur Clip Veränderung auf verschiedene 
Weisen einsetzen. NuVJ bietet eine große Auswahl 
verschiedener Effekte, die in mehrere Kategorien unterteilt sind. 
Sie finden die Effekte im zweiten Tab des Browser Bereiches. 
Effekte lassen sich mit Zellen verbinden, um einen einzelnen 
Clip zu bearbeiten oder auf den Master Ausgang legen, damit 
der Mix verändert wird. Beachten Sie, dass, je nach den 
Möglichkeiten Ihrer Video Hardware, möglicherweise nicht alle 
Effekte verwendet werden können, da einige Effekte High End 
Video Hardware voraussetzen. 
 
 
Quellen (Sources):  
 
Quellen können wie Clips verwendet werden. Jedoch sind 
Quellen keine Dateien auf der Festplatte. Die Quellen, die unter 
dem dritten Tab im Browser gelistet werden, lassen sich in drei 
Kategorien einteilen: Live Eingänge, Generatoren sowie Text.  
Live Eingänge vereinen alle verfügbaren Kameraeingänge des 
Systems.  Bei der Verwendung können Sie NuVJ direkt mit 
Signalen Ihrer USB oder Firewire Webkameras, DV-Kameras, 
und anderen Videogeräten versorgen. Die Inputs Kategorie zeigt 
alle durch das System erkannte Live Eingänge an. Generatoren 
sind Elements, die automatische Muster erzeugen. Dazu werden die internen Effekte und das Signal vom 
Audioeingang verwendet. Generatoren lassen sich mit den Visualisierungsmodulen von iTunes oder  dem 
Windows Media Player vergleichen.  Um eine Quelle mit einer Zelle zu verknüpfen, ziehen Sie diese einfach 
auf die gewünschte Zelle. Die dritte Kategorie ‘Texts’ enthält spezielle Dateien, die zur Anzeige von Texten 
in Präsentationen, Ankündigungen und so weiter verwendet werden können. 

 
VERWENDUNG DES AUDIO EIGANGS:   

 

NuVJ kann Ihre Video Clips und Performances zum Signal des Audio Eingangs synchronisieren. Zur 
Verwendung dieser Funktion verbinden Sie bitte eine Audioquelle zum Linepegel Eingang Ihrer 
Computer Soundkarte.  Nun müssen Sie den Linepegeleingang als Eingangsquelle auswählen.   

PC: Gehen Sie auf Mein Computer -> Systemsteuerung -> Sounds und Audiogeräte, klicken Sie auf 
den Audio Tab und dann auf Erweitert – die Einstellung für die Lautstärke öffnet sich. Klicken Sie auf 
Optionen -> Einstellungen -> Aufnahme – es wird Ihnen der Aufnahme-Eingang angezeigt.  
Überprüfen Sie, dass Line In aktiviert ist und der Lautstärkefader aufgezogen ist. 

Um den Audioeingang über die Soundkarte des Computers abhören zu können, müssen Sie zurück zu 
Optionen -> Einstellungen -> Wiedergabe gehen und darauf achten, dass der Line In nicht stumm 
geschaltet ist und der Lautstärkefader aufgezogen ist.  

Bei einigen Soundkarten können Sie den Ausgang der Karte als Aufnahmegerät auswählen. Dazu wird 
im Allgemeinen die Aufnahmequelle ‘Stereo Mix’ angezeigt.  Wenn Ihre Karte solch einen Kanal 
besitzt, können Sie durch seine Auswahl NuVJ zum Audiosignal, welches der PC abspielt 
synchronisieren.  

MAC: Gehen Sie zum Finder -> Einstellungen -> Systemeinstellungen und klicken Sie auf das Ton 
Symbol.  Wählen Sie Eingang, um alle verfügbaren Eingangsquellen anzuzeigen.  Wählen Sie das 
Gerät, welches Sie als Eingangsgerät verwenden möchten. Nach der Auswahl synchronisiert NuVJ die 
Session zum Tempo des Audiosignals. 

 
Die Visuals Bibliothek:  
 
Die Visuals Bibliothek stellt eine einfache Möglichkeit dar, Clips, 
die bereits in das Programm geladen wurden, zu finden. 
Nachdem Sie einen Clip in NuVJ geladen haben, wird er in der 
Visual Bibliothek verfügbar. Sie können jederzeit innerhalb der 
Session auf den Clip zugreifen. Die Bibliothek befindet sich im 
vierten Tab des Browser Bereiches. Clips lassen sich direkt aus 
dem Bibliotheksbereich auf die Zellen ziehen, ohne dass Sie 
diese noch einmal auf der Festplatte suchen müssen. 
 
Bänke:  
 
Bänke bestehen aus neun Zellen.  In jedem Deck 
ist immer eine Bank ausgewählt.  Die aktuelle 
Nummer der Bank wird im blauen Bereich unter 
dem Vorschaufenster des Decks wiedergegeben.  
Sie können zwischen Bänken wechseln, indem Sie 
die AUF oder AB Pfeile drücken oder den BANK 
Regler des Controllers drehen.  Mit Hilfe der Bänke 
können Sie Ihre Clips nach Themen, Stimmung, 
oder Art der Clips organisieren. 
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Deck Wiedergabesteuerung:  
 
Neben der Bankauswahlanzeige finden Sie Bedienelemente, mit denen Sie die Wiedergabe des Zellinhalts 
eines Decks beeinflussen können.  

 
Die obere Anzeige verdeutlicht die Wiedergabeposition des gegenwärtig gespielten Clips.  
 
Die untere Anzeige steuert die Abspielgeschwindigkeit des Clips.  In der Mittelposition wird der Clip 
mit der Geschwindigkeit 0 abgespielt (der Clip wird angehalten). Befindet sich der Markierungspunkt 
im rechten Bereich wird der Clip vorwärts, bei einer Position im linken Bereich rückwärts abgespielt. 
Je weiter Sie sich von der mittleren Position entfernen, umso schneller wird der Clip gespielt. Zur 
Änderung der Wiedergabegeschwindigkeit über das Softwareinterface, klicken Sie einfach in das Feld, 
um die Markierung an den gewünschten Punkt zu bringen. Darüber hinaus können Sie die 
Abspielgeschwindigkeit mit den SPEED Schiebereglern am Controller einstellen. Ein vertikaler Balken 
in der Geschwindigkeitsanzeige zeigt die Geschwindigkeit, mit der der Clip gegenwärtig abgespielt 
wird. Wird die Geschwindigkeit nahe der Normalgeschwindigkeit eingestellt, leuchtet die 
Geschwindigkeitsanzeige rot.  
 
 
 
 
 
 
 
 
Die [LATCH] Taste beeinflusst die Reaktion der Zelle beim Drücken eines Pads oder einer Zelle. Ist sie 
aktiviert, spielt der Clip weiter, nachdem Sie die Zelle oder das Pad loslassen. Wenn die Taste nicht 
aktiv ist stoppt der Clip der Zelle, wenn Sie diese oder das dazugehörige Pad am Controller loslassen. 
Diesen Modus können Sie auch mit der LATCH Taste auf der Oberfläche des Controllers 
aktivieren/deaktivieren.  
 
Mit der [SYNC] Taste ermöglichen Sie die ‘synchronisierte Wiedergabe’ für Clips.  Bei Aktivierung 
verwendet NuVJ das BPM Tempo des Audioeingangs, um die Clipgeschwindigkeit anzupassen.  Sie 
können den Sync Modus am Controller mit der dazugehörigen Taste aktivieren. Trotz aktivierter 
Synchronisation kann die Abspielgeschwindigkeit eines Filmes immer noch mit den SPEED 
Schiebereglern verändert werden. 
 
Die [AUTO] Taste schaltet den automatischen Modus für das Deck ein.  Im automatischen Modus 
triggert NuVJ automatisch, dem vom Audio Eingang erkannten BPM Tempo folgend, Zellen der 
gegenwärtigen Bank nach dem Zufallsprinzip.  Diese Funktion ermöglicht Ihnen eine kleine Pause bei 
der Performance. Sie können damit automatisch Clips überblenden lassen. 

 
Der Crossfader:  
 
Der Crossfader befindet sich in der Mitte der 
Softwareoberfläche. Sie können unter Verwendung der Maus 
oder des Crossfaders am Controller den Schieberegler dazu 
verwenden, Ihre Clips überzublenden.  Befindet sich der 
Crossfader äußerst links, wird nur der Ausgang des Deck A 
gesehen. Auf der äußerst rechten Seite wird ausschließlich der Ausgang des Deck B zu sehen sein. Steht der 
Crossfader auf der Mittelposition werden beide Decks gemäß des gewählten ‘Übergangs (Transition)’ 
zusammengemischt.  Zur Auswahl einer Transition Kurve, klicken Sie den Crossfader mit der echten 
Maustaste an und wählen einen der verfügbaren Übergänge.  Der Controller besitzt außerdem einen FADER 
MODE Schalter auf der Vorderseite, mit dem Sie zwischen drei verschiedenen vordefinierten 3 Transition 
Kurven umschalten können.  Weitere Informationen zur Definition der Übergänge finden Sie im Abschnitt 
Voreinstellungen. 
 
Der Master Effekt:  
 
Der Master Effekt ist ein zusätzlicher Effekt, der sich dem Ausgang 
des Mixes zuweisen lässt.  Der Master Effekt lässt sich entweder 
über die Oberfläche der Software oder mit dem MASTER FX Regler 
des Controllers auswählen.  Jeder Effekt bietet bis zu zwei 
anpassbare Parameter, auf die mit den PMTR1 und PMTR2 Reglern 
des Controllers zugegriffen werden kann. Der FX LEVEL (Master FX 
Mix) Regler ermöglicht es festzulegen, welcher Prozentsatz des  
bearbeiteten Bildes am Ausgang letztendlich zu sehen sein wird.  
Sie können den Master Effekt umgehen (Bypass), indem Sie die 
MASTER FX Taste am Controller drücken. 
 
Helligkeit/Kontrast Regler:  
 
Bevor ein Clip den Main Ausgang verlässt, können Sie seine 
Helligkeit und den Kontrast einstellen, um das Bild den 
Raumlichtumständen anzupassen oder um Artefakte, die 
durch übermäßige Bearbeitung und Überblendungen 
entstanden sind, auszugleichen. Die Kontrast- und 
Helligkeitseinstellungen können entweder über die Softwareoberfläche oder am Controller mit den 
CONTRAST und BRIGHT Reglern vorgenommen werden.  Wenn Sie diese Funktionen nicht verwenden, 
können Sie diese im Voreinstellungsdialog deaktivieren – dadurch sparen Sie CPU Leistung ein, durch die 
Ihre Performance stabiler wird.  

Bitte beachten Sie, dass die Qualität des Clips bei 
nichtdurchschnittlicher Geschwindigkeit von der Art des Clips und der 
Kompressionsrate des Clips abhängt.  Weitere Informationen hiuerzu 
finden Sie im Abschnitt Performance Tipps dieser Anleitung. 
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Erweiterte Funktionen 
 

 
Hintergrund (Background):  
 
NuVJ ermöglicht es, einen Hintergrundclip wiederzugeben, der angezeigt wird, wenn auf beiden Decks kein 
Clip abgespielt wird oder wenn die [INSTA BLACK] Taste des Controllers gedrückt wird. Der Hintergrund Clip 
wird im Voreinstellungsdialog unter File > Preferences definiert und kann im laufenden Betrieb geändert 
werden. Ziehen Sie dazu einfach einen Clip auf das Master Vorschaufenster. In den Voreinstellungen können 
Sie auch die Verwendung der Kopier & Blending Modi (siehe unten) zwischen Deck A und dem Hintergrund 
definieren.  Diese Option ist in der Grundeinstellung nicht aktiviert, um Verwirrungen zu vermeiden. 
 
Zellenparameter und erweiterte Mixingfunktionen:  
 
Beim Anklicken einer Zelle mit der Maus oder durch Triggern einer Zelle mit den Pads des Controllers wird 
das Zellenparameterdisplay im unteren Bereich der Softwareoberfläche aktualisiert und zeigt die 
Einstellungen der aktuellen Zelle an. Um die Parameter einer Zelle anzupassen, ohne dass sie getriggert 
wird, klicken Sie die Zelle mit der rechten Maustaste an. Die Parameteranzeige enthält erweiterte Optionen, 
die Sie beim Mixen und bei der Performance gewinnbringend einsetzen können.  Um diese Optionen besser 
erläutern zu können, stellen wir uns vor, dass wir zwei Bilder zusammenmixen wollen:  

 
Deck A: 

 
 

 
Deck B: 

 

 
Kopier (Copy) Modi:  
 
Die Copy Modi erweitern die Art und Weise, wie Zellen der Decks A & B im Mixer miteinander übergeblendet 
werden können.  Auch wenn schon eine spezielle Option definiert wurde (siehe Einstellungen / Erweitert), 
werden diese Einstellungen erst dann wirksam, wenn eine Zelle im Deck B einen Clip abspielt.  Das liegt 
daran, dass das Deck B virtuell ‘über’ dem Deck A liegt und beim Kopieren das Signal des Deck B in das A 
Signal ‘gemischt’ werden. 

 
Die Copy Modi definieren die mathematische Operation, 
die zur Kombination von Pixelfarben vom Deck B mit den 
Pixelfarben vom Deck A verwendet werden. Wir schauen 
uns die einmal der Reihe nach von links nach rechts an. 
 

 
Das ist die Grundeinstellung im Copy Modus. Hier wird die Zelle des Deck B einfach mit der des 
Deck A gemischt. Im Resultat sehen Sie einige Farbmittelwerte in beiden Bildern. 

 
Im Additionsmodus werden die Pixel von B den Pixeln von A hinzugefügt.  Falls dieser Modus 
ausgewählt wurde (wie auch die Modi Subtraktion, Multiplikation, Maximum sowie Minimum), 
wird der Effekt am deutlichsten, wenn der Mixing Regler äußerst rechts steht.  

 
 

Im Subtraktionsmodus werden die Pixelfarben vom Deck B vom Deck A abgezogen, was in einer 
invertierten Einblendung von B in A resultiert.  

 
 

         Beim Multiplikationsmodus werden die Pixel vom Deck B mit denen des Deck A multipliziert.  
 
 

Der Maximum Modus wählt Pixel entweder vom Deck A oder B aus, je nachdem welches Deck die 
stärkere Leuchtkraft aufweist. 

 
 

Der Minimum Modus zeigt entweder die Pixel vom Deck A oder B aus, je nachdem welches Deck 
die schwächere Leuchtkraft aufweist.  
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Maskierungsoptionen:   
 
Die Maskierungsoptionen ermöglichen, basierend auf der Farbe (Chrominance Keying) oder der 
Helligkeitscharakteristik (Luminance Keying), die Ausblendung eines Teils des Clipinhalts. Wie auch bei den 
Kopiermodi wirken sich die Maskeneinstellungen nur auf Zellen, 
die in Deck B gespielt werden aus, da Deck B über dem Bild des 
Deck A liegt. Wenn das Luminance oder Chrominance Keying 
eingeschaltet werden, aktivieren sich die Regler unter der 
Auswahl. Diese Regler definieren die Charakteristiken (Center 
und Width [Bandbreite]) eines Bandsperrfilters, der sich 
entweder auf die Helligkeitsstärke oder die Farbsättigung des 
Cipbildes auswirkt. Der Helligkeitsbereich oder die Farbe, die in dieser Zone betroffen ist, wird Transparent 
und Sie sehen das Bild des Deck A. 

 
Die Grundeinstellung (linkes Modus Feld) deaktiviert die Maske. In diesem Fall sind die Center- und 
Bandbreitenregler ebenfalls nicht verwendbar. 

 
Das Luminance Keying ermöglicht es, einen Helligkeitsbereich transparent zu gestalten. Wenn 
Sie zum Beispiel den Centerparameter auf den Maximalwert stellen, werden die hellen Bereiche 
(Weiß) transparent und sie sehen den Inhalt des Deck A hindurch. Mit Center wird der Bereich 
der Graustufen, der ausgeblendet werden soll, bestimmt. 

 
 

Beim Chrominance Keying kann ein Farbbereich transparent gestaltet werden. Die Position des 
Centerreglers bestimmt, welche Farbe unterdrückt wird. Der Bandbreitenregler definiert wie 
groß der Farbbereich anderer Farben, die um den Centerbereich liegen und ausgeblendet 
werden, ist.  

 
Wiedergabeoptionen:  
 
Die Wiedergabeoptionen beeinflussen das Abspielen eines Clips. Dazu stehen drei Modi zur Verfügung: One 
Shot, Loop sowie Ping-Pong. 

 
Im One Shot Modus startet der Film, sobald er getriggert wurde und 
stoppt am Ende. 

  
Der Loop Modus spielt den Clip wiederholt ab. Dieses ist die Grundeinstellung. 

 
Beim Ping-Pong Modus spielt der Clip erst vorwärts, dann rückwärts, wieder vorwärts,… usw. Ab.  
 
Effektoptionen:  
 
Die Effektoptionen auf der rechten Seite ermöglichen das Einstellen 
von Grundwerten für die Effektparameter. Diese Werte werden 
automatisch aufgerufen, wenn die Zelle getriggert wird. Mit den 
Deck Parametern (siehe Abschnitt “Deck”) können sie im laufenden 
Betrieb geändert werden, die hier definierten Grundeinstellungen  
werden bei jedem Triggern der Zelle verwendet. Um die 
gegenwärtigen ‘Liveeinstellungen’  zu den Grundwerten zu machen, damit diese in Zukunft als 
Grundeinstellungen für diese Zelle fungieren, halten Sie die BANK Taste für das ausgewählte Deck des 
Controllers gedrückt.   
 
Texteinstellungen: 
 
Wenn Sie Textclips aus dem Source Browser verwenden, können Sie den angezeigten Text in der 
Texteingabezeile im Zellenparameterpanel ändern oder neu eingeben. 
 
Bank Import/Export:  
 
Neben der Möglichkeit, den gesamten Inhalt Ihrer Performance über das File Menü zu speichern, können 
auch eine einzelne Bank importieren oder exportieren. Dazu klicken Sie eine Zelle der Bank mit der rechten 
Maustaste an und wählen die passende Option aus dem Popup Menü (weitere Hinweise hierzu finden Sie in 
der Beschreibung der Softwareoberfläche). Mit dieser Funktion können Sie sehr einfach Gruppen 
vordefinierter Clips und Visualisierungen während der Performance laden. Sie können auch unzählig viele 
vorkonfigurierte Clip- und Effekteinstellungen speichern und diese jederzeit ohne Unterbrechung der 
Performance wieder einladen. 
 
Zwei Monitore:  
 
Für eine gute VJ Performance sind Videokarten, die zwei Monitore speisen können, besonders geeignet. Auf 
diese Weise lässt sich der Ausgang des Mixers auf den zweiten Monitor projizieren, während Sie die 
Softwareoberfläche auf dem Hauptbildschirm des Rechners sehen. Um den zweiten Monitor in NuVJ nutzen 
zu können, sollten Sie zunächst darauf achten, dass Ihr System für den Einsatz zwei unabhängiger 
Bildschirmausgänge konfiguriert ist (und nicht einfach das Bild des Hauptmonitors auf dem zweiten 
Bildschirm spiegelt). Nach der Systemeinrichtung starten Sie NuVJ und gehen Sie in die Einstellungen (File 
> Preferences).  Unter Display können Sie definieren, welcher Monitor für die Vollbildanzeige verwendet 
werden soll. Danach rufen Sie den Vollbildmodus auf, indem Sie auf Display > Toggle Fullscreen wählen 
oder indem Sie die Tastenkombination STRG+A (Befehl+A am Mac) verwenden.  Den Vollbildmodus 
verlassen Sie, indem Sie STRAG+A (Befehl+A am Mac) noch einmal drücken. 
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VERWENDEN DER SOFTWARE 
 

 
Dieser Abschnitt geht näher die verschiedenen Elemente der Softwareoberfläche ein und erklärt, wie man am 
Besten mit dem Programm interagiert.  
 
Die Softwareoberfläche ist in vier verschiedene Bereiche untergliedert: Die Menü/Browser Zone (oben links), 
die Mixer Zone (oben rechts), das Informationsfenster (unten links) and die Zellenparameteranzeige (rechts 
unten).            

         
 

Menüs 
 

 
Die Menüs wurden wie folgt organisiert: 

 
File --------------------------- 

New: Löscht alle Daten und startet mit einer leeren Performance 
Open: Öffnet eine Performance Datei (.nvj)  
Save: Speichert die gegenwärtige Performance 
Save As...: Speichert die gegenwärtige Performance als neue Datei  

   Preferences: Ruft den Voreinstellungsdialog auf  
Quit: Beendet das Programm. Der Befehl funktioniert nur, wenn der Vollbildmodus 
nicht aktiv ist, um ein Ausschalten bei einer Performance zu vermeiden 

 
Edit --------------------------- 

Cut Cell: Entfernt den Inhalt der editierten Zelle und kopiert ihn in die Zwischenablage 
  Copy Cell: Kopiert den Inhalt der gegenwärtig editierten Zelle in die Zwischenablage  

Paste Zelle: Kopiert den Inhalt der Zwischenablage in die gegenwärtig editierte Zelle 
    Clear Background: Entfernt den aktuellen Hintergrund Clip 

Purge Visuals: Entfernt alle unbenutzten Clips aus dem Speicher. 
  

Display --------------------------- 
  Toggle Fullscreen: Aktiviert/deaktiviert den Vollbildmodus  

 
Help --------------------------- 

Getting Started: Öffnet die Kurzanleitung des NuVJ als PDF 
Reference Manual: Öffnet die Bedienungsanleitung des NuVJ als PDF 
Release Notes: Zeigt ein PDF mit den Informationen zur gegenwärtigen 
Softwareversion des Programms und zusätzliche Hinweise an  
NuVJ Web Site: Öffnet die NuVJ Webseite in Ihrem Internetbrowser  
Register: Ermöglicht die Online Registrierung des NuVJs  
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Die Browser Zone 
 

 
Die Browser Zone bietet eine Strukturansicht zur Auswahl von Content (Videos, Bilder, usw.) und 
Effekten, die Sie in Ihrer Performance einsetzen möchten. Die Zone enthält vier Tabs, über die Sie 
auf Files (Dateien), Effects (Effekte), Sources (Live Quellen) und die Library (Bibliothek) zugreifen 
können.  Um eines der Elemente zu verwenden, ziehen Sie es mit der Maus aus dem Browser auf 
eine Zelle. Sie können ein Element auch auf einem der beiden Vorschaufenster platzieren. Das 
Element ersetzt dann den Clip oder den Effekt, der gerade gespielt wird.  Wenn Sie ein Element auf 
das mittlere Hauptvorschaufenster ziehen, wird es als Hintergrund Clip bzw. als Master Effekt 
definiert. 
 
Direkt unter der Browser Zone sehen Sie ein Dateifilterfeld, mit dem Sie bestimmen können, 
welche Arten von Dateien im Browser angezeigt werden sollen. In der Grundeinstellung werden 
Ihnen alle kompatiblen Dateien (Videos, Bilder sowie Flash Dateien) dargestellt. Sie können sich 
jedoch nur Videos, nur Bilder, nur Flash Dateien oder alle vorhandenen Dateien der Festplatte 
anzeigen lassen. 
 
Unter dem Filter sehen Sie ein Papierkorbsymbol. Dieses Symbol eignet sich dazu, den Inhalt der 
Zellen zu entfernen. Ziehen Sie einfach die Zelle oder das Effektsymbol der Zelle auf den 
Papierkorb. 
 

Die Mixing Zone 
 

 
Die Mixing Zone enthält alle für Vorschau und Deckinhalt wichtigen Informationen, sowie den Mix 
Schieberegler und den Master Effekt. Links befindet sich das Deck A, während Sie rechts das Deck 
B sehen. In der Mitte sind die Mixing und Master Effekt Zonen angeordnet. 
 
Deck Zonen (A und B): 

 
Jedes Deck enthält, von oben nach unten gesehen, folgende Elemente: 

  
Deck Vorschau: Zeigt den Ausgang einer Zelle des Decks. Sie können Elemente aus 
dem Browser direkt auf die Vorschaufenster eines Decks ziehen, die den Clip oder den 
Effekt, den die Zelle gegenwärtig abspielt, ersetzen. 

 
Deck Steuerung: Das sind die Elemente, die zur Bankauswahl, 
Wiedergabegeschwindigkeit und zur Definition der Latch, Auto und Sync Modi benötigt 
werden. Weitere Hinweise hierzu finden Sie im Abschnitt ‘Deck Wiedergabesteuerung’ 
der  ‘Softwareeinführung’ dieser Anleitung. 

 
Deck Effektparameter: Ermöglichen die Anpassung der Effektparameter der gerade 
gespielten Zelle. Beachten Sie bitte, dass sich diese Modifizierungen nur zeitweilig 
auswirken. Sobald eine neue Zelle getriggert wird, werden die Effektparameter auf die 
im Parameter Panel der Zelle eingestellten Ursprungswerte zurückgesetzt. Falls Sie die 
aktuellen Effektparameter als Standardwerte der Zelle definieren möchten, damit sie 
beim nächsten Triggern der Zelle verwendet werden, drücken Sie einfach die [BANK] 
Taste des Decks. 

 
Zellen: Im unteren Deckbereich sehen Sie die neun Zellen der ausgewählten Bank. Um 
den Inhalt einer Zelle zu verändern, ziehen Sie mit der Maus eine im Browser 
angezeigte Datei, einen Effekt oder eine Quelle auf die Zelle. Die Zelle zeigt ein 
Vorschaubild des ihr zugewiesenen Clips sowie ein paar informative Symbole, als da 
wären: 

 
Eine graue Zelle mit einem roten Rand bedeutet, dass diese Zelle 
momentan im Deck spielt. Ein Stiftsymbol in der linken oberen 
Ecke zeigt an, dass die Zelle zur Bearbeitung ausgewählt wurde 
und die Parameter im Zellenparameterpanel angezeigt werden. 
Es bedeutet auch, dass die Zelle gerade als Ziel für 
Kopier/Einfügen Vorgänge verwendet wird. Zur Auswahl einer 
Zelle, klicken Sie die Zelle entweder mit der linken Maustaste 
(dann wird die Zelle getriggert und zur Bearbeitung ausgewählt) 
oder mit der rechten Maustaste (dann wird die Zelle zwar zur Bearbeitung ausgewählt 
aber nicht getriggert). 

 
Das Symbol in der rechten unteren Ecke bedeutet, dass die Zelle mit einem Effekt 
versehen ist. Das Symbol links daneben zeigt, dass die Zelle veränderte Kopier- und 
Maskierungseinstellungen hat. 

 
Sie können Clips und Effekte zwischen Zellen bewegen. Klicken Sie einfach in den 
Bildbereich der Zelle und ziehen Sie den Inhalt auf eine andere Zelle. Um einen Effekt 
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auf eine andere Zelle zu ziehen, ziehen Sie das Effektsymbol mit der Maus auf eine 
andere Zelle. 

 
Wenn Sie eine Zelle mit der rechten Maustaste anklicken und 
die Maustaste halten erscheint ein Aufklappmenü mit den 
folgenden Einträgen:  

  
Clear Visual: Entfernt Clips und Visual aus der Zelle 
Clear Effect: Entfernt den Effekt von der Zelle 
Reset Cell: Entfernt alle Einstellungen, Visuals und Effekte 
aus der Zelle 
Import Bank: Importiert eine gesamte Bank aus einer .nvjb Datei, die die Bank, zu der 
die Zelle gehört, ersetzt. 
Export Bank: Ermöglicht den Export der Bank, zu der die Zelle gehört als .njvb Datei. 
Clear Bank: Löscht den Inhalt der Bank. Die Clips bleiben über den Browser im 
Speicher, um sie später weiter verwenden zu können. Um den Speicherplatz 
freizugeben und unbenutzte Clips zu entfernen, verwenden Sie die ‘Purge Visuals’ 
Funktion aus dem Edit Menü. 

 
 
Mixing und Master Effekt Zone: 

 
Die mittlere Zone enthält alle Elemente, die für den Masterausgang und das Mixen wichtig sind. 
Hier finden Sie von oben nach unten aus gesehen: 

 
Ausgangsvorschau: Das Ausgangsvorschaufenster dupliziert die Bilder im Vollbildmodus auf einen 
zweiten Monitor. Mit der Maus können Sie Elemente auf das Ausgangsvorschaufenster ziehen. 
Wenn Sie dabei einen Clip, eine Kameraquelle oder einen Generator verwenden, ersetzt dieses 
Element den gegenwärtig ausgewählten Hintergrund (Siehe Hintergrund im Abschnitt Grundlagen). 
Wird ein Effekt auf die Vorschau bewegt, wird dieser als Master Effekt verwendet. 

 
Helligkeit und Kontrast: Diese beiden Regler ermöglichen die Korrektur der Kontrast- und 
Helligkeitseinstellungen des Ausgangsbildes, um es den Lichtverhältnissen im Raum oder die 
anzupassen oder um Artefakte, die durch starke Editierungen verursacht werden, zu kompensieren. 

 
Master Effekt Sektion: Die Master Effekt Sektion ermöglicht die Einbindung eines zusätzlichen 
Effekts am Ausgang des Mixers. Der Effekt kann mit der Combo Box ausgewählt und mit den drei 
Reglern darunter verändert werden. Der erste Regler bestimmt den Wet/Dry Prozentsatz zwischen 
Original- und Effektbild. Die beiden anderen Regler ermöglichen die Anpassung der spezifischen 
Parameter des gewählten Effekts. 

 
Crossfader: Steuert den Mix aus den Signalen von 
Deck A und Deck B. Auf der äußerst linken Position 
passiert nur das Deck A Signal den Ausgang. Auf der 
äußerst rechten Seite wird ausschließlich das Bild 
des Deck B gezeigt. Die Art und Weise, wie die Bilder 
von A nach B gemixt werden, bestimmen Sie mit den 
Übergängen (Transitions). Transitions können 
ausgewählt werden, indem Sie den Crossfader mit 
der rechten Maustaste anklicken oder den Schalter 
am Controller verwenden. Beachten Sie bitte, dass 
die Anzahl der verfügbaren Transitions von den Möglichkeiten Ihrer Hardware abhängt. 
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Die Information Zone 
 

 
Die Information Zone am linken Ende des Fensters zeigt die Informationen des Elements, auf 
welches die Maus zeigt, dynamisch an. Wenn Sie zu einem bestimmten Element eine genaue 
Information benötigen, zeigen Sie einfach mit der Maus auf das Element und lesen Sie hier die 
Information ab. 
 

Das Zellenparameterpanel 
 

 
Im  Zellenparameterpanel können Sie die Parameter, die sich auf eine aktuell gewählte 
Zelle auswirken, editieren. Es kann immer nur eine Zelle ausgewählt werden. Die 
ausgewählte Zelle wird Ihnen durch das nebenstehende Symbol gekennzeichnet:   

 
Wie bereits im Abschnitt ‘Grundlagen’ beschrieben wurde, ermöglicht dieses Panel die Anpassung 
der Wiedergabe- und Mixing-Charakeristiken einer jeden Zelle. Hier definieren Sie zudem die 
Grundwerte für die Effektparameter, die bei jedem Triggern der Zelle abgerufen werden. 
 

Der Preferences Dialog (Voreinstellungen) 
 

 
Im Preferences Dialog können Sie verschiedene Einstellungen, die die generelle Arbeitsweise des 
Programms definieren, bestimmen. Diese Einstellungen sind in vier Kategorien unterteilt, auf die 
Sie über Tabs im Dialog zugreifen können: 
 
 General: 
 

Background Visual: 
Bestimmt die Datei, die als 
Hintergrund-Clip angezeigt 
wird. Diese Datei wird dann 
gezeigt oder gespielt, wenn 
auf keinem Deck eine Zelle 
spielt oder wenn am 
Controller die ‘Fade to Black’ 
Taste gedrückt wird. Geben 
Sie hier entweder den 
vollständigen Dateipfad an 
oder klicken Sie ‘Select’, um 
eine Datei über den 
Dateibrowser auszuwählen. 
Diese Datei wird als 
Standard-Hintergrund 
verwendet und beim Start 
des Programms, beim Laden einer Performance Datei oder beim Zurücksetzen der Daten 
über das File>New geladen. Die Einstellung lässt sich durch Klicken auf das Edit>Clear 
Background Menü oder durch ziehen eines Clips direkt auf das Mastervorschaufenster 
überschreiben.  
 
Automation Beat Count: Wählt die Anzahl der Beats aus, welche das Programm 
wartet, bevor ein neuer Clip getriggert wird. Siehe ‘Grundlagen/Deck 
Wiedergabesteuerung’. 
 
Slide Show Time: NuVJ ermöglicht es, einen ganzen Ordner auf eine Zelle zu ziehen. 
Dann werden alle Filme/Bilder/Flash Dateien dieses Ordners nacheinander als Slideshow 
angezeigt. Der ‘Slide Show Time’ Parameter bestimmt, wieviele Sekunden ein Bild 
angezeigt wird, bevor zum nächsten Clip gewechselt wird. 
 
Transition 2 & Transition 3: Der Controller besitzt einen Schalter, mit Sie im 
laufenden Betrieb zwischen 3 Transitions (Übergängen) wechseln können. Die erste 
Transition ist immer die Standard-Tansition (Exponential Transparency) die anderen 
lassen sich jedoch frei konfigurieren. Diese beiden Listen ermöglichen die Zuweisung der 
Transition zu den Schalterpositionen ‘2’ & ‘3’ des Transition Schalters. 
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Display:  

 
Im Display Tab finden Sie die Optionen für den Vollbildmodus des Programms. 

  
Full Screen Monitor: 
Definiert, welcher Monitor 
vom Programm als 
Vollbildanzeige verwendet 
werden soll. Indem Sie 
einen anderen Ausgang als 
Ihren Hauptmonitor wählen, 
können Sie den Mix über 
einen alternativen Ausgang 
senden, während Sie die 
Bedienoberfläche auf dem 
normalen Monitor weiterhin 
sehen.  
  
Resolution: Bestimmt, die 
Auflösung, mit der intern 
gearbeitet wird. Je niedriger 
der hier eingestellte Wert ist, desto schneller werden die Berechnungen durchgeführt 
(und ergeben eine bessere Frame Rate), jedoch desto schlechter ist die Bildqualität. 
Probieren Sie verschiedene Einstellungen aus, bis Sie eine gute Kombination aus 
Bildqualität  und Frame Rate gefunden haben. Normalerweise sollte eine Auflösung von 
800x600 perfekt für einen Projektor sein. 
 
Exclusive Mode: Veranlasst Windows im Exclusive Modus zu arbeiten. In diesem Modus 
sind die Performances zwar etwas flüssiger, jedoch gibt es einen Stolperstein: nach 
Aktivierung funktioniert nur noch NuVJ. Das Aktivieren eines anderen Programms 
bewirkt, dass NuVJ die Vollbildanzeige verlässt. Dieser Modus ist deshalb nicht 
empfehlenswert, wenn Sie vorhaben, neben NuVJ auch andere Programme laufen zu 
lassen.  

 
 

Performances:  
 

Der Performance Tab ermöglicht es, Performance Elemente zu verändern, um eine 
bessere Frame Rate zu erzielen. 

 
GPU Level: Das erste Feld 
zeigt die Leistungsfähigkeit 
Ihrer Grafikhardware von 1 
bis 5 an. Auch wenn das 
Programm mit jedem 
Leistungslevel funktioniert,  
empfehlen wir mindestens 
einen GPU Level 2, um NuVJ 
richtig einsetzen zu können. 
Unter Level 2 könnten einige 
Funktionen nicht 
bereitgestellt werden, da 
diese durch die Hardware 
nicht unterstützt werden.  
 
Rendering Quality: Mit 
diesem Schieberegler 
definieren Sie die verschiedenen Aspekte des Rendering Prozesses. Er beeinflusst die 
Bildqualität in Abhängigkeit von der Rendering Geschwindigkeit. Steht der Regler ganz 
rechts, wird die beste Qualität erzielt. Auf der äußerst linken Position ist die Qualität 
einiger Funktionen (Vorschau, interne Bearbeitung, usw…) niedriger, jedoch erhöht sich 
aufgrund höherer Berechnungskapazitäten die Frame Rate. Experimentieren Sie mit 
verschiedenen Werten und denken Sie auch daran, dass die im ‘Display’ Tab definierte 
Auflösung (Resolution) sich automatisch auf die Performance Ihres Systems auswirkt. 

 
Disable Contrast/Brightness Control: Bei der Verwendung von nicht so 
leistungsfähiger Grafikhardware können Sie Prozessorkapazitäten freigeben, indem Sie 
die Kontrast/Helligkeitsregler deaktivieren. 
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Advanced 
 

Auto purge after: Wird ein 
Film in NuVJ importiert, 
verbleibt er im Speicher, 
auch wenn er keiner Zelle 
zugewiesen wurde. Um nicht 
den Speicher des Computers 
zu überlasten, ist es wichtig, 
unbenutzte Filme aus dem 
Speicher zu löschen. Diese 
Einstellung stellt eine Zeit 
ein, nach der unbenutzte 
Filme entfernt werden.  
 
Auto purge when 
physical memory left 
reaches: Diese Einstellung 
ermöglicht die automatische 
Entfernung von Filmen, wenn der physikalische Speicher des Computers knapp wird. 
Diese Option existiert nur für die Windows Version des Programms.  
 
Use Mask and Copy Mode on Deck A: Normalerweise wirken sich die im 
Zellenparameterpanel definierten Maskierungs- und Kopiermodi nur dann aus, wenn eine 
Zelle des Deck B abgespielt wird. Durch die Aktivierung dieser Option werden die 
Parameter für Deck A eingeschaltet. Das bedeutet, dass die im Deck A wiedergegebene 
Zelle zunächst durch die Maskierungs- und Kopiereinstellungen mit dem Hintergrund Clip 
gemischt werden, bevor sie zum Mixer gesendet werden. Die Kombination dieser Option 
mit der Funktion, den Hintergrund durch darauf ziehen eines Clips auf das Master 
Vorschaufenster eröffnet weit reichende Möglichkeiten für den Mix.  
 
Play sound in QuickTime movies: Durch die Auswahl dieser Option wird die Tonspur 
von Quicktime Filmen nicht ignoriert, so dass NuVJ Video und Audio gleichzeitig 
scratchen kann. 

 
 

Controller: 

 
Der Controller Bereich enthält die für den Controller wichtigen Einstellmöglichkeiten: 

 
Status: Zeigt den Status des Controllers an (offline/connected). 
Firmware: Zeigt die installierte Firmwareversion des Controllers an, wenn dieser 
angeschlossen ist.  
LCD Contrast: Ermöglicht, 
den Kontrast des Controller 
LCDs einzustellen. Nach der 
Einstellung speichert der 
Controller permanent diesen 
Wert und startet beim 
nächsten Mal mit dem 
eingestellten Kontrast.  
Scratch sensitivity: 
Definiert die Empfindlichkeit 
des Jog Rades im Scratch 
Modus 
Slide Sensitivity: Definiert 
die Empfindlichkeit des Jog 
Rades bei der Verwendung 
ohne gedrückter Scratch 
Taste (‘Pitch Bend’). 
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PERFORMANCE HINWEISE 
 

 
 
 
 
 
 
 
 
 
Das Erreichen einer guten Performance mit Video kann manchmal schwierig sein, da sie von vielen 
unterschiedlichen Faktoren abhängt:  
 
Die wichtigsten Faktoren sind: 

 
• CPU Geschwindigkeit 
• Geschwindigkeit der Festplatte  
• Zugriffsgeschwindigkeit auf den RAM Speicher  
• Video Hardware & Video Bus Geschwindigkeit  
• Filmkomprimierung  

 
Es ist nicht einfach, eine Antwort auf die Frage zu finden, welche die beste Computerkonfiguration ist.  NuVJ 
erledigt den Hauptanteil der grafischen Bearbeitung über die Videohardware. Je leistungsfähiger diese ist, 
desto besser wird die Performance letztendlich sein. Die CPU wird eigentlich nur zum Dekomprimieren der 
Filme von der Festplatte und zur Übertragung dieser zur Grafikhardware verwendet. Je schneller Ihre 
Laufwerke arbeiten, desto schneller werden die Frames eines Films in den Arbeitsspeicher geladen. Mit einer 
schnelleren CPU werden die Frames schneller dekomprimiert. Um mit der vorhandenen Hardware eine 
ausreichende Frame Rate zu erzielen, können Sie:  
 
• Passen Sie die Auflösung der internen Berechnung an (Siehe Preferences/Display). 
• Verwenden Sie den Performance Schieberegler, um eine brauchbare Balance zwischen Qualität und 

Performance für Ihre Hardware zu finden. 
• Verwenden Sie Sie Quellmaterial, welches sich mit Ihrer Hardware gut einsetzen lässt. Wenn Sie eine 

langsame Festplatte oder ältere Hardwarekomponenten verwenden, arbeiten Sie vorwiegend mit 
kleineren Videodateien, um die Einbußen beim Dekodieren  und Laden der Filme zu minimieren. Da 
alle Berechnungen von der Videohardware ausgeführt werden, werden Aliasing Effekte durch die 
automatischen Filter minimiert, wenn die Bilder auf die letztendliche Auflösung gebracht werden. 

 

Komprimierung der Filme  
 

Neben der Größe der Filme, besitzt die Art der Komprimierung einen großen Einfluss auf eine flüssige 
Arbeitsweise. Je komplexer der Kompressionsalgorithmus ist, desto mehr Arbeit muss der Prozessor zum 
wiederherstellen der Bildinformationen aufwenden, was sich wiederum in einer zähen Performance spiegelt. 
Hinzu kommt das Key Frame Thema. Die am weitesten verbreiteten Kompressionsarten arbeiten nach einer 
Methode, die ein Frame so aufbauen, dass der Unterschied zwischen dem vorhergehenden und dem 
aktuellen Frame gespeichert wird. Damit dieser Prozess nicht zu oft das Originalbild vergleichen muss, wird 
gelegentlich ein weiteres Original Key Frame gespeichert, von dem aus der Aufbau der nachfolgenden Bilder 
hergeleitet wird. Diese originalen Frames nennen sich ‘Key Frames’. Bei der Verwendung weniger Key 
Frames ist es für NuVJ wichtig, die vorangegangenen Key Frames zu finden und all die dazwischen liegenden 
Frameunterschiede zu berechnen, bis das gewünschte gefunden wurde. Wie Sie sich vorstellen können, ist 
dieser Prozess langwierig und verhindert, dass auf Frames schnell zugegriffen werden kann. Zum Scratchen 
oder zur umgekehrten Wiedergabe muss NuVJ schnell auf die Frames zugreifen können. Deshalb eignen sich 
komprimierte Videodateien (mpeg oder DivX) nicht für aufwändige Video Performances. 
 

 
 
 
 
 
 
 

Speicherverbrauch 
 

Filme sind Speicherfresser. Je nach Größe und Länge können sie sehr schnell sehr viel Speicherplatz 
verbrauchen. Wird eine Datei in NuVJ importiert, wird sie auch dann im Speicher behalten, wenn sie nicht in 
einer Zelle verwendet wird. Auf diese Weise können Sie im Browser nach bereits geladenen Clips suchen, 
ohne dass diese noch einmal geladen und importiert werden müssen.  Wenn sich der Speicher des 
Computers immer weiter füllt, verschlechtert sich seine Performance. Haben Sie deshalb immer ein Auge auf 
die Speicherauslastung. Um nicht verwendete Filme aus der Software zu entfernen stehen verschiedene 
Funktionen zur Verfügung: 

1.  Ungenutzte Filme lassen sich manuell mit dem ‘Edit/Purge Visuals’ entfernen 

2. Mit der Auto-Purge Funktion, die im Preferences/Advanced Fenster definiert wird, können Sie nicht 
verwendete Filme nach einer bestimmten Zeit entfernen lassen. Weitere Informationen hierzu finden Sie im 
Abschnitt Preferences dieser Anleitung. 
 

Es ist wichtig zu wissen, dass die populären Kompressionsalgorithmen sehr uneffizient fürs 
VJing sind. Videodateien, die so komprimiert wurden verhalten sich zwar normal, wenn sie 
mit Normalgeschwindigkeit abgespielen, werden jedoch unkontrollierbar träge, wenn sie in 
der Abspielgeschwingigkeit verändert oder gescratcht werden. Dies gilt, neben anderen, für 
mpeg, divx und DV Codecs. Falls Sie diese Dateiarten verwenden, verschlechtert sich die 
Performance der Software merklich.  

Nach unserer Erfahrung eignet das Quicktime Photo JPEG mit einer 
Qualitätseinstellung von 80% oder besser am Besten für Video 

Performances. So erhalten Sie eine Datei mittlerer Größe, die sich flüssig 
wiedergeben und effektiv scratchen lässt. 
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